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Introdução

Introdução

Com a chegada da internet, o modelo sociotécnico pelo qual 
compreendemos o mundo social em termos de uma estrutura reticular, ou 
rede, terminou impondo-se nos mais variados domínios do conhecimento. 
A era dos big-data tem outorgado um poder crescente aos programadores 
em linguagens computacionais. O dado científico relevante confunde-se 
com o que parece ser a nova natureza digital das relações sociais construídas 
pelo uso cotidiano dos ordenadores de dados. Ninguém consegue imaginar 
como era o mundo antes do uso massivo do notebook e da internet. 

	 Porém, antes das mídias sociais, facebook ou twitter, por exemplo, 
já havia redes sociais. O comportamento humano sempre foi estruturado 
através da interdependência das interações e de tudo aquilo que pressupõe 
a sua existência: normas sociais, sanções, formas de controle lateral, 
disciplinas, narrativas, meios de pagamento e troca, formas de dominação, 
valores, regras de parentesco, regimes de propriedade etc. A lista é quase 
que interminável.  Há vários equívocos quando falamos de redes sociais. 
Muitas pessoas confundem as mídias sociais, isto é, os aplicativos digitais 
por meio dos quais nos comunicamos e postamos informações sobre a 
nossa vida para que outros curtam, com o método para analisar os dados 
de nossas relações sociais que nos tornam interdependentes. Muito antes 
da corrida metodológica pela popularmente conhecida análise de redes 
sociais, as ciências humanas tinham inaugurado um campo metodológico 
conhecido como sociometria. O trabalho pioneiro do Jacob Moreno 
(1953) fez uso da teoria de grafos como ferramenta de visualização e 
modelagem de interações. Como resultado desse esforço, surgiu a técnica 
do sociograma, precursora das atuais ferramentas de desenho topológico 
disponíveis em diversos pacotes computacionais que circulam na rede 
digital. Em poucas palavras, não devemos confundir a topologia aplicada 
nas técnicas de análise de redes com dispositivos digitais que colocam em 
contato as pessoas. 
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Outro equívoco muito frequente diz respeito à confusão entre a 
análise formal e a teorização. Isto é, fala-se da ciência das redes, como se 
existisse um domínio teórico geral aplicável às mais variadas realidades 
do mundo. Um sistema de trocas sociais e uma rede de estradas, por 
exemplo, seriam realizações concretas de uma teoria unificada das redes 
que simplesmente desvenda propriedades topológicas de domínios 
diferentes. Mas devemos dizer com todas as letras: um sociólogo não é 
um engenheiro de tráfego, ainda que o comportamento social seja, ao 
mesmo tempo, condicionante do e condicionado pelo dispositivo de 
estradas. Cada domínio científico precisa formular as suas teorias para 
logo submetê-las ao teste dos dados de redes. 

	 O presente trabalho é fruto de vários anos de ensino no campo 
da sociometria entre alunos e alunas de Ciências Sociais e áreas afins, 
tanto do Brasil como do exterior. Apresenta os conceitos básicos que 
melhor descrevem a topologia de um sistema social: coesão, centralidade 
e posições funcionais. A perspectiva teórica trata os grafos como 
representações visuais de processos sociais dos mais variados tipos. A 
inspiração está na obra pioneira de Harrison White (2008), Identity and 
Control, opera prima de uma fórmula analítica que foge às velhas aporias 
da teoria social. Tanto estruturas como agentes são produtos emergentes 
do processo social. A sociologia neoestrutural, ou, que trabalha com 
dados relacionais e ferramentas de análise topológica, é sem dúvida um 
avanço perante a cacofonia que insiste em fazer oposições burdas entre 
indivíduos e estruturas. 

	 O conteúdo está articulado na sequência de 10 capítulos, com 
um intermédio que abre as portas de dois softwares de amplo uso, Pajek 
e Ucinet, e um epílogo prático com exercícios que ajudam a afiançar o 
aprendido. No final de cada capítulo, com exceção do primeiro, o leitor 
encontra exercícios que ajudam na apropriação dos conceitos trabalhados. 
O material apresentado não pressupõe habilidades estatísticas do leitor, 
ao menos não neste primeiro volume, mas sim uma concentração básica 
para enfrentar explicações que estão acompanhadas de notações formais, 
ou algébricas, imprescindíveis em qualquer abstração matemática, por 
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elementar que esta seja. Adotamos o sistema de notação do insuperável 
trabalho de Stanley Wasserman e Katherine Faust (2009) intitulado Social 
Network Analysis: Methods and Applications. 

	 Esperamos que este recurso didático ajude na formação 
metodológica das novas gerações de cientistas sociais que frequentam as 
universidades brasileiras. Assumimos como consigna a diversificação de 
métodos, única forma de evitarmos o debate estéril entre o quantitativo 
e o qualitativo. Neste ponto, resulta útil lembrar a sábia resposta daquela 
professora quando lhe perguntaram pelas disposições básicas que devia 
reunir uma pessoa que tivesse a intenção de estudar Ciências Sociais, ela 
respondeu, palavras mais, palavras menos: “somente duas, deve gostar da 
história e das matemáticas, o resto nós ensinamos aqui na Universidade”.  

Para um melhor entendimento, apresentamos na Tabela 1 o plano 
expositivo do livro, indo de cima para baixo.  Nas linhas, temos os critérios 
básicos que descrevem uma estrutura de rede, e nas colunas, os conceitos 
que especificam os critérios. A mudança de cores marca a diferença entre 
a análise de superfície de uma estrutura reticular e a análise latente. Nesse 
sentido, os capítulos finais que tratam da análise posicional aprofundam 
em um tipo de estrutura que não é visível ao olho nu do investigador. Bom 
proveito para nossos leitores!

Tabela 1 – Plano expositivo do livro

Conceitos

Coesão
(Subgrupos)

Densidade

Arcos observados/ 
Arcos possíveis

Geodésica

Caminho mais curto 
entre dois arcos

Reciprocidade

Completa - cliques

Centralidade

(Prestígio)

Grau absoluto

Tamanho da rede 
de um nodo

Proximidade

Distância mínima para 
entrar em contato com 

todos os nodos

Intermediação

Número de geodésicas 
que passam por um 

nodo

Posição 
estrutural

(Autonomia / 
Controle)

Equivalência 
estrutural Autonomia estrutural Controle estrutural

Fonte: Elaboração própria.

Cr
ité

rio
s
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Capítulo 1 – Georg Simmel: visionário  
da geometria social

Em sua visão, a sociedade consiste numa intrincada rede de 
múltiplas relações entre indivíduos que estão em constante 
interação uns com os outros: “Sociedade é simplesmente o 
nome para um número de indivíduos conectados por interação” 
(Simmel,1992 a [1894] apud Coser, 1967).

1. Quem foi Georg Simmel? 

Nos cursos de Ciências Sociais e de pós-graduação em Sociologia, 
ao menos pelo que acontece no Brasil, há um consenso implícito: o cânon 
dos estudos sobre a fundação da ciência sociológica se reduz aos três 
clássicos de sempre: Karl Marx, Max Weber e Émile Durkheim. 

Esse consenso sobre o que deve ser lido, em matéria de tradição 
sociológica, é, por si mesmo, um problema digno de ser examinado em 
História das Ciências. Algo que merece um atento estudo sobre a difusão 
e normalização de determinados conteúdos da Sociologia. 

O trabalho de Waizbort (2007), Simmel no Brasil, no qual examina a 
recepção acadêmica do sociólogo alemão, confirma a marginalidade deste 
último, se comparado com Durkheim e Weber. Até hoje, não contamos 
com a tradução íntegra ao português das principais obras de Simmel. Em 
resumo, Simmel é, entre nós, um ilustre desconhecido.

Apoiados na obra de Lewis Coser (1970) Masters of sociological 
thought, podemos reconstruir um retrato geral da vida desse sociólogo 
muito mencionado e pouco estudado.

Georg Simmel nasceu no coração de Berlim em 01-03-1858. 
“Simmel foi um homem urbano e moderno, sem raízes na cultura popular 
tradicional” (Coser, 1970, p.194). Foi o caçula de sete filhos de um 
próspero empresário judaico convertido ao cristianismo. Muito jovem, 
Simmel fica órfão de pai e sua guarda é entregue a um amigo da família. O 
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jovem Simmel manteve relação distante com sua mãe e seu tutor legal. O 
rapaz desenvolve “um senso de marginalidade e inseguridade”.  

A fortuna herdada de seu pai permitiu-lhe, ao longo de sua carreira 
intelectual, suportar a marginalidade empregatícia em que sempre 
viveu. Após o Gymnasium (ensino médio), estuda História e Filosofia na 
Universidade de Berlim. Doutorou-se em filosofia aos 23 anos com uma 
tese intitulada “A natureza da matéria de acordo com a monadologia física 
de Kant”.

A sua sólida formação historiográfica e filosófica lhe permitiu 
incursionar nos mais variados campos da ciência e da cultura. Simmel 
fez aportes conceituais importantes para a constituição de um domínio 
científico sobre o mundo social, também foi um dos co-fundadores, junto 
com Weber e Töennies, da Sociedade Alemã para a Sociologia. Para os 
moldes institucionais da época, Simmel foi um filósofo profissional.

Apesar de ser reconhecido pela qualidade de seus escritos e pelo 
brilho de suas aulas, Simmel nunca ocupou uma cátedra importante no 
sistema de ensino alemão. Foi, em palavras de Coser, “um outsider”. 

Por outro lado, sua cômoda posição econômica lhe permitiu ficar 
na Universidade de Berlim (1885) como Privatdozent (um lecturer sem 
salário, dependente dos estipêndios dos alunos) durante quinze anos. 
Em 1901 foi promovido a Ausserordentlhicher Professor, um simples 
título honorífico que não lhe permitia tomar parte nos assuntos da 
comunidade acadêmica. 

Pouco antes de sua morte (1914), Simmel assume um posto de 
professor, com plenos direitos acadêmicos, na periférica Universidade de 
Strasbourg. Em 1915, fracassou na sua última tentativa de obter um posto 
numa grande universidade, desta vez em Heidelberg. Morreu em 1918, de 
um câncer de rins. 

1.1 Conceitos-chave

No ensaio intitulado O problema da sociologia, preliminar da obra 
Sociologia: estudos sobre as formas da socialização (1894), Simmel deixa 
exposto o estilo kantiano de seus conceitos sociológicos.
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Assume que todo conhecimento possui interesses práticos. Não se 
faz ciência pela ciência, não existe o amor puro pela verdade ou a sabedoria. 

“Assim, as ambições presentes da ciência sociológica são a 
prolongação teórica e o reflexo do poder prático que as massas 
têm adquirido no século 19 diante dos interesses dos indivíduos” 
(Simmel,1999,p. 39)

Segundo Simmel, todo fenômeno individual é determinado por 
uma infinidade de fatores do ambiente humano. 

1.1.1 Sociologia das formas de interação

Simmel procede de forma análoga ao modo como o filósofo Kant 
coloca o problema do conhecimento: “O que podemos conhecer?” – pergunta 
Kant. Resposta: o que seja dado a nós pela experiência espaço-temporal. 

Nesse sentido, a metafísica clássica não pode aspirar a conhecer 
nada sobre o mundo. Seus dados estão além da experiência, não são 
fenômenos em sentido kantiano.

Na crítica kantiana do conhecimento, o sujeito dá forma ao objeto. 
A ciência constrói juízos sintéticos a priori, isto é, acrescenta algo novo 
pela experiência, mas ao mesmo tempo organiza os dados empíricos 
pelas formas puras da sensibilidade e do entendimento. 

Figura 1 –  A formação do juízo científico segundo Kant

Fonte: Elaboração própria

Ainda que siga Kant, Simmel marca uma diferença radical entre o 
conhecimento da natureza e o conhecimento da sociedade. 
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Como é possível o conhecimento da natureza?
Pela atividade de síntese do sujeito.
Como é possível o conhecimento da sociedade?

“A unidade social é realizada simplesmente pelos seus 
elementos, porque eles são conscientes e sinteticamente ativos, 
não há necessidade de um observador.” (...) Esta afirmação de 
Kant, segundo a qual não pode haver relações entre as coisas, 
dado que só o sujeito a produz, não se aplica à relação social, 
que, ao contrário, se realiza de fato imediatamente nas “coisas” 
– aqui as almas individuais (Simmel, 1999, p.64).

Simmel vai além de Kant, ao afirmar que a síntese subjetiva, própria 
de todo conhecimento científico, quando focada no conhecimento do 
mundo social, é, em realidade, uma síntese entre sujeitos que constituem 
o mundo social. Ao conhecer o comportamento humano em sociedade, 
a subjetividade se conhece a si própria numa síntese original que se 
realiza em cada um dos indivíduos. O estado de consciência coletivo é 
uma síntese nova que se realiza na vida de todos os indivíduos que dela 
participam. 

1.1.2 Ação recíproca

Porém, o mais interessante na Teoria do Conhecimento simmeleano 
está no fato de que a Sociologia veio a ser considerada uma ciência 
formal. Isso o que significa? Que Simmel estava interessado em identificar 
as formas puras da socialização. A sociologia é uma ciência dedicada a 
um campo disciplinar específico: a distinção entre conteúdos e formas da 
socialização 

Onde há sociedade? – pergunta Simmel. Onde há ação recíproca. O 
agir recíproco implica exercer e padecer efeitos.

“Estas ações recíprocas significam que os vetores individuais 
destas pulsões e destas finalidades iniciais constituem então 
uma unidade, isto é, uma ‘sociedade’” (Simmel, 1999,p.43). 
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O agir recíproco pode ser provisório ou permanente. Pensemos, por 
exemplo, quando compramos ou vendemos um bem numa transação de 
mercado. Eu entrego uma mercadoria e em troca recebo o dinheiro que 
corresponde ao preço. Esse encontro não supõe nenhum vínculo afetivo 
entre as partes e tampouco é a fonte de um compromisso mais duradouro. 
Como bem afirma Durkheim em sua obra Da divisão do trabalho social 
(2000), as transações de mercado não constroem vínculos de socialização 
permanente. Agora, se duas pessoas decidem viver juntas em casamento, 
o agir recíproco pressupõe o engajamento e o compromisso de longo 
prazo que faltam nas transações de mercado.

Porém, o aporte mais importante da análise sociológica de Simmel 
está em distinguir a forma e conteúdo da ação recíproca que dá lugar à 
socialização. Todo vínculo que constitui uma unidade maior de interação, 
como, por exemplo, o casamento, pois a família é mais que a soma das 
partes, é passível de ser analisado em termos de seu conteúdo e de 
sua forma. Consiste numa distinção do observador sociológico, pois na 
realidade estão juntas. O conteúdo é o objetivo do agir, seu sentido, 
interesse ou significado, enquanto que a forma é o seu modo. Observemos 
o seguinte esquema:

Figura 2 – Forma e conteúdo da socialização segundo Simmel

 

 

Fonte: Elaboração própria

Essa distinção traz alguns desdobramentos interessantes, pois 
podemos ter uma mesma forma com diversos conteúdos e diversas 
formas com o mesmo conteúdo. O conflito, estudado brilhantemente por 
Simmel como uma forma de socialização – pois o inimigo de meu inimigo 
convém que seja meu amigo –, pode ser impulsionado por diversos 
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motivos. Já a atividade econômica, guiada pelo interesse mercantil, pode 
ser coordenada mediante planejamento ou pelo mecanismo do mercado.

Figura 3 – Combinatória de forma e conteúdo na ação recíproca

 
Fonte: Elaboração própria

Em síntese, Simmel teve a brilhante ideia de conceber uma 
geometria da vida social. As formas da socialização, de forma análoga 
à geometria, existem na abstração. Por exemplo, podemos encontrar 
a forma da concorrência, em domínios diversos: a política, a economia 
política, a história, as religiões, as artes etc. 

“Trata-se, em todo caso, de constatar o que significa a concorrência 
como forma pura do comportamento, em que circunstâncias 
aparece, como se desenvolve, quais modificações lhe introduz o 
caráter particular de seu objeto” (Simmel, 1999, p.50).

1.1.3 A determinação quantitativa do grupo

Em seu ensaio seminal A determinação quantitativa do grupo, 
incluído na coletânea Sociologia: estudos sobre as formas da socialização 
(1999), Simmel trabalha na ideia de construir uma geometria da vida 
social. O fator-chave para isolar as formas da socialização reside no 
número de participantes de um grupo.
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1.1.3.1 A díada

Figura 4 – Representação formal da díade

   

Fonte: Elaboração própria

Diferentemente de outros tipos de grupo, na díada cada participante 
se confronta mutuamente e não por uma coletividade maior.

“Uma díada depende de cada um de seus elementos, para sua 
vida precisa de ambos, para sua morte somente de um” (Simmel, 
1992c[1908], apud Coser 1967,p.186).

	 Quando temos grupos maiores, gera-se um senso de controle do 
supra-pessoal sobre o indivíduo.

Figura 5 – Representação formal do controle supra-pessoal sobre o 
indivíduo.

 
Fonte: Elaboração própria

Em grupos grandes, as obrigações e as responsabilidades podem 
ser delegadas. 

Na díada, pelo contrário, isso não acontece. Cada participante 
é imediata e diretamente responsável por qualquer ação coletiva. 
Ninguém pode delegar a responsabilidade no grupo, um depende 
diretamente do outro. 

A díada não tem acesso a uma vida interpessoal que o indivíduo 
sentiria como independente dele. Pelo contrário, dado que existe 
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associação de três, o grupo continua existindo ainda que alguém se afaste 
(COSER, 1967).

1.1.3.2 A tríada

Figura  6 – Representação formal da tríada

 
Fonte: Elaboração própria

O fato, aparentemente simples, de introduzir um terceiro ator, 
eleva exponencialmente a complexidade.

Para começar, a tríada gera o efeito da maioria simples. Dois ganham 
de um. Cada indivíduo é passível de ser controlado pelo grupo maioritário. 

A tríada cria a estrutura mínima para que o grupo, como um todo, 
possa dominar seus componentes visando aos propósitos coletivos.  

Ao criar o fenômeno da coligação, a tríada exibe na forma mais 
simples o drama que habita a vida social: a dialética entre liberdade e 
controle. Na Figura 7, o nodo marcado em vermelho recebe relações de 
controle de seus alters.

Figura  7 – Controle social no nível da tríade

 

Fonte: Elaboração própria

Simmel concebe toda estrutura social como um equilíbrio entre 
forças positivas e negativas, especialmente entre conflito e cooperação. O 



23

Capítulo 1 – Georg Simmel: visionário da geometria social

conflito implica, segundo ele, um papel de integração social. Um inimigo 
comum fusiona os indivíduos e ajuda a delimitar o grupo. Nos jogos a três, 
começa propriamente a sociologia.  

A tríada introduz a diferença entre relações diretas e indiretas. 
Observemos uma sutil diferença nos dois grafos seguintes: na Figura 
8, todos os nós estão ligados de forma direta. Na Figura 9, A entra em 
contato com B através de sua relação com C. Esse caminho intermediário 
só é possível, como mínimo, quando há três atores em relação. 

Figura 8 – Tríada  de relações recíprocas 

Fonte: Elaboração própria

Figura 9 – Tríada de relações indiretas

	
Fonte: Elaboração própria

Quando aprofunda no conflito, como uma forma de socialização, 
Simmel identifica três estratégias possíveis de um tertius numa tríada.

Estratégia do mediador
Em caso de conflito, o tertius serve de intermediário e ajuda os 

outros dois agentes a negociar. É preciso que o terceiro seja tido como 
neutro e confiável. Estudos recentes (Gould; Fernandez, 1989) distinguem 
cinco papéis de articulação.
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1.1.3.3 O intermediário

Figura 10 – Tríada de intermediação

Fonte: Elaborado a partir do Degenne; Forsé (2004)

O intermediário vincula indivíduos que pertencem a círculos 
diferentes, ele mesmo faz parte de um círculo específico. Aqui o 
círculo significa pertença a um grupo definido por critério específico. O 
intermediário possui o poder de “cortar o fio”.

1.1.3.4 O representante

Figura 11 – Tríada de representação

Fonte: Elaborado a partir do Degenne; Forsé (2004) 

O representante pertence ao mesmo círculo que A, enquanto B 
pertence a um círculo diferente. O ego assume por delegação a tarefa de 
representar A diante de B. 
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1.1.3.5 O guardião 

Figura 12 – Tríada de bloqueio

Fonte: Elaborado a partir do Degenne; Forsé (2004)

A configuração de círculo é igual ao caso do representante. A 
diferença reside no fato de que o guardião assume a tarefa de controlar o 
acesso ao círculo.

1.1.3.6 O mediador

Figura 13 – Tríada de mediação

Fonte: Elaborado a partir do Degenne; Forsé (2004)

O mediador, propriamente dito, pertence a um círculo diferente de 
A e B. Esse articulador facilita a comunicação intragrupo. É o típico caso de 
um mediador externo que desbloqueia a comunicação dentro de um grupo.
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1.1.3.7 O coordenador
O coordenador é um terceiro que pertence ao mesmo círculo social 

de A e B.

Figura 14 – Tríada de coordenação

Fonte: Elaborado a partir do Degenne; Forsé (2004)

Estratégia tertius gaudens
Nesse caso, o tertius obtém a vantagem do conflito entre os outros 

dois atores. O caso típico está representado no advogado picareta que 
rouba as duas partes em confronto. 

Estratégia divide et impera
Nesta situação, o tertius, de forma intencional, “joga lenha 

na fogueira”, como se diz corriqueiramente, para tirar vantagem das 
circunstâncias. Esse é caso proverbial da estratégia imperial de Roma 
contra seus inimigos.
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Capítulo 2 – A tradição científica da 
análise de redes

Na ausência de dados em rede, tudo é especulação. Não temos em 
mãos a informação pertinente para demonstrar se a comunidade 
de West End era fragmentada ou se as que se organizaram 
eficazmente não o eram, porém, esses dados não são fáceis de 
coletar (Granovetter, 1973: 1375 - tradução dos autores).

1. A questão de partida

1.1 Do ponto de vista sociológico, o que veio primeiro? O ovo ou a galinha?

Em seu artigo Economic action and social structure: the problem 
of embeddedness (A ação econômica e a estrutura social: o problema 
da imersão), Mark Granovetter (1985) traz de volta a velha aporia da 
estrutura e da ação que durante décadas ocupou a mente dos mais 
brilhantes cientistas sociais. Só para citar um caso, lembremos a acirrada 
discussão de Pierre Bourdieu (1994) contra a linguística estrutural em 
seu célebre ensaio A teoria da prática. De que falamos quando dizemos 
aporia? Podemos refazer a questão em forma simples: as causas do 
comportamento social estão na motivação do indivíduo ou na pressão 
que exerce o contexto sobre ele? Talcott Parsons (1977) pensava que, 
na execução de papéis sociais, o que é do contexto, ou da estrutura, já 
está fusionado com o que é do indivíduo. Portanto, não teríamos por 
que fazer a distinção. Mas o funcionalismo do papel social só obscurece 
ainda mais o problema. Pierre Bourdieu, por sua parte, quando discute 
contra os economistas e sua ideia de indivíduo racional, acusa-os de 
trabalharem como uma antropologia fantástica, pois o consumidor que 
desenham os manuais de microeconomia é um indivíduo sem história 
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e sem identidade, isto é, um sujeito sem relações sociais. Como saída, 
Bourdieu propõe seu conceito de habitus ou consciência prática, que é 
aprendida na experiência social. Viver do comércio, por exemplo, supõe 
o desenvolvimento de habilidades de cálculo que não são aprendidas da 
noite para o dia e que tampouco são ativadas com a plena intenção de um 
calculista profissional. As preferências do consumidor, diria Bourdieu, são 
formadas e transformadas no processo social.  

Não vamos fazer aqui um compêndio historiográfico do que 
foi esse debate na história das Ciências Sociais, vamos simplesmente 
colocar as perspectivas básicas a que deu lugar na história da teoria 
sobre o comportamento social. Para tanto, desenvolvemos o seguinte 
esquema, com quatro posições tipo, levando em conta uma distinção 
básica feita por Granovetter (1985). Segundo ele, há duas perspectivas 
teóricas fundamentais em Ciências Sociais: a hipossocialização (1) e a 
hiperssocialização (2). 

Figura 15 – Enfoques teóricos da sociologia

Fonte: Elaboração própria
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1.2 Nem ação humana hipersocializada, nem hipossocializada

Granovetter (1985) elabora o conceito de embeddednees (imersão, 
inserção, incarnação etc.)  para oferecê-lo como uma resposta alternativa 
às duas posturas extremas do individualismo e do holismo metodológicos. 
O primeiro entende que agem os indivíduos guiados pelos seus interesses. 
O segundo considera que, após a socialização primária, isto é, a educação 
familiar e escolar, os agentes internalizam os valores do sistema social no 
qual vivem, agindo de conformidade com a sua pauta valorativa. O problema 
reside, segundo Granovetter, em que tanto a posição 1 como a 2 jogam 
o indivíduo na maré do mundo social e se esquecem da variabilidade dos 
contextos em que age. Tanto a hiperssocialização como a hipossocialização 
partem da idéia de que há indivíduos atomizados e sem contexto. Os 
extremos terminam se abraçando. 

Isso significa que os agentes humanos não são marionetes das 
normas e dos valores sociais, postura extrema do holismo metodológico, 
nem seres autistas e anônimos guiados pelo interesse próprio, postura 
extrema do individualismo metodológico. 

2. A estrutura como efeito emergente

Durante um longo período, os cientistas sociais falaram que a ação 
social era, por uma parte, ação estruturante dos agentes, e, por outra, 
ação estruturada pela força da vida institucional. A obra Estudos sobre as 
formas de socialização (Simmel, 1908), que resenhamos antes, permite 
distinguir entre estrutura em sentido forte, no sentido de Lévi-Strauss, 
e estrutura em sentido fraco (Dégenne; Forsé, 2004). Para entendermos 
essa distinção, é necessário apontar que se trata de um desdobramento 
de um processo básico de todo sistema social. Os grupos humanos são 
unidades de ação interdependente na medida em que desenvolvem 
fluxos de trocas permanentes. A isso aponta Lévi-Strauss (1982) em sua 
obra seminal As estruturas elementares do parentesco. Os sistemas de 
parentesco são o desdobramento da interdição básica, o tabu do incesto, 
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que torna indisponível certo grupo de mulheres para o casamento com 
os membros do intragrupo e as destina para as trocas matrimonias com 
outros grupos. E vai mais longe ainda, pergunta-se se talvez na lógica da 
interdição estaria o fundamento da linguagem humana entendida como 
troca de significados. Assumindo a troca como fato básico da vida social, 
podemos distinguir duas acepções do que é uma estrutura social. Uma 
forte, no sentido de Lévi-Strauss, que corresponde a um sistema de normas 
que sancionam os comportamentos socialmente aceitos. Podemos falar, 
nesse sentido, da estrutura fundiária de um país, para designar as regras de 
apropriação do espaço geográfico com finalidade produtiva, tendo como 
centro a propriedade privada.  Mas também podemos identificar uma 
acepção fraca das estruturas sociais. Nesse sentido, estruturas são efeitos 
emergentes, by product, ou supraintencionais, das constantes interações 
entre agentes sociais. Das ações recíprocas, resultam regularidades não 
previstas por nenhum dos envolvidos na ação social. 

Figura 16 – Dupla perspectiva sobre a estrutura social

Fonte: Elaboração própria

Pela dupla acepção anterior, consideramos mais acertado falar em 
uma abordagem neoestrutural que enfatiza o sentido fraco das estruturas 
emergentes no mundo social (Lazega; Higgins, 2014). 
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Na década de 1970, White, Boorman  e Breiger (1976) desenvolvem 
métodos sociométricos que marcam uma evolução em relação à clássica 
técnica do sociograma desenvolvida por Jacob Moreno (1953). A partir 
de então, o campo começou a ser denominado como análise de redes 
sociais (Social Network Analysis). Alguns elementos da trajetória de 
White merecem destaque, como o fato de incursionar na Sociologia após 
ter concluído seu doutorado em física. A sua busca constante tem sido 
criar ferramentas de análise empírica para entendermos como emergem 
formações sociais dentro do processo histórico. Identidade e controle 
(2008) é seu maior legado teórico. Com seu trabalho pioneiro, o campo 
da análise de redes sociais deixa de ser um braço da Psicologia.

Dois discípulos de White, orientados no Ph.D., Mark Granovetter 
e Ronald Burt, entre outros, aplicam a perspectiva neoestrutural a 
problemas próprios do mundo econômico: mercado do trabalho e 
estruturas organizacionais. Veja-se, por exemplo, Getting a job: the 
strength of weak ties (Buscando emprego: a força dos laços fracos), de 
Granovetter (1973); e Structural holes: the social structure of competition 
(Buracos estruturais: a estrutura social da competição), de Ronald Burt 
(1992).

2.1 Digressão: análise de redes sociais e metodologias quantitativas

	 De forma muito ampla, podemos afirmar que a análise de redes 
sociais constitui um conjunto de métodos quantitativos que se aplicam 
a dados relacionais. A quantificação em Ciências Sociais é um tipo de 
interpretação, ou hermenêutica, que tem por foco o valor extensional 
dos dados. Aqui é necessária uma curta digressão pela ciência da lógica 
e a filosofia da linguagem para entendermos a diferença entre intensão 
e extensão de um conceito. Por exemplo, o conceito pobreza pode ser 
entendido em sua extensão como o conjunto das pessoas que, num 
tempo e lugar, enquadram-se numa definição de pobreza. Se a minha 
definição disse que é pobre quem ganha até dois dólares por dia, então 
eu posso medir, ou estimar, a extensão do número de pessoas que no 
Brasil ainda vivem nessa condição. O critério que me conduz a identificar a 
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classe das pessoas pobres corresponde à sua intensão, neste caso, ganhar 
até dois dólares por dia. Note-se que não é intenção com ç, o que significa 
volição ou ato da vontade, e sim com s. Os lógicos medievais falavam 
das intentiones animae para referir-se às representações da mente. A 
definição anterior é conhecida como pobreza por ingressos, amplamente 
divulgada pelos técnicos do Banco Mundial. 

Mas eu posso afirmar que pobre é aquele que não possui água 
encanada nem esgoto ligado a seu domicilio. Nesse caso, o número de 
pessoas que posso contar como pobres, talvez seja diferente daqueles que 
contei a partir da definição do Banco Mundial. Muitas famílias ganham mais 
de dois dólares por dia, porém não possuem serviço de água potável nem 
esgoto. Nesse caso, a intensão do conceito pobreza mudou o mesmo que 
a sua extensão. Tudo isso serve para vermos o simplismo que supõe dividir 
os métodos das Ciências Sociais em qualitativos e quantitativos, como se 
fossem mundos separados. O observador social, nesse caso o economista 
ou o demógrafo, trabalha com conceitos em que a qualitas e a quantitas 
são inseparáveis. 

O assunto torna-se mais complexo quando analisamos o que 
dizem os próprios sujeitos que observamos em nossas pesquisas. Pois eu 
posso ir até uma comunidade de agricultores e perguntar para eles se há 
pessoas pobres na comunidade. O conceito de pobreza entre os nativos 
pode estar distante do que o economista e o demógrafo definem. Por 
exemplo, eles podem afirmar com pleno direito que em sua comunidade 
ninguém é pobre, pois eles produzem tudo o que precisam para estar 
bem alimentados além de ter uma vida saudável sem ar poluído e sem 
águas contaminadas, pois fazem um manejo orgânico das lavouras. Essa 
diferença entre as intensões, ou sentidos, do nativo e do observador 
é o que ordinário leva a pensar que o qualitativo e o quantitativo são 
mundos opostos. Não vamos nos alongar sobre esse ponto, o leitor pode 
revisar um bom manual de introdução à lógica simbólica. 

Em análise de redes sociais, a análise extensional, ou quantitativa, 
opera com dois tipos de registros: a álgebra de matrizes e a teoria topológica 
de grafos. Por essa via, converte-se numa nova forma de administração 



33

Capítulo 2 – A tradição científica da análise de redes 

da prova sociológica, no sentido do que disse Émile Durkheim (2004) no 
capítulo final de As regras do método sociológico.

Retornando à acepção fraca de estrutura, e levando em conta 
a perspectiva interacionista de Simmel, podemos incorporar o velho 
problema dos efeitos não intencionais da ação intencional. Charada 
que já estava presente nas primeiras análises sobre o mundo social no 
século 18, na Riqueza das nações de Adam Smith (1984), e logo retomado 
pela sociologia funcionalista de Robert K. Merton (1968). A melhor 
formulação está nas palavras de Adam Ferguson, um filósofo ilustrado 
contemporâneo de Adam Smith: a história é feita pelos seres humanos, 
porém não obedece a um plano humano. 

O anterior quer dizer que os resultados do processo social não 
estão predefinidos na intenção dos agentes. Não há engenharia social que 
consiga planejar com pleno controle seus resultados. Aqui é interessante 
lembrar o debate político levantado por Karl Popper (1975) em La 
sociedad abierta y sus enemigos, quando afirma que aqueles que desejam 
construir o céu na terra terminam construindo o inferno. Obviamente que 
em seu contexto ele tinha na mira o comunismo internacional da Guerra 
Fria. Mas também é certo que alguns buscaram o inferno na terra sem 
desejar o céu, como foi o caso dos regimes políticos de corte fascista e 
nazista. De qualquer forma, o desafio das Ciências Sociais consiste em 
explicar os efeitos supraintencionais da ação humana. 

Hoje a física de sistemas complexos consegue diferenciar entre 
um fenômeno aleatório e outro caótico. No primeiro, não podemos 
estabelecer um padrão de causalidade, enquanto que, no segundo, ainda 
que tenhamos uma pauta de causalidade, não é possível fazer qualquer 
previsão, dado o caráter aberto do sistema e sua alta sensibilidade 
perante qualquer variação dos fatores que estão entre suas condições de 
existência. Em palavras simples, o desenrolar das sociedades, ao longo da 
história, é um fenômeno caótico ou imprevisível. Podemos estabelecer 
algumas pautas de causalidade, e de fato os cientistas sociais têm 
identificado mecanismos de mudança social, mas isso não significa que 
consigam prever o curso futuro das sociedades. Mas isso acontece também 
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nos estratos biofísicos da realidade, logo, a incapacidade preditiva não é 
só uma limitação das Ciências Sociais, também o é das Ciências Naturais. 

Anthony Giddens (2003) se refere a esse problema em sua obra 
A constituição da sociedade. Demonstra que a ação social não deve ser 
confundia com a ação intencional, pois também somos agentes para além de 
nossas intenções. Algo que o próprio Max Weber (2002) já tinha apontado 
em seu dicionário de conceitos sociológicos que está nos primeiros capítulos 
de Economia e sociedade. O desafio de entender como os sistemas sociais 
geram efeitos combinatórios é bem conhecido na tradição sociológica 
(Higgins, 2011), porém pouco tínhamos avançado até o desenvolvimento 
da sociometria de última geração ou análise de redes sociais. 

2.2 Exemplos de estruturas em sentido fraco ou como efeito combinatório

O que significa que uma estrutura é um efeito combinatório? 
Pensemos no que acontece numa coorte de alunos de um curso 
universitário. No primeiro semestre muitos começam a sua vida 
acadêmica sem se conhecer e, depois de alguns meses, surgem 
agrupamentos específicos por diversos tipos de afinidades, como, por 
exemplo, a origem social e econômica, o desempenho escolar, os vínculos 
afetivos, entre outros. A estrutura forte da vida universitária, seus códigos 
e regras de governo, não predetermina o resultado em termos dos 
grupos de afinidades, os namoros ou conflitos que estarão segmentados 
quando for a data de colação de grau. Se acompanhamos o raciocínio de 
Harrison White (2008), temos de reconhecer que o mundo social não 
está pré-programado pelas regras institucionais ou pelas normas sociais. 
É um fluxo imprevisível de interações. Somos identidades em busca 
de controle, agimos em procura de um ponto de referência para não 
estarmos perdidos na maré do mundo social. Controle não significa, nessa 
experiência originária, necessariamente dominação, ainda que também 
venha a sê-lo conforme a vida social é institucionalizada. As formações 
sociais, sejam indivíduos, organizações, estilos narrativos, emergem dos 
fluxos imprevisíveis do mundo social. 
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Vamos analisar várias situações a partir das quais podemos inferir 
a importância da estrutura social entendida como um efeito emergente, 
isto é, como uma rede de interações que condiciona a ação social, mas 
que é, ao mesmo tempo, produto da própria ação social:

Situação 1 – Imaginemos que um vírus letal ataca o ator nº 1 e que o 
ator nº 4 é o único que está vacinado na rede. Qual das redes é mais 
vulnerável?

Fonte: Elaboração própria a partir de Klovdahl et al. (1992).  

Observações
Para todos os casos e com uma finalidade explicativa, apresentamos 

duas situações tipo: uma rede (A) pouco coesa, com dois setores 
conectados por uma ponte, no que se conhece como buraco estrutural, 
e outra (B) entrosada ou coesa. A cada uma corresponde uma densidade 
delta, 16% na primeira e 32% na segunda (no capítulo 5 será explicada 
essa medida de coesão).  Se as interações sociais possuem uma certa 
estabilidade predeterminada, esta incidirá no resultado do processo 
social que estejamos analisando. Por exemplo, em relação com a situação 
1, hoje temos evidências empíricas de que as redes de contato fazem a 
diferença em certos problemas epidemiológicos. Nicolas Christakis e James 
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Fowler (2007) pesquisaram em que medida a obesidade é um problema 
de difusão social e não só algo genético ou de hábitos alimentares. 
Encontraram evidências de que o convívio ou a relação estreita com uma 
pessoa obesa eleva as probabilidades de que seus parentes ou amigos 
também venham a ter problemas de sobrepeso. Mecanismos causais 
como a decisão nutricional da família, quem decide o que se come em 
casa, passam a um primeiro plano.  

Situação 2 – Imaginemos que uma oferta de trabalho sai do lado a do 
gráfico, qual dos nodos do lado b estará em posição de vantagem para 
usufruir a informação?

Fonte: Elaboração própria a partir de Klovdahl et al. (1992).  

Observações
Nesse caso, vemos como a estrutura de interações trabalha como 

um recurso, ou capital, em favor dos agentes. Quem está na borda do 
buraco estrutural tem todas as condições de levar vantagem de uma 
informação útil, nesse caso, do mercado de trabalho. Mark Granovetter 
(1973) e Ronald Burt (2005) têm sido pioneiros na forma como o 
brokerage ou a intermediação operam no mundo social. Burt desenvolveu 
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um algoritmo para mensurar a vantagem relativa dos nós numa rede, 
chamado de autonomia estrutural ou constraint. 

Situação 3 – Imaginemos que o ator nº 4 é um comerciante que costuma 
pagar com cheques sem fundo a seus colegas mais próximos. Em qual das 
redes o ator nº 7 poderá estar melhor informado das falcatruas do nº 4?

Fonte: Elaboração própria a partir de Klovdahl et al. (1992).  

Observações
Aqui temos um típico problema de ação coletiva. Como manter sob 

controle o comportamento oportunista dos agentes dentro de um sistema 
social, num mercado, por exemplo? A Teoria do Capital Social enfrenta 
duas situações diferentes, pois não é igual que o agente tire vantagens 
da estrutura e que a estrutura coíba as formas desviantes da cooperação. 
James Coleman (1988) chamou atenção para esse fato. No caso da rede B, a 
aplicação de sanções de baixo custo é muito mais provável, dado que o boca 
a boca pode destruir a honra daquele que paga com cheques sem fundo.  
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Situação 4 –  Imaginemos que cada rede corresponde a uma vizinhança. 
O tempo das chuvas chegou e o mosquito da dengue ameaça com uma 
epidemia. Em qual das estruturas de interação haveria maior probablilidade 
de iniciar uma ação coletiva para erradicar os focos do mosquito?

Fonte: Elaboração própria a partir de Klovdahl et al. (1992).  

Observações
Nessa situação, temos um problema de ação coletiva que envolve 

várias dimensões. Em primeiro lugar, o poder de convocar por parte 
de pessoas críveis ou lideranças. Em segundo lugar, a capacidade de 
mobilização dos recursos necessários e a circulação de informação entre 
todos os participantes. Granovetter (1973) apontou para a necessidade 
de estudarmos dinâmicas comunitárias em termos do poder de coesão 
dos laços fracos. 
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Situação 5 – Imaginemos que o nó nº 1 ficou viúvo e que o nó nº 7 ficou 
viúva. Qual das duas redes de amizade os aproximaria mais rápido 
elevando as chances de começarem um namoro?

Fonte: Elaboração própria a partir de Klovdahl et al. (1992).  

Observações
Essa situação aponta a algo contraintuitivo. Num primeiro momento, 

poder-se-ia pensar que na rede B há maiores chances de encontrar um 
parceiro afetivo. Porém, como desvendaram Travers e Milgram (1969), o 
mundo social possui fortes indícios de operar como um pequeno mundo. 
Isto é, habitamos em nichos ou clusters de contatos vinculados entre si 
por laços ponte. Essa condição estrutural reduz a distância topológica 
entre as pessoas, fazendo a famosa média dos 5 graus de distância. 
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3. O que é, então, a análise de redes sociais?

Em resumo, e seguindo a Borgatti (2011b), podemos afirmar que a 
análise de redes sociais é um campo de estudos focado:

•	 Nas relações entre os atores sociais e não em seus atributos 
como raça, gênero, renda etc. Esses podem ser chamados de 
monádicos, fazendo referência à unidade de observação focada 
no agente social, que pode ser uma pessoa, uma organização e 
um país (coluna direita da Tabela 2). 

•	 Na interdependência, na dimensão molecular da vida social e 
não na dimensão atomística da vida social. Isso significa que 
estamos focando as relações entre agentes (coluna esquerda 
da Tabela 2). 

•	 Nos efeitos emergentes e substantivos da estrutura (como, por 
exemplo, o controle social e o acesso a recursos).

Tabela 2 – Tipos de atributos em pesquisa social

Análise de redes
Parte de atributos diádicos

Estatística aplicada às ciências sociais
Parte de atributos monádicos

Parentesco: pai de, filho de,
Rol social: chefe de,

Cognitivos: conhece a,

Afetivo: gosta de, amigo(a) de,

Ação: compartilha com,
Distância: longe de, próximo a,

Co-ocorrência: na mesma escola com,

Raça
Sexo

Renda

Idade

Escolaridade
Categoria profissional

3.1 Dados monádicos em Ciência Social

Levando em conta a diferença entre dados diádicos e monádicos, 
podemos observar vários exemplos do que a pesquisa habitual, em Ciência 
Social, apresenta como resultados de dados agregados.  Os histogramas 
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de frequências (ver a seguir) apresentam a mudança demográfica do 
Brasil no século 20: em 60 anos houve uma parábola populacional.  A 
partir dos anos 1970, a população residente em meio rural diminui até 
atingir 32 milhões. A curva da população residente em meio urbano é 
exponencial. Não parou de crescer a partir de 1940. Na virada do século 
21, era de 140 milhões. 

Nos exemplos anteriores, do ponto de vista demográfico, o 
importante é mensurar tamanhos e atributos monádicos agregados de 
uma unidade de observação, que é o Brasil. 

Gráfico 1 – Brasil: população residente rural
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Gráfico 2 – Brasil: população residente urbana
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Ordem causal e análise de redes (Borgatti, 2011b)

3.2 A condição diádica da análise de redes 

A análise de redes sociais é simultaneamente um fornecedor e um 
cliente de diversos domínios científicos:

•	 Cliente de um braço da matemática conhecido como teoria de 
grafos, da álgebra de matrizes, e da teoria de probabilidades.

•	 Fornecedor da Psicologia, Sociologia, Ciências da Saúde, 
Ciências da Administração etc. 

4. O problema do pequeno mundo: o experimento de Travers 
e Milgram  

Após as colocações anteriores e do ponto de vista da análise de 
redes, podemos perguntar: então, qual é a comensurabilidade que 
importa? A partir de um estudo experimental, transformado em obra 
seminal, An experimental study of the small world problem, Jeffrey Travers 
e Stanley Milgram (1969) colocaram uma nova pergunta para a pesquisa 
sobre o mundo social:

“Dados dois indivíduos selecionados aleatoriamente de uma 
população, qual é a probabilidade para que o número mínimo 
de intermediários necessários, que possa conectá-los, seja 0, 1, 
2....., k?” (Travers; Milgram, 1969, p. 426).



43

Capítulo 2 – A tradição científica da análise de redes 

	 Um indivíduo alvo e um grupo de pessoas de partida foram 
escolhidas aleatoriamente com a finalidade de tentar gerar uma corrente 
de contatos que fosse de cada ponto de partida até o alvo. 

A cada indivíduo de partida foi confiado um pacote, que devia 
enviar pelo correio ao indivíduo alvo. Levemos em conta que na época 
não havia ainda internet. O pacote nomeava explicitamente o indivíduo 
alvo e incluía uma carta solicitando àquele que a recebia que se tornasse 
um membro ativo da corrente enviando-o a outra pessoa. Foi estipulado 
que o dossier devia ser encaminhado através de um conhecido direto. Nos 
documentos havia informações suficientes do indivíduo alvo.

A corrente terminava quando atingia a pessoa alvo ou quando 
alguém se recusava a fazer o envio. Foram coletadas algumas informações 
de monádicas ou dos indivíduos de partida (idade, sexo, profissão). 

Desenho do experimento de Travers e Milgram (1969)
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Foram dadas aos respondentes algumas instruções adicionais:

•	 Se o receptor conhecia pessoalmente o alvo, devia enviá-lo 
diretamente. 

•	 Se o receptor não conhecia o alvo, era-lhe proibido tentar 
entrar em contato diretamente através da lista telefônica. Era 
sugerido o envio a um conhecido (amigo, parente, colega) que 
estivesse em condição de conhecer melhor o alvo.

•	 Para evitar que o pacote voltasse a alguém que já tinha 
sido destinatário da corrente, uma lista dos intermediários 
acompanhava o envio, e cada expedidor devia acrescentar-se 
à lista. 

Eis os principais resultados da pesquisa de Milgram e Travers:

•	 217/296 enviaram o pacote para um conhecido.
•	 64 dossiers chegaram ao indivíduo alvo, os restantes foram 

correntes interrompidas.
•	 Quando o número de intermediários aumenta, é menor a 

probabilidade de que o último nodo abandone, deixando de 
enviar o dossier.

•	 86% dos participantes enviaram o pacote para amigos ou 
conhecidos.

•	 14% dos participantes enviou o dossier para parentes. 
•	 O comprimento médio das correntes foi de 5,2 intermediários.

Sendo prudentes sobre a generalização, a experiência de Milgram e 
Travers permite inferir que, para ligar duas pessoas que não se conhecem, 
num conglomerado tão vasto como os EUA, só precisamos em média de 
pouco mais de 5 intermediários. 

Declarações posteriores permitiram identificar:

•	 As correntes completas chegaram ao alvo, via o conhecimento de 
seu lugar de residência, com uma média de 6,1 intermediários.

•	 As correntes completas chegaram ao alvo, via o conhecimento 
do emprego, com uma média de 4,6 intermediários.
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•	 As correntes que partiram de Boston se revelaram mais curtas 
(4,4) que aquelas que partiram de Nebraska (5,7), diferença 
estatisticamente significativa.

5. Exercícios 

1. Abra sua caixa de correio eletrônico:
A. Identifique os remetentes e os destinatários dos últimos dias 

15 dias e faça uma lista de cada grupo (remetentes e destinatários). Até 
quarenta nomes de cada um.

B. Diferencie as mensagens de entrada e saída pelos seguintes 
critérios: amizade, conhecido ou institucional. 

Numa folha em branco, marque um ponto escuro no centro. Esse 
ponto representa você mesmo.

Represente no espaço em branco, com pontos e nomes, aquelas 
pessoas que enviaram mensagens para você; leve em conta as distâncias 
para marcar a proximidade afetiva: amigo(a), conhecido(a) ou institucional. 
Desenhe uma seta procedente daquelas pessoas que enviaram mensagens 
para você. Faça o mesmo, mas desenhando setas de saída, indicando para 
quais pessoas você enviou uma mensagem. Se procedente de ou em 
direção a houver mais de uma mensagem, marque várias setas. 

Figura 17 – Exemplo de um mundo de relações pessoais

Teresa

Helena Alex

Adriane Mônica
João

Pedro

Zé
Guga

Jorge

Cleusa

Maria

Raquel

Diogo

Fonte: Elaboração própria	

C. Você terá um grafo de seu mundo de relações digital
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2. Pegue seu telefone celular.

A. Liste seus contatos (até trinta).
B. Identifique as últimas 30 ligações recebidas e os últimos 30 

números discados.
C. Desenhe um gráfico semelhante aos dois anteriores. Desta vez, 

identifique com setas as suas últimas ligações telefônicas; com setas de 
saída e de chegada, as ligações discadas e recebidas. Desta vez, se houver 
mais de uma ligação com um mesmo contato, marque tantas setas quantas 
sejam necessárias.

Figura 18 – Exemplo de relações diferenciadas pela frequência dos 
contatos

Fonte: Elaboração própria

D. Há alguma diferença entre seu mundo de relações on line e via 
telefone? A que atribui as diferenças?
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Capítulo 3 – Conceber um  
estudo de redes

1. Identificar as variáveis-chave 

Como em toda pesquisa sociológica, assumimos que o primeiro 
passo para desenhar uma boa investigação consiste numa profunda 
intimidade do pesquisador com a problemática através de diversas 
formas de conhecimento, seja este etnográfico, historiográfico ou pela 
revisão exaustiva da tradição científica sobre o problema. Nesse sentido, 
a análise de redes sociais é uma perspectiva e uma ferramenta entre 
outras, mas que permite enxergar o que dificilmente pode ser captado 
através de outras abordagens. A diversidade de métodos não é um fato 
trivial isento de conflitos. Não se trata simplesmente de querer agradar 
a todos e todas dizendo que a realidade não se esgota numa perspectiva 
teórica ou metodológica, pois, por exemplo, os achados de uma boa 
etnografia podem ser questionados por outro tipo de abordagem. 
Bearman (1997) contesta modelos de troca matrimonial, em povos 
aborígenes australianos, que tinham sido analisados com as ferramentas 
clássicas da análise de parentesco. Em seu lugar aplica block models para 
entender o surgimento de um sistema solidário de trocas generalizadas. 
Sendo assim, cabe ao pesquisador, em estreita discussão com a sua 
comunidade científica, decidir quais achados resultam mais consistentes 
em relação com uma determinada problemática.

Em continuação, apresentemos algumas recomendações para 
termos bons insights que conduzam a uma pesquisa original em análise 
de redes sociais (Lazega e Higgins, 2014). Nesse caso, como em qualquer 
outra situação que exige criatividade, a intuição não pode ser comunicada 
pelo orientador de pesquisa nem pelo manual de investigação, quando 
muito pode ser estimulada e desafiada. A imaginação sociológica é uma 
inspiração que somente bate na porta do pesquisador disciplinado que 
trabalha com tesão. 
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1.1 Identificar uma variável estrutural 

Em primeiro lugar, o pesquisador precisa identificar uma, ou mais, 
variável estrutural que coloque em relação todos os atores do sistema 
social que visamos estudar. Aqui é fundamental estar atento às interações 
em pelo menos duas dimensões: (1) as trocas entre os agentes/
identidades; e (2) os recursos que circulam dentro do universo social com 
o qual trabalhamos. 

1.2 Identificar os atributos dos agentes 

Como em qualquer outra pesquisa social, as variáveis que 
correspondem aos atributos dos agentes são de vital importância para 
o entendimento do fenômeno social em questão. Levando em conta a 
distinção feita antes, falamos aqui dos atributos monádicos, como, por 
exemplo, a idade, o gênero, a raça, a origem social, o nível salarial ou 
qualquer outra informação que seja relevante para o entendimento de 
nosso problema. 

1.3 Identificar os comportamentos relevantes

Apontamos aqui para as formas de ação que são susceptíveis de ser 
influenciadas pela posição que ocupam os agentes dentro da estrutura de 
relações. Por exemplo, se queremos entender o sistema de aprendizado 
dentro de uma organização, o que também é conhecido como aprendizado 
social, será de vital importância reconstruir o status dos agentes em 
termos de sua expertise, saber quem é percebido como mais experiente 
ou habilitado para resolver problemas do campo profissional em que atua 
a organização. Pensemos, também, na forma como agentes do mundo 
político podem coligar ou se desligar em função das oportunidades que 
oferece o contexto de uma mobilização social, como no caso da ação de 
movimento ao longo de uma jornada de protestos, isto é, a posição relativa 
de vantagem pode acionar determinadas respostas de aproximação ou 
rejeição. A pesquisa de Ann Mische e Phillippa Pattinson (2000) sobre o 
processo de impeachment do Presidente Fenando Collor ilustra muito 
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bem de que forma a ação política é mais complexa do que pretendem os 
modelos da escolha racional.  

2. Coleta de dados

Uma vez mais, chamamos a atenção para o fato de que não 
há receita de bolo que acione a imaginação metodológica. Como em 
qualquer pesquisa sobre o mundo social, temos a opção de coletar dados 
primários ou secundários.  Na primeira opção, o procedimento padrão 
é a formulação de uma questão sociométrica. No segundo, podemos 
reconstruir estruturas relacionais a partir de informações secundárias, 
como, por exemplo, arquivos, anuários, jornais etc. Mas na era do mundo 
interconectado pela transmissão digital de dados, contamos hoje com 
informações de grande tamanho disponíveis na rede mundial de dados; 
estamos falando dos conhecidos big data. Nesse ponto, uma reflexão é 
pertinente e necessária. Há um antes e um depois dos big data. 

O pesquisador desavisado pode pensar que a coleta de informação 
mediante a aplicação direta de questionários é coisa do passado, como 
se fosse uma espécie de dado artesanal, quando comparado com a 
sofisticação da programação computacional que é necessária para a 
ELT (extract, load and transform) dos dados digitais. A societas duplex, 
formada pelos mundos on line e off line, pode ser vista como uma 
superação das interações cotidianas, dos encontros e das encenações 
extensamente analisadas por Erwing Goffman (1956). Aqui é bom 
lembrar uma observação feita por Robert Putnam (2001) em seu estudo 
sobre o declínio do capital social na sociedade norteamericana. Quando a 
invenção de Antonio Meucci, o telefone eletromagnético, ganhou escala 
de produção industrial pelas mãos de Alexander Grahan Bell, muitos 
pensaram que isso seria o fim das relações de vizinhança e proximidade. 
Mas nada disso aconteceu, as comunicações a distância simplesmente 
distenderam as relações de proximidade, as tornaram mais complexas, 
mas não as substituíram. Algo análogo está acontecendo com o mundo das 
interações humanas mediadas pelos dispositivos tecnológicos de ponta. A 
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nossa forma de construir a intimidade ou de projetar nossa identidade 
está sujeita a novas gramáticas tecnológicas, mas isso não significa que os 
encontros cara a cara, pele a pele, venham a desaparecer da vida social. 

2.1 Coleta primária: questionário sociométrico 

Há diversas técnicas que permitem estimular nos respondentes a 
identificação de quais são as suas interações. A estratégia vai depender 
do conhecimento prévio do pesquisador sobre o universo em rede que 
deseja pesquisar e do atributo diádico que visa reconstruir.

Na literatura de redes, a questão sociométrica padrão é denominada 
gerador de nomes. Porém, seria melhor chamá-lo, de forma genérica, 
gerador sociométrico, para evitarmos a ambiguidade entre o nome do 
agente e a posição social que ocupa. 

Em continuação, vamos apresentar vários exemplos, levando em 
conta a tipologia proposta por Wasserman e Faust (1994):

Tabela 3 – Diferentes tipos de  questionários sociométricos

No sentido das linhas, a tabela apresenta duas estratégias tipo 
para a coleta de informação sociométrica. Se conhecemos todos os 
membros de um grupo ou de uma organização, podemos apresentar a 
lista, ou roster, para cada um dos respondentes. Logo, levantamos a(s) 
questão(ões) pertinente(s) do ponto de vista teórico. O respondente terá 
a opção de apontar com quais de seus pares na lista interage de forma 
específica.  
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2.1.1 Gerador sociométrico Tipo 1 (roster) (Higgins, 2012)

Tipo de dado: atributo diádico, visando captar a intermediação de 
informação.

“Aqui está a lista de todos os associados. No período dos últimos seis 
meses, quais foram as pessoas da Associação A PALMA S.A. com as quais 
você conversou para se manter informado sobre o normal funcionamento 
da organização?”

“Por que escolheu essas pessoas?”
Neste caso, devemos conhecer antes todos os membros da 

organização. 
No caso de não conhecermos todos os membros do universo cujas 

relações queremos estudar, a livre escolha, ou free recall, é uma opção. 
Em continuação, apresentamos um exemplo que inclui também uma 
escala, ou rating, que mensura a intensidade das relações de amizade.

2.1.2 Gerador sociométrico Tipo 2 (free recall e rating) (Rapoport; 
Horvath (1961) apud Wasserman; Faust, 1994)

Tipo de dado: atributo diádico, grau de amizade.
Fazendo uma comparação entre duas escolas, foi pedido a cada 

aluno, dentro do grupo de sua série, para escrever o nome, idade, grau e 
endereço e depois preencher os espaços em branco das frases seguintes:

“Meu melhor amigo na (nome da escola) é___”
“Meu segundo melhor amigo é___”
(….)
“Meu oitavo melhor amigo é___”

2.1.3 Gerador sociométrico Tipo 3 (Escolha fixa da relação e free recall) 
(Coleman; Katz; Menzel, 1957)

Tipo de dado: atributo diádico, difusão de inovações entre médicos.
A cada médico entrevistado lhe foram feitas as seguintes três 

questões sociométricas:
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(i)  “Qual foi o colega que procurou com mais frequência para 
solicitar-lhe conselho e informação?”

(ii)“No curso de uma semana ordinária, qual foi o colega mais 
procurado para discutir os casos clínicos?”

(iii) “Quais foram os amigos, entre os colegas, com os quais se 
encontrou em reuniões de lazer?”

2.1.4 Gerador sociométrico Tipo 4 (ranking completo) (Bernard, Killworth 
e Sailer (1980)  apud Wasserman; Faust, 1994)

Tipo de dado: atributo diádico, colaboração científica entre os 
membros de um laboratório de pesquisa.

A cada participante foi entregue um pacote de cartas que 
continha os nomes dos quarenta membros do escritório científico. 
Eles hierarquizavam as cartas segundo a frequência (do maior grau ao 
menor) com a qual conversavam com seus colegas de trabalho num dia 
qualquer.

2.2 Coleta secundária

A coleta de informação a partir de dados secundários não possui 
receitas fixas para reconstruir estruturas em rede. Vale a intimidade 
do pesquisador com a problemática e uma boa dose de criatividade e 
imaginação sociológica que lhe permitam intuir onde há uma informação 
relevante. Como foi dito antes, na era digital, há informação disponível na 
forma de grandes dados (big data) esperando para ser extraída, baixada 
e transformada. Isso demanda expertise em programação computacional 
específica que não está no foco desta obra introdutória. Apresentamos 
alguns exemplos de informações secundárias que constam em pesquisas 
exemplares no domínio da análise de redes. 

Em estudos de Sociologia da Ciência é frequente reconstruir 
regularidades a partir das citações bibliográficas entre scholars: quem cita 
a quem? É uma forma padrão de entender a difusão de uma inovação 
científica.
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Ronald Burt (1983) obteve informações sobre interações entre 
atores corporativos a partir das primeiras páginas do New York Times. 
Olivier Godechot e Nicolas Mariot (2004) construíram um banco de dados 
relacional a partir dos registros das bancas de defesa de doutorado da 
École des Hautes Études en Sciences Sociales para um período de mais 
de quarenta anos, 1960 a 2006. Esses dados permitiram reconstruir as 
estruturas de colaboração acadêmicas entre pesquisadores da Ciência 
Política. Essa estrutura foi levada a um modelo matemático formal em 
que a rede de colaboração e o sistema de status inerente eram preditores 
da empregabilidade dos egressos. No contexto brasileiro, Barbosa e 
Veneroso (2015) fizeram um trabalho semelhante reconstruindo a rede 
de coautoria entre membros de programas de pós-graduação das Ciências 
Contábeis do Brasil a partir do currículo Lattes. 

3. Problemas da coleta de dados sociométricos

Como em qualquer abordagem metodológica, a coleta de dados 
coloca problemas de diversas índoles para o pesquisador.

3.1 Problemas éticos

No levantamento de dados relacionais, é muito frequente 
encontrar resistência por parte dos entrevistados. Apontar relações 
com outras pessoas levanta desconfianças. Incrementam-se, então, as 
suspeitas em relação ao mandato supremo de toda pesquisa: manter 
o sigilo dos dados e o anonimato das pessoas ou organizações que são 
objeto de estudo.  

3.2 Risco de viés na informação

Vejamos a ambiguidade da seguinte questão: quais são seus 
amigos entre todas as pessoas que figuram nesta lista? O que cada 
pessoa entende por amizade pode ser muito diferente, levando assim a 
distorções cognitivas na origem dos dados. A forma mais útil de contornar 
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o problema é a construção de uma escala ou índice pelo qual seja reduzida 
a ambiguidade da percepção. Por exemplo, podemos perguntar: 

Entre os colegas de trabalho, indique por favor quem é:
•	 Desconhecido
•	 Conhecido
•	 Parceiro de trabalho
•	 Amigo de confiança
Devemos salientar que a opção do free recall, ou chamada 

espontânea das pessoas pelos seus parceiros de relações, tem como 
risco a variabilidade da memória das pessoas, o que pode deixar de fora 
informações valiosas. 

3.3. Gerar nomes ou posições?

Devemos levar em conta que não é igual gerar nomes e gerar 
posições dentro de um domínio em rede. No primeiro caso, podemos 
demandar os nomes segundo um tipo de relação previamente definido 
pelo pesquisador (por exemplo, colaboração técnica); no segundo caso, 
podemos perguntar pela posição relativa que ocupam os agentes num 
determinado sistema social (por exemplo, quem é o considerado como o 
mais influente, o mais isolado, o de maior expertise etc). 

3.4 A rede reconstruída não é uma substância ou coisa em si

A coleta de dados em rede está submetida às mesmas questões 
que a Epistemologia e a Sociologia do Conhecimento fazem para outras 
técnicas de trabalho. Vale lembrar que estamos após a crítica kantiana 
do conhecimento. Não podemos cair num encantamento ingênuo da 
pesquisa em rede, como se estivéssemos buscando conhecer entidades 
já dadas.

	 No caso dos geradores sociométricos, o pesquisador não possui 
acesso “em frio”, isto é, sem mediação, às relações que se decantam 
em estruturas emergentes. Não observamos uma “coisa em si” ou uma 
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substância reticular. Todos os dados em redes são na verdade percepções 
do que os declarantes consideram que são suas interações.

	 Nesse sentido, as redes, descritas pelos grafos, são como fotos 
instantâneas de um agregado de percepções. Hoje a pesquisa de ponta 
avança na construção de softwares que permitam entender a evolução 
dos dados reticulares. SIENA (Snijders, 2018) é o programa de computador 
pioneiro nesse campo. 

4. Redes sociais: possibilidade de amostragem, unidades de 
análise

A análise de redes procede por amostragem? Eis uma pergunta 
recorrente nos cursos e no treinamento sociométrico. O recorte 
do universo relacional não procede por critérios probabilísticos de 
independência das observações, pois, pela natureza interdependente 
dos dados, corremos o risco de deixar de fora atores-chave da estrutura. 
De ordinário, os universos relacionais estão circunscritos a mundos mais 
ou menos delimitados, por exemplo, uma empresa ou organização, um 
setor produtivo com um número determinado de empresas, um campo 
especializado de relações de colaboração acadêmica etc.

Vejamos qual é o risco da amostragem probabilística (Lazega; 
Higgins, 2014): 

Figura 19 – Estrutura de interação e o risco da amostragem aleatória 

Fonte: Lazega e Higgins (2014)
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Vamos supor que um universo relacional possui a estrutura chamada 
de “borboleta”, como no grafo anterior. Num plano de amostragem aleatória, 
haverá uma alta chance de deixar de fora o nodo i, sendo este o agente 
mais importante em termos de intermediação e proximidade. Devemos 
salientar, porém, que a pesquisa teórico-probabilística busca soluções para 
esse problema. Mark Granovetter (1976) publicou um artigo no qual explora 
o problema da inferencialidade para dados em rede, levando em conta a 
interdependência das observações e avaliando a distribuição do tamanho 
das amostras. Porém, a sua proposta está restrita somente à densidade da 
estrutura da rede, isto é, restringe-se ao nível diádico ou à estimativa do 
número de relações, dado um universo populacional.  

5. Unidades de análise 

No caso da análise de estruturas em redes, a unidade de observação 
pode estar focada nos nós, no tipo de relações ou na estrutura como 
um todo. Em cada caso, cabem algumas distinções importantes, que é 
importante salientar.

Figura 20 –  Unidades de análise em estruturas relacionais

Fonte: Elaboração própria
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Antecipamos ao leitor que as redes parciais (ego networks), em que 
só possuímos as escolhas ou relações diretas de um indivíduo com seus 
alters, não servem para fazer análises estruturais. Porém, há no contexto 
brasileiro alguns trabalhos como o de Marques (2012), no qual foram 
reconstruídas as redes pessoais (ego networks) de 150 pessoas pobres 
e 30 pessoas de classe média da cidade de São Paulo. O trabalho visa 
entender os padrões de sociabilidade que condicionam a segregação 
social das pessoas em situação de pobreza. A questão-chave consiste em 
entender até onde o tipo de inserção social, mensurado e reconstruído 
a partir da percepção das relações sociais das pessoas entrevistadas, 
permite explicar a persistência da pobreza.

Desse estudo não podemos fazer inferências estatísticas, no sentido 
amostra-população, pois o número de observações no ponto de partida 
não segue um critério amostral válido. 

6. Vantagens da análise de redes: do organograma 
funcionalista às redes de interação

A construção e análise de dados em rede não é um trabalho 
teoricamente neutro. Isto é, intrinsecamente a nossa base informacional 
abre um horizonte de novas possibilidades de interpretação. Por exemplo, 
nos estudos sobre organizações, seja no campo do business studies ou 
da Sociologia, há um contraste claro entre entender uma organização 
como um conjunto de posições funcionais previamente definidas pelo 
observador, ou pelos estatutos jurídico-legais da empresa, ou como 
uma forma emergente da interação dos participantes. No primeiro 
caso, a ferramenta metodológica com fins analíticos mais difundida é 
o organograma, do qual temos um exemplo na Figura 21. Esse tipo de 
gráfico representa, de forma intuitiva as posições funcionais dos agentes, 
o mesmo que a hierarquia em relação com a posição de mando e 
obediência. Porém, essa é uma representação pobre e limitada do que 
de fato acontece em termos de relações sociais, pois um universo de 
pessoas que constitui um sistema de produção, seja de bens ou serviços, 
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privados ou públicos, é uma realidade dinâmica em que os papéis sociais 
não estão estritamente predefinidos pelo que mandam fazer os estatutos. 
De forma ingênua, podemos pensar que o centro de decisão de um 
organograma hierárquico está com aquele que ocupa o topo da pirâmide. 
Porém, se atentamos para como acontecem as relações de troca entre os 
integrantes da empresa, para as formas endógenas de reconhecimento da 
autoridade, é possível que o verdadeiro centro de autoridade e decisão 
seja um ator aparentemente subordinado. Isto é, a organização formal é 
subvertida pela organização real. 

Ilustramos essa diferença básica comparando o organograma da 
Figura 21 com o grafo da Figura 22. Os dados correspondem às informações 
obtidas junto a uma associação de agricultores (Higgins, 2011). Segundo 
o primeiro gráfico, o centro de decisão da organização representada está 
na assembleia geral dos associados. Porém, após coletar informações de 
campo, mediante técnicas sociométricas, descobrimos que o centro da 
organização é um agente externo, nesse caso um extensionista agrícola 
do qual dependem todos os membros para receber assessoramento, 
visando ao cuidado das lavouras. A segunda visualização pressupõe um 
tipo de dado relacional que não está na base da Figura 21. Isto é, a pintura 
que surge da organização não formal, porém real, não coincide com a 
representação apriorística e intuitiva do organograma.

Figura 21 – Exemplo de organograma

Junta Diretora
Presidente

Vice-Presidente, Secretário,
Tesoureiro e dois suplentes

Fiscal
Função de
controle



59

Capítulo 3 – Conceber um estudo de redes

Figura 22 – Associação La Palma

Fonte: (Higgins , 2011).

7. Exercícios 

Este exercício está baseado em uma coleta de dados secundária. 
Foi pensado para você aplicar os conhecimentos que aprendeu até este 
ponto do livro e para você desenvolver a capacidade de identificar dados 
relevantes que podem subsidiar uma boa análise de redes sociais. 

Os dados do Figura 23 ilustram as informações sobre transferências 
de jogadores realizadas pelos clubes da 1ª divisão do campeonato 
brasileiro de futebol no ano de 2017 a partir das trocas realizadas por 
Cruzeiro e Altético-MG. A Figura 24 mostra a classificação final dessa 
edição do campeonato. Os dados foram retirados do site www.futebol365.
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pt, onde você encontrar as informações completas sobre as transferências 
de jogadores realizadas pelos 20 clubes da 1ª divisão em 2017. Com 
base nas informações do site, separamos para você um arquivo com as 
transferências realizadas pelos clubes de futebol que jogaram a 1ª divisão 
do campeonato e as classificações finais nos últimos 5 anos (de 2013 a 
2107); esses dados estão disponíveis em www.giars.ufmg.br. 

Figura 23 – Transferências de jogadores Atlético-MG e Cruzeiro em 2017 

Transferências do Atlético-MG

Entrada Jogador Origem Tipo

06/06/2017 Valdívia Internacional Empréstimo

06/04/2017 Rómulo Otero Huachipato Definitivo

22/03/2017 Marlone Corinthians Empréstimo

08/03/2017 Adilson Akhmat Grozny Definitivo

27/01/2017 Elias Sporting Definitivo

Saídas Jogador Destino Tipo

23/01/2018 Robinho Sivasspor Definitivo

01/07/2017 Henrique CSKA Sofia Definitivo

28/02/2017 Hyuri Chongqing Lifan Empréstimo

11/02/2017 Lucas Pratto São Paulo Definitivo

26/01/2017 Edcarlos Club Olimpia Definitivo

19/01/2017 Fillipe Soutto Red Bull Brasil Definitivo

19/01/2017 Marion América-MG Definitivo

19/01/2017 Renan Oliveira América-MG Definitivo

07/01/2017 Jesús Dátolo Vitória Definitivo

Transferências do Cruzeiro

Entradas Jogador Origem Tipo

22/07/2017 Rafael Galhardo Anderlecht Definitivo

22/05/2017 Jonata CRB Empréstimo

31/01/2017 Lucas Silva Real Madrid Empréstimo

11/01/2017 Luis Caicedo Independiente JT Definitivo

07/01/2017 Thiago Neves Al-Jazira Definitivo
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Saídas Jogador Destino Tipo

08/01/2018 Joel Marítimo Definitivo

24/11/2017 Rafael Donato U. Madeira Definitivo

29/07/2017 Bruno Ramires Moreirense Empréstimo

11/07/2017 Ruan Teles Varzim Definitivo

08/07/2017 Allano Estoril Definitivo

17/06/2017 Rick Sena Marítimo Empréstimo

01/06/2017 Joel Avaí Empréstimo

22/05/2017 Rafael Donato Joinville Empréstimo

30/03/2017 Edimar São Paulo Empréstimo

22/02/2017 Federico Gino Santa Cruz Empréstimo

21/02/2017 Duvier Riascos Millonarios Definitivo

09/02/2017 Matiás Pisano Club Tijuana Definitivo

01/02/2017 Bruno Ramires Vitória Empréstimo

28/01/2017 Joel Botafogo Empréstimo

19/01/2017 Paulo André Atlético-PR Definitivo

14/01/2017 Gabriel Xavier Vitória Empréstimo

04/01/2017 Diego Renan Chapecoense Definitivo

02/01/2017 Douglas Grolli Chapecoense Empréstimo

01/01/2017 Rafael Donato ABC Empréstimo

28/05/2016 Felipe Seymour Unión Española Definitivo

Fonte: Elaboração própria, a partir de www.futebol365.pt (acesso em março de 2018)

Figura 24 – Tabela 38º rodada do campeonato brasileiro de 2017

Classificação – Final Campeonato Brasileiro de 2017

Posição Clube J V E D GM GS DG P

1º Corinthians 38 21 9 8 50 30 20 72

2º Palmeiras 38 19 6 13 61 45 16 63

3º Santos 38 17 12 9 42 32 10 63

4º Grêmio 38 18 8 12 55 36 19 62

5º Cruzeiro 38 15 12 11 47 39 8 57

6º Flamengo 38 15 11 12 49 38 11 56

7º Vasco 38 15 11 12 40 47 -7 56
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Classificação – Final Campeonato Brasileiro de 2017

Posição Clube J V E D GM GS DG P
8º Chapecoense 38 15 9 14 47 49 -2 54

9º Atlético-MG 38 14 12 12 52 49 3 54

10º Botafogo 38 14 11 13 45 42 3 53

11º Atlético-PR 38 14 9 15 45 43 2 51

12º Bahia 38 13 11 14 50 48 2 50

13º São Paulo 38 13 11 14 48 49 -1 50

14º Fluminense 38 11 14 13 50 53 -3 47

15º Sport 38 12 9 17 46 58 -12 45

16º Vitória 38 11 10 17 50 58 -8 43

17º Coritiba 38 11 10 17 42 51 -9 43

18º Avaí 38 10 13 15 29 48 -19 43

19º Ponte Preta 38 10 9 19 37 52 -15 39

20º Atlético-GO 38 9 9 20 38 56 -18 36

Legenda: J = Jogos; V = Vitórias; E = Empates; D = Debates; GM = Gols Marcados; GS = Gols 
Sofridos; SG = Saldo de Gols; P = Pontos.

Fonte: site www.futebol365.pt (acesso em março de 2018)

Após a análise das duas figuras, responda:
1) É possível conceber uma análise de redes sociais a partir das 

informações sobre transferências de jogadores realizadas pelos clubes da 
1ª divisão do campeonato brasileiro?

(   ) Sim	 (   ) Não
2) Se você respondeu sim, identifique os elementos úteis à análise 

de rede sociais que podemos retirar das duas figuras acima. Isto é:
a. Quem são os atores do universo relacional?
(  )  Jogadores		  (  ) Presidentes de clube
(  ) Empresários		  (  ) Clubes de futebol
(  ) Patrocinadores	 (  ) CBF e federações estaduais
b. Qual é a variável estrutural contida nesses dados? Isto é, qual é o 

recurso que circula pela rede?
(  ) Dinheiro		  (  ) Títulos de campeão
(  ) Jogadores		  (  ) Clubes de futebol
(  ) Conselhos		  (  ) Treinadores
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c. Quais atributos podemos identificar nas informações acima para 
inserir em uma análise de redes sociais (marcar mais de uma)?

(  )  Idade dos jogadores	 (  ) Função dos jogadores
(  ) Tipo da transferência	 (  ) Nacionalidade dos clubes	
(  ) Patrimônio dos clubes	 (  ) Classificação final dos clubes
d. Quais comportamentos relevantes possivelmente associados à 

posição dos atores na rede podemos identificar nas informações acima?
(  ) Patrimônio dos clubes	 (  ) Posição na classificação final
(  ) Pontuação alcançada	 (  ) Nacionalidades dos jogadores
(  ) Número e saldo de gols	 (  ) Empates, vitórias e derrotas.
3) Descreva quais informações complementares podem ser 

levantadas para enriquecer a análise estrutural dos dados apresentados.
4) Aponte os principais limites dos dados citados nas Figuras 23 e 

24. Por exemplo, o que podemos dizer sobre a fronteira dessa rede?
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Capítulo 4 – A linguagem dos grafos

1. Noções básicas sobre grafos

A linguagem dos grafos é a ferramenta fundamental para descrever 
a morfologia das redes sociais. Para sermos mais exatos, a Teoria de Grafos 
é um tipo de geometria, conhecida de forma específica como topologia, 
de grande expansão e com diversos usos aplicados, especialmente em 
Ciências da Computação e nas Ciências Sociais. Devemos a Dénes König 
(1990), matemático húngaro, a primeira sistematização da Teoria de 
Grafos, publicada em sua obra Teoria de grafos finitos e infinitos.  

Figura 25 – O mapa de Euler

Fonte: Digital commons.

O que diferencia a topologia da geometria convencional, ou 
euclidiana, que aprendemos nos primeiros anos da escola? Para sermos 
didáticos, vamos apresentar o problema que o matemático Leohnard 
Euler formulou em 1736, conhecido como as sete pontes de Könisgberg. 
Nessa cidade, que hoje faz parte da Rússia, havia sete pontes para cruzar 
uma ilha formada pelos dois braços de um rio. É proverbial a história de 
que o filósofo Emmanuel Kant era tão rigoroso que sempre fazia a mesma 
rotina ao longo da cidade, ao ponto de que os habitantes do vilarejo 
não precisavam consultar o relógio para saber a hora, bastava saber se 
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o professor estava passando ou não. O desafio consistia em saber se era 
possível para qualquer um, incluído Kant, cruzar as sete pontes passando 
por cada uma delas somente uma vez.

Esse problema ajuda a entender de forma clara a diferença entre a 
geometria euclidiana e a topologia criada por Euler. O que o desafio pede 
não é uma solução em termos de áreas ou distâncias, tal e como fomos 
ensinados na escola. Aqui não se trata de encontrar a distância mais curta, 
por exemplo. O assunto é outro, consiste em saber se há solução para 
um circuito de caminhos sob uma condição dada de não repetição. Nesse 
ponto entra em cena a ideia do grafo e a sua vantagem de visualização. 
Vejamos como na Figura 26 os blocos de terra foram transformados em 
pontos e as pontes em linhas ou caminhos. Dessa forma fica mais fácil 
entender a natureza do problema. A topologia é uma abstração de outra 
ordem, em que não contam distâncias e propriedades formais entre as 
partes de um polígono, e sim a continuidade das partes em questão. Sobre 
o mapa foi superposto um grafo que representa o circuito de caminhos. 

Figura 26 – O grafo superposto 

Fonte: Digital commons.

A moderna Teoria de Grafos concluiu que a senda procurada 
somente pode ser construída se estão dadas duas condições: se o grafo 
é conectado e se há como máximo dois vértices ímpares. Essa última 
condição evita a repetição indesejada. Hoje é conhecida como a solução 
Euleriana, que possui fundamentos axiomáticos. Como podemos ver, no 
mapa de Euler todos os vértices são ímpares, ,um possui cinco arcos 
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adjacentes e os restantes três, o que é contrário à condição formal. Em 
conclusão, o problema original não tinha solução.  

Antes de apresentar a definição formal de um grafo e as suas 
vantagens técnicas, é necessário tomar distância de algumas noções 
prévias do senso comum. Falamos da linguagem dos grafos, e não dos 
gráficos. A distinção não é ociosa, pois queremos demonstrar que um 
gráfico qualquer que expresse aparentemente relações entre objetos ou 
pessoas não é um grafo em sentido formal.

Figura 27 – Representação intuitiva de atores envolvidos num projeto 
agroindustrial
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Bio-tecnologia

Terra

Trabalho

Fonte: Elaboração própria

Observemos a Figura 27, tomada de uma tese de doutorado que 
visava representar as interações interorganizacionais que deram origem a 
um projeto agroindustrial. Nela estão representados três tipos de agentes, 
por tons diferentes. Os círculos pretos representam organizações do nível 
nacional e internacional, os círculos cinzas representam organizações do 



68

Análise de redes em Ciências Sociais

nível regional e, em brancos, estão as organizações de nível local que 
eram objeto de incubação por parte dos níveis superiores. As linhas de 
traços diferentes representam os recursos que eram intercambiados 
nesse sistema social. Esta é uma descrição geral tal e como o observador 
reconstrói os nexos e trocas. Porém, esse não é um dado técnico, pois não 
há na raiz da coleta um procedimento técnico que permita captar com 
precisão e clareza as trocas do sistema. Para tanto, precisamos desenhar 
instrumentos de pesquisa adequados, como os que foram apresentados 
no capítulo anterior.

A Figura 28 é um grafo propriamente dito. Em sua origem, houve 
um procedimento de coleta sociométrico que permitiu registrar de que 
forma trocavam informação os membros da organização que estava 
sendo incubada pelos agentes organizacionais representados na anterior 
Figura 27. Esse grafo foi gerado com o visualizador NetDraw acoplado ao 
software Ucinet 6.1.

Figura 28 –  Grafo sobre fluxo de informações num projeto agroindustrial
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A geração de um grafo pressupõe um procedimento matemático 
formal que consiste numa matriz de adjacência na qual se registram as 
relações entre os agentes do sistema. Em breve explicaremos em que 
consiste a matriz sociométrica. 

2. Notação

A notação algébrica é uma ferramenta poderosa das matemáticas 
que permite tratar a quantidade do modo mais geral possível. Isto é, a 
introdução da formalização numérica, mediante o uso de letras, implicou 
um ganho de abstração para captar as propriedades formais de certas 
operações da aritmética básica e do cálculo avançado. Por exemplo, a 
simplificação da adição mediante a redução a fatores de multiplicação, 
conhecida como fatoração, não teria sido possível sem a invenção da 
álgebra. Com este breve preambulo, só queremos atrair a atenção do 
leitor para o fato de que a teoria de grafos e a sua subsequente análise não 
é possível sem uma adequada notação formal. Aqui adotamos a notação 
de Wasserman e Faust (1994), pois se trata da publicação mais completa 
que aplica a Teoria de Grafos ao mundo das Ciências Sociais. 

2.1 Espaço relacional

Um grafo designa um espaço relacional que corresponde a um 
conjunto N com um número g de atores. 

N = { n1, n2......ng } 
Em Teoria de Gráficos fala-se de uma coleção de nós, por isso a 

notação N. 
Podemos considerar como exemplo um conjunto g composto por 

crianças da quinta série do ensino fundamental: João, Maria, Pedro, 
Chico, Joana, Luisa.

N = {João, Maria, Pedro, Chico, Joana, Luisa} 
g=6
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2.2 A relação simples

Além dos atores, o espaço relacional também é conformado por 
um conjunto de relações de vários tipos:

•	 dicotômicas (acontece - não acontece)
•	 orientadas (à) ou  não orientadas (        )
•	 fortes ou fracas
Assim, cada ni pode estar em relação com nj, isto é <ni, nj> .
Se há uma relação entre ni e nj, afirma-se que pertence a uma 

coleção de pares que se denomina L. Esta constitui o conjunto de linhas 
ou espaço de adjacência. 

Se a relação é direcionada, dado que a ordem importa, a relação é 
registrada como ni à nj.

Os pares ordenados denotam-se como l entradas em L = {l1,l2...lL}. 
O número total de pares ordenados em L corresponde a g(g-1) 

como máximo.
Em resumo: um grafo G está composto de um conjunto de nós N e 

de um conjunto L de relações, isto é, G(N,L).
Para o G(N,L)
N = {João, Maria, Pedro, Chico, Joana, Luisa}
L = {l1, l2, l3, l4... l30 } 6(5)=30
L = <João, Maria>, <João,Pedro>, <João,Chico>, <João,Joana>, 

<João, Luisa>... l30 
A Figura 28 corresponde ao dígrafo completo de todas as relações 

das seis crianças da quinta série do ensino fundamental:

Figura 29 – Dígrafo completo de tamanho g = 6
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Maria

Fonte: Elaboração própria
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2.3 Dígrafo ou grafo direcionado

Nos grafos, os pontos (ou outras figuras) representam os agentes 
ou eventos, e os arcos, ou linhas, as relações. Quando os arcos terminam 
em flechas, damos a entender que a relação é direcionada. Podemos 
supor que o grafo G anterior representa a propriedade diádica, ou entre 
dois agentes, “gostar de”. Sendo assim, cada seta direcionada no grafo 
significa que uma das crianças declara gostar da outra. 

2.4 Grafo não direcionado

Podemos ter situações em que não há relações orientadas, portanto, 
não podemos estabelecer uma direção no par ordenado <ni, nj>. A relação 
só pode ser representada como ni        nj.

Imaginemos a propriedade diádica “morar perto de”. Nesse caso, 
o número total de pares ordenados em L corresponde a g (g-1)/2 como 
máximo L = 15.

A Figura 30 corresponde ao grafo completo de todas as relações 
não orientadas das crianças que moram perto uma das outras na quinta 
série do ensino fundamental:

Figura 30 – Grafo completo de tamanho g = 6 

 

Luisa
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Fonte: Elaboração própria

2.5 Matriz de adjacência

Já vimos que todo grafo é construído a partir do espaço de relações 
ou de adjacência L. Isto é, a partir de um conjunto de pares ordenados. 
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	 L = <João, Maria>, <João,Pedro>, <João,Chico>, <João,Joana>, 
<João, Luisa>... l30 

A organização básica para desenvolver operações aritméticas com 
pares ordenados denomina-se matriz de adjacência. 

Para o espaço relacional G(N,L) 
N = {João, Maria, Pedro, Chico, Joana, Luisa}
L = {l1, l2, l3, l4... l30} 6 (5) =30 
As informações básicas de nós e relações podem ser registradas 

numa matriz quadrada denominada matriz de adjacência, devido a que 
cada relação coloca em contato diferentes nós entre si, isto é, os faz 
adjacentes. Nas linhas e colunas aparecem os nomes dos agentes do 
sistema social, e nos vértices estão marcadas as relações. De ordinário, 
nos estudos sobre sistemas sociais, as relações são entendidas como 
variáveis aleatórias cujo resultado é binário, 1 ou 0.   

Tabela  4 – Matriz sociométrica 

João Maria Pedro Chico Joana Luisa

João ___ 1 1 1 1 1

Maria 1 ___ 1 1 1 1

Pedro 1 1 ___ 1 1 1

Chico 1 1 1 ___ 1 1

Joana 1 1 1 1 ___ 1

Luisa 1 1 1 1 1 ___

Fonte: Elaboração própria
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No caso de termos uma matriz de relações orientadas, toda vez que 
encontramos um vértice cujo valor é 1, isso significa que há uma relação 
vinculante entre os dois nós respectivos. Quando o valor é 0, isso significa 
que não há relação vinculante. Na Tabela 4 podemos interpretar que todas 
as relações possuem orientação nos dois sentidos. Porém, em alguns 
casos não cabe interpretar a orientação da relação, pois a interação não 
pressupõe um fluxo direcionado. Por exemplo, uma relação de casamento 
não é uma interação que possa ser representada como direcionada.  Ou 
estamos cassados ou não estamos. Mas o leitor pode estar perguntando: 
por que a diagonal está vazia? De ordinário, nas matrizes sociométricas 
não faz muito sentido afirmar que um agente possui relações consigo 
mesmo. Porém, obviamente há exceções.  Observemos a seguinte matriz 
orientada (Tabela 5):

Tabela 5 – Matriz sociométrica orientada

João Maria Pedro Chico Joana Luisa

João ___ 0 0 1 1 1

Maria 1 ___ 1 1 1 1

Pedro 1 1 ___ 1 1 1

Chico 1 0 1 ___ 0 1

Joana 1 1 1 1 ___ 1

Luisa 1 0 1 0 1 ___

Fonte: Elaboração própria
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Por convenção, a matriz sociométrica é lida sempre partindo das 
linhas ao encontro das colunas. Observemos o vértice que representa o par 
ordenado <Maria, João>, nele aparece o valor 1. Isso significa que Maria 
declarou gostar de João. Mas no vértice que representa o par ordenado 
<João, Maria> aparece um valor de 0. Isto significa que não há reciprocidade 
por parte de João, ele não declara gostar de Maria. Toda matriz é 
representável pelo seu correspondente grafo. A Figura 31 corresponde ao 
grafo que expressa visualmente as relações da matriz anterior.

Figura  31 – Dígrafo que corresponde à matriz da Tabela 5
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Fonte: Elaboração própria

O caso da matriz não orientada segue a mesma lógica de notação 
binária, mas incorpora a propriedade da simetria. Esse assunto será 
explicado no ponto 5 deste capítulo.  

3. Relações diretas e indiretas e seus grafos respectivos

Na vida cotidiana, costumamos identificar as nossas relações sociais 
com as nossas interações aqui e agora. A conversa durante o almoço com 
os colegas de trabalho, o encontro casual na parada do ônibus com um 
desconhecido ao qual perguntamos o horário da rota de ônibus, a mesa 
redonda na qual perguntamos e respondemos. Porém, o nosso mundo 
de relações é composto também de relações não imediatas, distendidas 
no espaço e no tempo. Aquele colega da universidade que não vemos 
faz muitos anos, o ex-namorado da nossa juventude, aquele colega em 
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nosso primeiro emprego que foi nosso suporte nos momentos difíceis do 
trabalho. Mas há um tipo de relações potenciais, não menos importantes. 
Aqueles amigos dos nossos amigos que ainda não conhecemos, mas 
aos quais temos uma alta probabilidade de sermos apresentados. Esse 
fato exige pensar que há pelo menos dois tipos de relações sociais: as 
diretas, em que incluímos as interações do aqui e agora e as passadas, 
cujo universo se confunde com a nossa memória; e as indiretas, aquelas 
relações mediadas pelas pessoas que conhecemos em nossos diversos 
círculos sociais e que potencialmente podem ser ativadas a qualquer 
momento. Sobre esse segundo universo não temos consciência nem 
muito menos memória.

Levando em conta essa distinção, podemos reconhecer uma nova 
vantagem da visualização feita mediante grafos. Há dois tipos básicos 
de grafos, segundo o grau de completude das informações. Se um grafo 
fornece informações só para um agente, falamos de uma rede pessoal 
(personal network ou ego network). Essa é passível de ser reconstruída 
por métodos de amostragem convencional probabilística. Observemos 
a Figura 32 , que representa uma rede egocentrada. Nela podemos 
identificar os alters de ego, isto é, as suas relações não orientadas 
imediatas ou diretas. 

Figura 32 – Rede egocentrada sem relações entre alters

Fonte: Elaboração própria

Dentro de um grafo maior, podemos identificar diversas redes 
egocentradas. Por exemplo, observemos a rede pessoal de João obtida 
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a partir do grafo, representado na Figura 33, das seis crianças da quinta 
série do ensino fundamental:

Figura 33 – Grafo egocentrado extraído de um grafo completo
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Fonte: Elaboração própria

	 Quando temos informações sobre as relações entre os nós 
adjacentes de ego, temos uma ego-network completa. Observemos como, 
na Figura 34, aparecem as relações entre A        B, B        C, C        A.

Figura 34 – Rede egocentrada com relações entre alters

Fonte: Elaboração própria

Porém, devemos evitar a confusão entre uma ego-network 
completa e uma rede completa, ou total-network, propriamente dita. Há 
uma sutil diferença que altera o sentido da informação. Observemos a 
Figura 35: nela aparecem os alters dos alters, os nós D e E, para os quais 
temos novas relações B        D e C        E . 
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Figura 35 – Rede completa

Fonte: Elaboração própria

Agora estamos em condições de entender o que é o grafo de uma 
rede completa ou total-network. Nesta estão representadas as relações 
diretas e indiretas para cada um dos nós que compõem o espaço relacional. 
Lembremos o que foi dito antes: no mundo social, tão importantes como 
as relações imediatas que reconhecemos, ou sobre as quais temos 
memória, são as relações indiretas ou mediatas, isto é, as que acontecem 
porque há intermediários que tornam possível certo tipo de encontros ou 
alianças. Isso é o típico do mundo social, a interdependência das escolhas, 
as colaborações, os conflitos, e toda sorte de formas de socialização nos 
termos de Georg Simmel.  

4. Matrizes: operações básicas

As inúmeras contas que sustentam a análise de grafos com 
ferramentas computacionais são possíveis porque a informação aritmética 
e algébrica está formatada como uma matriz de informações. Ainda que 
este não seja um livro para o ensino das matemáticas, devemos lembrar 
o leitor que uma matriz está sujeita às operações básicas da aritmética. 

Para começar, podemos definir intuitivamente uma matriz como 
uma tabela que organiza cifras em linhas e colunas. Uma matriz de g 
número de linhas e h número de colunas possui o tamanho g x h. Se o 
número de linhas e colunas for igual, temos uma matriz quadrada. Se for 



78

Análise de redes em Ciências Sociais

diferente temos uma matriz retangular. Por notação, a matriz é designada 
com letra maiúscula, e os vértices, ou termos, isto é, o ponto onde se 
encontram as linhas e colunas, com letras minúsculas. 

Figura 36 – Matriz quadrada e retangular

Fonte: Elaboração própria

4.1 Adicionar e subtrair matrizes

Disse-se que uma matriz M possui um conjunto de termos gerais 
ou vértices mij 

Isso significa que na interseção da linha i e da coluna j encontramos 
o número m

Para adicionar duas matrizes é suficiente fazer a soma termo a 
termo para cada um de seus elementos. O princípio é idêntico para 
subtração. Essas operações só são possíveis se as matrizes possuem o 
mesmo número de linhas e de colunas.

Descrevamos a soma de duas matrizes – A, cujo termo geral é aij, e 
B, cujo termo geral é bij, contendo cada uma g linhas e h colunas – como 
uma matriz C que contém igual número de g linhas e h colunas e cujo 
termo geral é cij, calculado assim:

cij = aij + bij
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Figura 37 – Soma de matrizes

Fonte: Elaboração própria

4.2 Vetores e escalares

Chama-se vetor-linha uma matriz que possui h colunas e uma única 
linha.

Chama-se vetor-coluna uma matriz que possui g linhas e uma única 
coluna. Quando não se faz precisão, assumimos que um vetor sempre 
indica um vetor-coluna.

Figura 38 – Vetor linha e vetor coluna

Fonte: Elaboração própria

Reserva-se a expressão termo para indicar os elementos de uma 
matriz, e componente, os elementos de um vetor; vi designa a iésima linha 
de um vetor coluna e vj designa a jésima coluna de um vetor linha.

Um escalar é uma matriz que possui uma única linha e uma única 
coluna. Por exemplo, o número inteiro 5 é um escalar. 

4.3 Produto escalar

Quando temos a operação de um vetor-linha vezes um vetor-
coluna, o resultado é um escalar, dado que possui o número de linhas do 
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primeiro vetor e o número de colunas do segundo vetor. Observemos o 
exemplo para obtermos o escalar 29:

4.4 Produto matriz

Quando temos a operação de um vetor-coluna vezes um vetor-linha, 
o resultado é uma matriz com o número de linhas do primeiro vetor e o 
número de colunas do segundo vetor. Observemos o seguinte exemplo: 

4.5 Produto de duas matrizes

O produto de duas matrizes A e B, tomado nessa ordem, implica 
necessariamente que o número de colunas da primeira seja igual ao 
número de linhas da segunda. O resultado será uma matriz C, que possui 
o mesmo número de linhas da primeira matriz e o mesmo número de 
colunas da segunda. 

4.6 Divisão de duas matrizes

A divisão de duas matrizes não é um processo direto termo 
a termo. Para saber da divisibilidade de uma matriz, é necessário 
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submetê-la ao teste da inversão. Em primeiro lugar, devemos lembrar 
que dividir é o mesmo que multiplicar pelo inverso. Por exemplo, dividir 
10 inteiros por 5 inteiros é o mesmo que multiplicar 10 pelo inverso do 
divisor, neste caso 1/5. Assim: 10 * 1/5 = 2. Em segundo lugar, sabemos 
que ao multiplicar um número pelo seu inverso, obtemos a unidade. Por 
exemplo: 5*(1/5) = 1.   

Levando em conta o anterior, se queremos dividir uma matriz, 
primeiro precisamos saber se seu divisor possui inversa, o que nem 
sempre se cumpre. Por exemplo, se é proposta a seguinte divisão de duas 
matrizes A/B= X, já sabemos pelo dito acima que o quociente corresponde 
à seguinte multiplicação X = A*B-1 , na qual o multiplicador é o inverso do 
divisor. Além disso, e também como consequência da segunda condição 
lembrada acima, a existência da inversa passa pelo cumprimento da 
seguinte igualdade A*X = In, onde In é a matriz identidade cuja propriedade 
é ter valores 1 nas diagonais, e a incógnita X é a inversa do multiplicando. 
Como vemos, a divisão de matrizes assume condições mais complexas 
que as três primeiras operações básicas.

5. Outras operações com matrizes

Para além das operações aritméticas descritas anteriormente, as 
matrizes permitem outro tipo de operação de ampla utilidade na análise 
de redes sociais. Vamos expor as mais importantes. 

5.1 Matriz simétrica

Uma propriedade importante de uma matriz quadrada é a simetria, 
definida como a propriedade do termo xij = xji. 

Isso acontece quando os vértices recíprocos possuem o mesmo 
termo.

Uma matriz sociométrica, representando uma relação não 
direcionada, é simétrica, dado que o par <ni, nj> = <nj, ni>, portanto o 
termo xij = xji. 
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Observemos a seguinte matriz, na qual todos os valores acima e 
abaixo da diagonal são iguais. Por exemplo, Maria escolhe o João como 
seu parceiro de jogos na hora do recreio, ao tempo que João também 
declara escolher a Maria como a sua parceira. 

Tabela 6  – Matriz simétrica

João Maria Pedro Chico Joana Luisa 

João ___ 1 1 1 1 1

Maria 1 ___ 1 1 1 1

Pedro 1 1 ___ 1 1 1

Chico 1 1 1 ___ 1 1

Joana 1 1 1 1 ___ 1

Luisa 1 1 1 1 1 ___

Fonte: Elaboração própria

5.2 Permutação 

Já sabemos que numa matriz sociométrica o dado fundamental é 
a adjacência, ou seja as relações entre agentes marcadas nos vértices, 
ou no encontro das linhas e colunas. A ordem das linhas e das colunas 
pouco importa. De ordinário, esta não obedece a um critério substantivo 
ou inerente às próprias relações. Sendo assim, podemos alterar a ordem 
das linhas e colunas desde que seja cumprida a condição de não alterar a 
informação dos vértices ou termos, para dessa forma garantir a adjacência 
original.
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Esta mudança de linhas e colunas é chamada de permutação. Mas 
qual a vantagem de fazê-la? Em essência é uma forma de tornar certas 
informações mais compreensíveis para o observador. Vejamos o seguinte 
exemplo:

Temos uma matriz de adjacência, e seu grafo respectivo, que reúne 
a informação relacional “pedir conselho a” entre gerentes de vários 
setores de uma grande empresa.

Tabela 7 – Matriz não permutada

n1 n2 n3 n4 n5 

n1 - 0 1 0 1 

n2 0 - 0 1 0 

n3 1 0 - 0 1 

n4 0 1 0 - 0

n5 1 0 1 0 - 

                    
Fonte: Elaboração própria

A matriz original pode ser rearranjada de tal forma que os termos 
recíprocos fiquem próximos. Na Tabela, os termos da matriz ficam 
dispostos conforme a proximidade dos pares ordenados. Observe-se que 
há duas regiões com valores 1 no canto superior esquerdo da matriz e 
no inferior direito. Cada uma corresponde a um subgrupo ou cluster de 
relações, tal e como o grafo respectivo indica. A matriz envolve informação 
sobre uma relação diádica <n2,n4> e uma relação triádica <n1,n3,n5>. 

X=
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Tabela 8 – Matriz permutada

n5 n1 n3 n2 n4 

n5 - 1 1 0 0 

n1 1 - 1 0 0 

n3 1 1 - 0 0 

n2 0 0 0 - 1 

n4 0 0 0 1 - 

Fonte: Elaboração própria

Para um espaço relacional composto por g objetos, as possibilidades 
de permutação se calculam pelo fatorial, assim:

g! = g x(g-1) x (g-2) x (g-3) ... x 1
Para o caso anterior N= {1,2,3,4,5} 
O número de permutações possíveis é 5!
5x4x3x2x1= 120 permutações possíveis
Em síntese, a permutação é útil na análise da coesão de subgrupos 

dentro de um grafo.

5.3 Transposição

Uma matriz sociométrica pode ser submetida a uma torção, de tal 
forma que as linhas se tornem colunas e as colunas, linhas. Essa operação 
é conhecida como transposição. Para uma matriz X denotamos a sua 
transposta como X’ com termos {x’ij}. 

No caso de um grafo orientado, a transposição de uma matriz 
sociométrica representa a conversão do grafo. Isto é, inverte o sentido das 
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relações. Vejamos o seguinte exemplo da Tabela 9, e seu grafo respectivo, 
contendo a informação relacional “conhece a no começo do ano letivo”. 

Tabela 9 – Matriz não transposta

n1 n2 n3 n4 n5 n6 

n1 - 1 0 0 1 0 

n2 0 - 1 0 0 1 

n3 0 1 - 0 0 0 

n4 0 0 0 -  0 0

n5 0 0 0 0 - 1 

n6 0 1 0 0 0 - 

Fonte: Elaboração própria

Figura 39 – Digrafo da matriz não transposta

n3

n4

n2

n1

n5

n6

Fonte: Elaboração própria

A transposta da matriz será X’, onde x’ij = xji.
Isso significa que, na matriz transposta, a direção dos arcos vai em 

sentido inverso. Para a notação anterior, o termo xji indica que o nodo j 



86

Análise de redes em Ciências Sociais

envia um arco para i, enquanto que na transposta o termo x’ij indica que j 
recebe um arco de i.

Tabela 10 – Matriz transpost

n1 n2 n3 n4 n5 n6 

n1 - 0 0 0 0 0 

n2 1 - 1 0 0 1 

n3 0 1 - 0 0 0 

n4 0 0 0 -  0 0 

n5 1 0 0 0 - 0 

n6 0 1 0 0 1 - 

Fonte: Elaboração própria

Figura – 40 Dígrafo da matriz transposta
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Fonte: Elaboração própria
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6. Grafos multiplexo, one-mode e two-mode

Até agora, tudo o que foi apresentado parte de dois pressupostos 
básicos: por um lado, que há relações entre agentes da mesma natureza 
ou categoria, e por outro, que foi identificada uma única relação dentro 
do mesmo universo.

A multiplexidade designa a condição plural das relações sociais 
dentro de um determinado círculo social. Aliás, a condição mais 
interessante do mundo social é a multiplexidade, em virtude de que 
as trocas e as interações nunca estão restritas ao mesmo círculo social. 
Para um mesmo universo social, o observador pode reconstruir diversos 
processos de interação que acontecem entre os mesmos agentes 
observados. Os grafos seguintes representam três relações distintas 
coletadas dentro da mesma organização de produtores agrícolas. Cada 
uma corresponde a um processo relevante, porém distinto, dentro da 
mesma empressa associativa.   

Figura  41 – Trocas de informação

Fonte: Higgins (2011).
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Figura 42– Trocas colaborativas 

Fonte: Higgins (2011).

Figura 43 – Relações de controle social lateral 

Fonte: Higgins (2011).

Os três grafos anteriores representam relações diferentes entre os 
mesmos agentes. Nesse sentido, o leitor avisado já pode ter intuído uma 
pergunta pertinente: não será que há relações entre as relações? Ou, dito 
de outra forma, será que um tipo de relação condiciona os outros? De 
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que forma? Esse tipo de desafio exige modelos matemático-formais que 
ajudem a estimar as probabilidades de que isso seja assim em realidade e 
não uma simples imaginação do observador. 

Para além da multiplexidade, temos outras formas de categorizar 
um grafo, levando em conta tanto a natureza do conjunto de atores como 
as propriedades intrínsecas dos laços entre eles. O mode de uma rede é 
o número de conjuntos ou “entidades” nas quais as variáveis estruturais 
de um grafo podem ser mensuradas. As redes comumente estudadas são 
one-mode, isto é, nelas há um único conjunto de entidades. Mas também 
podemos estudar redes two-mode que incluem dois tipos de entidades. 
Vamos explicar a diferença com um exemplo elementar. Na Figura 44, o 
grafo representa as relações de doação entre empresas do setor privado e 
organizações da sociedade civil (O grafo da figura 43 é um exemplo fictício, 
elaborado pelos autores para fins didáticos).  

Nesse caso, dois tipos diferentes de agentes estão vinculados pela 
transferência dadivosa de um recurso. Como cientistas sociais, sabemos 
que isso não está isento de consequências, basta pensar no famoso Ensaio 
sobre a dádiva, de Marcel Mauss. Dar e receber presentes está na base do 
senso da obrigação moral, ou retribuição, nos sistemas sociais. 

Figura 44 – Grafo two mode

Fonte: Elaboração própria
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Observemos agora o caso da Figura 45. Desta vez, o grafo designa 
um tipo de relação que é a filiação social, de forma específica, o vínculo 
com um partido político. Aqui devemos lembrar que as primeiras pesquisas 
sociométricas foram feitas no campo dos sistemas de parentesco, como 
uma forma de filiação estruturante da vida social. Estar vinculado a um 
partido político ou ser parente de alguém são dois tipos diferentes de 
filiação social. O primeiro é, se vivermos numa sociedade democrática, 
uma escolha do agente; no segundo caso, as regras do parentesco impõem 
a pertença a uma linha familiar ou a uma casta, sendo algo imposto pela 
coletividade ao agente.   

Figura 45 – Grafo two mode

Fonte: Elaboração própria

De forma sucinta, podemos listar as características básicas das 
redes one mode e two mode.

6.1 One-mode network

Tipos de atores
•	 Pessoas
•	 Subgrupos
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•	 Organizações
•	 Coletivos/Agregados: comunidades, Estados-nação, municípios 

etc. 
Tipos de relações 
•	 Avaliações individuais: amizade, respeito, autoridade etc.
•	 Transações ou transferência de recursos materiais: comprar, 

vender, tomar emprestado de, emprestar a etc. 
•	 Transferência de recursos não materiais: enviar ou receber 

informação
•	 Interações: ajudar a, controlar a etc.
•	 Movimento: físico (migrar para), social (mudar de status)
•	 Parentesco: estar casado com, descender de etc. 

6.2 Two-mode network

Tipos de atores
•	 Pessoas
•	 Organizações
•	 Coletivos/Agregados: comunidades, Estados-nação, municípios 

etc. 
Tipos de relações 
•	 Formas de filiação voluntária a diversos tipos de organizações 
•	 Transações ou transferência de recursos materiais: comprar, 

vender, tomar emprestado de, emprestar a etc. 
•	 Transferência de recursos não materiais: enviar ou receber 

informação
•	 Interações: ajudar a, controlar a etc.
•	 Movimento: físico (migrar para), social (mudar de status)

7. Exercícios 

1) Com base nas informações da Figura 24 sobre os 20 clubes de 
futebol que disputaram a 1ª divisão do Campeonato Brasileiro em 2017, 
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pede-se que você identifique os seguintes conjuntos e elabore para cada 
um as notações correspondentes:

a.	 Conjunto dos oito primeiros colocados.
b.	 Conjunto dos quatro times rebaixados para a segunda divisão 

(a cada ano são rebaixados os 4 últimos colocados).
c.	 Conjunto de clubes com menos de 10 empates.
d.	 Conjunto de clubes que sofreram menos de 40 gols.
2) Qual das opções a seguir representa o tipo de rede que obteremos 

a partir das informações sobre transferências de jogadores?

3) Tendo em vista que a 1ª divisão do campeonato brasileiro envolve 
a participação de 20 clubes de futebol, qual é o número máximo de laços 
possíveis em um dígrafo que represente os clubes e as transferências de 
jogadores entre eles?

4) O Quadro 1 mostra as transferências de jogadores apenas entre 
os 8 primeiros colocados da 1ª divisão do campeonato brasileiro em 2017. 

a.	 Pede-se que você construa a matriz sociométrica e o dígrafo 
referentes aos dados apresentados no Quadro 1. 

b.	 Indique as relações diretas e indiretas entre o clube Palmeiras e 
os outros 7 clubes.
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Quadro 1 – Transferências de jogadores entre os 8 primeiros colocados 
do campeonato brasileiro em 2017

Origem Destino das transferências (apenas para os 8 primeiros 
colocados no campeonato em 2017)

1º Corinthians Enviou 2 Jogadores para o Grêmio.

2º Palmeiras Enviou 2 Jogadores para o Grêmio.
Enviou 4 jogadores para a Chapecoense.

3º Santos Não enviou jogadores para nenhum clube.
4º Grêmio Não enviou jogadores para nenhum clube.
5º Cruzeiro Enviou 4 jogadores para a Chapecoense.
6º Flamengo Não enviou jogadores para nenhum clube.
7º Vasco Enviou 2 Jogadores para o Palmeiras.
8º Chapecoense Não enviou jogadores para nenhum clube.

Fonte: Elaboração própria.

5) A matriz a seguir mostra as transferências entre os 20 clubes da 
primeira divisão sem considerar as trocas realizadas com clubes de outras 
divisões ou de outros países. Analise a matriz e responda:

a.	 Trata-se de uma matriz simétrica ou assimétrica?
b.	 Em 2017, qual foi o clube brasileiro que mais estabeleceu 

relações de transferência de jogadores com outros clubes da 1ª 
divisão para enviar jogadores? Desenhe a rede egocentrada e a 
rede ego completa desse clube.

c.	 Em 2017, qual foi o clube brasileiro que mais estabeleceu 
relações de transferência de jogadores com outros clubes da 1ª 
divisão para receber jogadores? Desenhe a rede egocentrada e 
a rede ego completa desse clube.

d.	 Compare as redes que você desenhou nas duas questões 
anteriores. Em qual das redes o N é maior? Em qual das redes 
há mais laços?

e.	 Em 2017, quantos jogadores foram cedidos pelo clube que mais 
vendeu/emprestou jogadores para outros clubes da 1ª divisão?

f.	 Em 2017, quantos jogadores foram cedidos pelo clube que mais 
comprou/tomou emprestado jogadores de outros clubes da 1ª 
divisão?
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Cruzeiro 0 0 0 0 2 0 2 0 0 0 4 0 0 0 2 4 0 0 0 2
Flamengo 0 0 0 0 0 0 0 0 0 0 2 0 0 2 0 0 2 0 0 0

Vasco 0 0 0 2 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Palmeiras 0 0 0 0 0 0 0 2 2 2 2 0 0 2 0 4 0 0 0 0
São Paulo 0 0 0 2 0 0 0 2 0 2 0 0 0 0 0 0 0 0 0 0

Sport 0 0 0 0 2 0 0 0 0 0 0 0 0 0 0 2 0 0 0 0
Atlético-PR 0 0 0 0 0 0 0 0 0 0 2 2 0 0 0 0 0 0 0 0

Grêmio 0 0 0 0 0 0 0 0 0 0 4 2 0 2 0 0 2 0 0 0
Fluminense 0 0 0 0 0 0 0 0 0 0 2 0 0 0 0 2 0 0 0 0

Bahia 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Vitória 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Atlético-GO 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 2 0 0
Atlético-MG 0 0 0 0 2 0 0 0 0 0 2 0 0 0 0 0 0 0 0 0

Coritiba 0 0 0 0 0 0 0 0 0 2 0 0 0 0 0 0 0 0 2 0
Botafogo 0 0 0 0 0 0 2 0 0 0 0 0 0 0 0 0 0 0 0 0

Chapecoense 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Ponte Preta 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Santos 0 0 0 0 0 0 0 0 2 0 0 0 0 0 0 0 0 0 0 0
Corinthians 0 0 0 0 0 0 2 2 0 4 0 2 0 0 0 0 0 0 0 2

Avaí 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Fonte: Elaboração própria.

6) Aponte outros recursos que os 20 clubes da primeira divisão 
podem trocar entre eles e com outras organizações. 

7) Aponte ao menos um exemplo de rede two-mode que envolva os 
clubes de futebol. 
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Capítulo 5 – Descrição de uma  
estrutura reticular 

1. Descrição das estruturas relacionais

Entramos agora na análise estrutural propriamente dita. Para 
orientar o leitor nas diversas dimensões descritivas da análise de redes 
sociais, remetemos-lhe novamente para a Tabela 1 –, que serve como 
plano do voo para os seguintes capítulos. Nas linhas, temos três critérios 
básicos que descrevem a estrutura de superfície de um grafo observado. 
A coesão define o nível de entrosamento de um grafo a partir de uma 
perspectiva global. A centralidade discrimina a importância dos nós 
do grafo levando em conta o número de relações observadas. Isto é, 
constitui um ranking de status, seja do ponto de vista da popularidade, 
relações de entrada, seja da iniciativa, ou relações de saída. Para cada 
critério, há um conjunto básico de conceitos que especificam nuances 
de cada dimensão; estes aparecem nos vértices adjacentes de cada 
linha da tabela. Temos um terceiro critério de análise denominado 
posição estrutural. Dito em forma preliminar e sucinta, consiste em 
entender qual é a posição relativa de um nó levando em conta uma 
estrutura latente. Esta última não é identificável ao olho nu quando 
analisamos um grafo. A introdução desse tipo de análise, por parte de 
Harrison White et al. (1976) e seus alunos nos anos setenta, equiparou-
se à introdução de um telescópio Hubble na Sociologia contemporânea, 
pois, pela primeira vez, os sociólogos estavam dotados da capacidade 
de analisar de forma técnica uma função social que surge do processo 
das relações e não da cabeça do observador. Em outras palavras, não é o 
sociólogo quem determina a função estrutural do agente na vida social. 
Sobre esse ponto, trabalharemos em detalhe mais adiante.  
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2. Elementos de conectividade em grafos não orientados

Um grafo admite inúmeras análises. Mas, se começamos pelas mais 
elementares, devemos distinguir o foco nas relações do foco posto nos 
nós. Assim, teremos propriedades de conexão intrínsecas às relações e 
outras intrínsecas aos nós. Isso não significa que separemos nós e relações, 
simplesmente que a análise admite duas ênfases diferentes.  

2.1 A díada

A forma mais simples de conexão num grafo é a adjacência. No caso 
de um par não ordenado, a opção é simples, há ou não há relação. Assim, 
a junção de dois nós constitui uma díada.

Figura 46 – Formas estruturais da díada

Fonte: Elaboração própria

Levando em conta a notação, já sabemos que o espaço relacional G 
está constituído por um conjunto N de nós, e outro, L, de relações.

N= {n1, n2 }  L= {l1}                                N= {n1, n2 } L= {0}

2.2 A tríada

A adjacência completa entre três nós constitui a segunda forma 
de conectividade num grafo. Já vimos como Georg Simmel falava que a 
sociedade começa na relação a três. Observemos os grafos seguintes:

Figura 47 – Formas estruturais da tríada

Fonte: Elaboração própria
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No caso de grafos não orientados, temos quatro possibilidades 
diferentes de adjacência. A tríada vazia, a díade, uma estrela de duas 
pontas; e a tríade fechada. Se o grafo for direcionado, o número de 
posições estruturais, ou isomorfismos, cresce até dezesseis. A estrela 
de duas pontas foi destacada porque corresponde ao axioma de Mark 
Granovetter no sentido de que, quando as pessoas estão vinculadas por 
laços fortes, mistura de apoio afetivo, reciprocidade e alta frequência nas 
relações, então as relações triádicas são necessariamente fechadas. 

2.3 O cutpoint ou broker 

Se olharmos um grafo focando na posição relativa dos nós, veremos 
uma série de propriedades que falam do poder de conectividade de 
certos atores dentro de uma rede. No grafo seguinte, Figura 48, é notório 
que há um nodo com alto poder de conectividade; se o n1 for suprimido, 
o grafo fica dividido em dois componentes desconexos. Esse poder 
de conectividade é conhecido como brokerage ou capacidade de ligar-
desligar os fluxos que circulam por uma rede ou de dividir uma estrutura 
fragilmente conexa. Essa propriedade fundamenta uma das principais 
perspectivas sobre o capital social do ponto de vista das vantagens que os 
agentes obtêm de seu contexto relacional. 

Figura 48 – Proprieade de cutpoint ou broker

Fonte:  Wasserman; Faust, 1994

Após a subtração do cutpoint ou broker, o grafo fica separado em 
dois componentes desconexos.

Ns = N - n1
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Figura 49 – Grafo separado em dois componentes

Fonte:  Wasserman; Faust, 1994

2.4 Laço ponte 

Se olharmos novamente com foco nas relações, veremos que há 
laços ou arcos dentro de um grafo com a propriedade de fazer de ponte 
entre componentes com baixa conectividade. Análogo à propriedade 
anterior do broker, temos agora a propriedade de um arco que constitui 
uma ponte. Se observamos a Figura 50, veremos que a supressão da linha  
(n2        n3 ) separa o grafo em dois componentes: 

Figura 50 – Arco ponte

Fonte:  Wasserman; Faust, 1994

Figura 51 – Grafo separado em dois componentes

Fonte:  Wasserman; Faust, 1994
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Chegados a este ponto, devemos introduzir uma sutil distinção 
feita por Granovetter (1973). Quando falamos de uma ponte, podemos 
perguntar qual é o tamanho desta dentro de um grafo. Aqui devemos 
antecipar o conceito de distância. A distância topológica, como vimos 
anteriormente, não faz referência a uma escala espacial convencional, 
seja em quilômetros, metros ou centímetros. Distância significa o número 
de arcos que separam o nó de outro. Isto é, falamos num maior nível de 
abstração. Resulta óbvio que todo arco é uma distância de tamanho d =1, 
pois estamos contando um único laço. A sutileza consiste em entender o 
tamanho de uma ponte a partir do caminho relativo, ou alternativo, mais 
curto. Observemos a Figura 52: qual é a distância alternativa mais curta 
para ir de n2 até n3? Só temos a ponte b, cuja distância é de tamanho 4, 
pois implica percorrer quatro arcos na seguinte sucessão, n2, n8, n10, n6, n3.

Figura 52 – Distância relativa de uma ponte

Fonte: Elaboração própria

2.5 Laços fortes e fracos

A colocação anterior deve ser entendida no contexto completo da 
que é talvez a hipótese mais popular da sociometria contemporânea: a 
força dos laços fracos. Discutindo o problema de como os sociômetras 
tinham tratado a transitividade no mundo das relações humanas, 
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Granovetter (1973) afirma que, até esse momento, começo dos anos 
setenta, o foco estava posto mais no que tínhamos em comum e não nas 
características das relações em si próprias. Por exemplo, é fácil entender 
que se João é amigo íntimo da Joana e do Pedro, em algum momento a 
Joana e o Pedro estarão em contato entre eles. Mas Granovetter (1973) 
estava pensando em algo mais sutil, pois a intensidade das relações é 
um fator-chave para que as relações a três constituam tríades fechadas. 
É dessa forma que introduz o conceito da força de um laço em termos da 
frequência dos encontros, a intensidade afetiva e o apoio mútuo. Com 
esses elementos, postula seu axioma fundamental de que não é possível 
que exista uma tríade aberta, ou estrela de duas pontas (ver a Figura 
47) se as relações são fortes. Isto é, relações fortes tendem a construir 
tríades fechadas. A esse axioma, Granovetter (1973) acrescenta outro: 
relações fechadas degeneram a informação que circula numa rede, pois 
a tornam repetitiva.  

Lembremos que a tese de doutorado de Granovetter (1974), 
orientado por Harrison White, versava sobre a inclusão no mercado 
de trabalho, especificamente no mercado da gerência empresarial 
em contextos urbanos. A sua grande descoberta contraintuitiva foi 
de que os laços fracos são as pontes por onde circula informação útil 
no mundo social. Foi através de velhos conhecidos que os gerentes 
incluídos em sua amostra tinham ficado sabendo das oportunidades 
de trabalho.  Ao final de seu célebre artigo, Granovetter (1973) postula 
uma inferência para o conjunto do problema da coesão social: até onde 
a ação coletiva e a coesão macro-social dependem de uma estrutura de 
interações rica em laços fracos. A pesquisa sociológica nessa matéria 
apenas começa.

2.6 Rotas indiretas em grafos

Os grafos também podem ser comparados a uma rede de caminhos 
com propriedades formais importantes em termos de começo, meio 
e fim. Lembremos que os problemas básicos que deram origem à 
topologia geométrica estavam relacionados com a solução de problemas 
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de circulação. Se observamos a Tabela 11, podemos identificar diversas 
rotas, para as quais a sociometria utiliza termos em inglês que permitem 
a sua diferenciação.

Tabela 11 – Diversos tipos de rotas indiretas num grafo não orientado

Walk
Constitui o tipo genérico. Consiste na 
sequência de nós e de arcos incidentes 
entre si, isto é, não há interrupções, 
nem restrições para repetições.

W 1-2-3-1-2-7
Trial

Sequência de nós e arcos que 
comunica dois nós. Não há repetição 
de arcos.

Wt 1-2-3-1-7-8
Paths

Sequência de nós e linhas que 
comunica dois nós. Não se repete nem 
nó nem linha.

Wp 1-2-3-4-5-6-7-8

Walk fechado
Sequência de nós e arcos incidentes 
entre si, sem interrupção, que começa 
e termina no mesmo nó. Não há 
restrições para repetições. 

Wf 1-2-3-1-2-7-1

Cycle
Walk fechando com um mínimo de 
três nós, em que todos os nós e todos 
os arcos são diferentes, exceto no 
começo no final.

Wc 1-2-3-4-5-6-7-1
Fonte: Elaboração própria
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3. Elementos de conectividade em grafos orientados ou 
dígrafos 

Em grafos orientados, podemos distinguir vários tipos de 
conectividade, levando em conta as rotas de ida e volta entre dois nós:

Figura 53 – Diversos tipos de rotas num grafo orientado

Fonte: Elaboração própria

Path: é um caminho, sem interrupção, de tamanho n, em que todos 
os arcos vão na mesma direção.

Semi-path é um caminho de tamanho n sem importar a orientação 
dos nós. 

Levando em conta a distinção anterior, para dois nós i e j, podemos 
identificar os seguintes tipos de conectividade, conforme a Tabela 12, na 
qual as formas estão em correspondência com a Figura 53.

Tabela 12 – Características de conectividade num grafo orientado

 Debilmente conectado Via um semi-path 

 Unilateralmente Via um path 

 Fortemente conectado 
Via um path de ida outro de volta, 
ainda que sejam diferentes 

 Recursivamente conectado 
Se está fortemente conectado e usa 
os mesmos nodos e arcos 

Fonte: Elaboração própria
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4. Diâmetro e distância

Se há diferentes tipos de caminhos num grafo de rede, estes podem 
ser diferenciados de acordo com a distância topológica. Lembremos que 
na análise de redes o conceito de distância não tem nada a ver com o 
espaço geométrico habitual ou euclidiano. 

	 O tamanho dos caminhos topológicos pode ser mensurado de 
várias formas. 

Figura 54 – Geodésicas e diâmetro de um grafo

Fonte: Elaboração própria

4.1 Geodésica

Consiste na distância mais curta entre dois nodos tomando em 
conta o número de arcos. Porém, pode haver mais de uma geodésica entre 
dois nodos devido à possibilidade de existirem diversos intermediários. 
Às vezes simplesmente se fala de distância entre dois nodos.  Quando 
não há caminho entre dois nodos, falamos de uma distância infinita ou 
indeterminada. 

Na Figura 54 destacamos várias distâncias entre o nó 1 e seus alters. 
A notação formal para as diferentes distâncias é a seguinte:
	 d(1,3)= 2
	 d(1,2)= 3
	 d(1,4)= 3
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4.2 Diâmetro de um grafo 

Em termos topológicos, um grafo é uma figura que possui um 
diâmetro. Este consiste na mais longa geodésica que possamos encontrar 
no grafo. Isto é, o diâmetro é a mais longa entre as mais curtas distâncias 
num grafo. Por exemplo, qual o diâmetro do grafo representado pela 
Figura 54? Entre as distâncias destacadas, o leitor não pode confundir 
a menor distância, nesse caso d(1,2)=2,  com o diâmetro do grafo, que 
corresponde à mais longa entre geodésicas, isto é, 

max d(i,j) = d(1,4) = 3 

4.3 Geodésicas de um grafo orientado

Deve se levar em conta que as distâncias geodésicas num grafo 
não orientado não coincidem com as de um dígrafo ou grafo orientado. 
O sentido da orientação novamente faz toda diferença. Observemos o 
seguinte exemplo da Figura 55.

Figura 55 – Geodésicas de um grafo não orientado

Fonte : Elaboração própria

d(1,8)= 2 é a mesma distância d(8,1)=2
Porém, num gráfico orientado, as geodésicas podem ser diferentes, 

como observamos na Figura seguinte. 
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Figura  56 – Geodésicas de um grafo orientado ou dígrafo

Fonte : Elaboração própria

d(1,8)= 3 é diferente da geodésica d(8,1)=2

4.4 Geodésicas: cálculo com matrizes

A matriz de adjacência permite calcular as geodésicas de um grafo 
orientado. A potência k de uma matriz indica o número total de caminhos 
orientados de tamanho k que começam no nodo ni da linha e terminam 
no nodo nj da coluna.   

Figura 57 – Potência k da matriz de adjacência

Fonte: Godechot, 2017 
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Figura 58 – Potência k=2 da matriz de adjacência

Fonte: Godechot, 2017

Figura 59 – Máxima potência k da matriz de adjacência

Fonte: Godechot, 2017

A máxima potência de uma matriz de distâncias corresponde ao 
diâmetro do grafo. Isto é, à mais longa das geodésicas. No exemplo que 
apresentamos aqui, ao potenciar pelo diâmetro do grafo, max d=3, obtemos 
as menores geodésicas. O leitor deve estar atento, pois as matrizes k=2 e 
k=3 indicam o número de geodésicas do tamanho respectivo, 2 e 3, entre 
os diferentes nós. Os valores dos vértices não indicam relações binárias 
entre os nós, como até agora temos ensinado. 

5. Densidade

Observemos os setores destacados no seguinte dígrafo representado 
pela Figura 60. Qual é a diferença em termos do entrosamento das 
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relações? O leitor pode ver com facilidade que no setor da esquerda há 
menos conectividade que no setor da direita, se levamos em conta o 
número de relações. Dessa forma, e após ter analisado as propriedades 
básicas da conectividade, estamos em condições de definir uma medida 
global sobre a coesão de qualquer grafo.  

Figura 60 – Densidade de um grafo: diversos graus de conectividade

Fonte: Elaboração própria

Do ponto de vista da totalidade de um grafo, a propriedade básica 
que descreve a conectividade se denomina densidade, e a sua notação é Δ. 
Em termos substantivos, devemos lembrar que, em estruturas relacionais 
mais densas, a interconectividade facilita pelo menos:

	 (1) Circulação de recursos, como, por exemplo, a informação. 
	 (2) Controle social.  
Observemos em continuação a forma como Samuel Coleman 

(1988) explica a importância de uma rede entrosada para o exercício do 
controle social.
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Figura 61  – Fechamento de uma rede

Fonte: Coleman (1988).

Coleman operacionaliza o conceito de capital social, em educação, 
a partir da forma como estão entrosadas as famílias de uma escola. Nos 
grafos (a) e (b), representados na Figura 61, A e D representam os pais de B e 
C, que frequentam a mesma escola. Se B perceber algum comportamento 
de risco, como, por exemplo, que seu colega C está levando para a escola 
uma sacolinha com um pó branco e que se reúne com colegas no banheiro 
da escola para cheirar o misterioso elemento, em qual das duas estruturas, 
(a) ou (b), perguntaria Coleman, há mais chances de que as famílias 
entrem em ação para saber o que está acontecendo? Se as famílias não 
se conhecem ou a escola não propicia encontros entre elas, fica mais 
difícil o controle preventivo contra o consumo de drogas. Uma estrutura 
fechada do tipo (b), ou com closure, facilita o controle social. Nesse caso, 
a hipótese da tríada fechada opera no sentido contrário do que vimos 
antes com Grannovetter (1973). Aqui não se trata de obter informação 
nova; trata-se, sim, de ter entrosamento para agir de forma conjunta. Dito 
em forma técnica, a força dos laços que propiciam o fechamento da tríade 
trabalha em favor do controle social preventivo. 
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Intuitivamente a densidade consiste na proporção de relações, ou 
arcos observados, entre o número de relações possíveis. 

O algoritmo que permite mensurar a densidade de um grafo de 
rede varia em função da orientação ou não das relações.

Se o grafo não é orientado, excluindo os loops, ou autorrelações, 
temos a seguinte fórmula de cálculo:

L representa o número de relações observadas, g o número de nós. 
Lembremos que subtraímos 1, dado que não interessam as autorrelações. 
Já sabemos que g(g-1) é o número de relações possíveis. Nesse caso, 
dividimos por 2, dado que estamos calculando a densidade de um grafo 
não orientado, pois o número de relações possíveis se reduz pela metade. 

 Se o grafo for orientado, temos a seguinte conta: 

Vejamos os seguintes exemplos de uma rede do mesmo tamanho g, 
sendo orientada num caso e não orientada no outro. 

Figura 62 – Densidade de uma rede não orientada

Fonte: Elaboração própria
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Figura 63 – Densidade de uma rede orientada

Fonte: Elaboração própria

O valor final significa que foi observado o 42% das relações 
possíveis. Lembremos que estamos falando de uma proporção em 
relação com o total das relações possíveis, que corresponderia ao 100%. 
Nos exemplos anteriores, o fato de termos a mesma densidade é uma 
simples coincidência que não deve confundir o leitor. Bem podia ter sido 
observado em cada caso um número de relações diferentes. 

6. Centralidade: iniciativa e prestígio 

Como anunciamos antes, além de aferir a coesão de uma estrutura 
reticular, podemos discriminar os nós segundo seu nível de atividade 
ou popularidade. Por exemplo, se estamos estudando o sistema de 
status dentro de uma organização, é importante perguntar quais são os 
atores com maior iniciativa na hora de costurar relações estratégicas, ou 
podemos perguntar qual é o ranking de importância levando em conta 
o reconhecimento mútuo. Em ambos os casos, apontamos para o efeito 
estruturante das percepções mútuas e das escolhas num sistema de poder 
ou dominação. Lembremos que, em estrito sentido sociológico, e isto é uma 
herança de Max Weber, a dominação é a obediência ou disposição para 
seguir ou emular o comportamento alheio com fundamento em diversas 
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formas de persuação. A análise de redes revela critérios importantes para 
mensurar e discriminar o poder num sistema social. 

 Wasserman e Faust (1994) propõem a comparação de três situações 
tipo, com a finalidade de construir um critério sobre a importância 
relativa dos nós numa rede. Dessa forma, podemos introduzir os diversos 
algoritmos que caem sobre o critério genérico de centralidade. Nos três 
grafos seguintes, quais são os nós mais portantes do ponto de vista da 
conectividade? 

Figura 64 – Comparativo da centralidade relativa dos nós

(a)

0 1 1 1 1 1 1

1 0 0 0 0 0 0

1 0 0 0 0 0 0

1 0 0 0 0 0 0

1 0 0 0 0 0 0

1 0 0 0 0 0 0

1 0 0 0 0 0 0

(b)

0 1 0 0 0 0 1

1 0 1 0 0 0 0

0 1 0 1 0 0 0

0 0 1 0 1 0 0

0 0 0 1 0 1 0

0 0 0 0 1 0 1

1 0 0 0 0 1 0
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(c)

0 1 1 0 0 0 0

1 0 0 1 0 0 0

1 0 0 0 1 0 0

0 1 0 0 0 1 0

0 0 1 0 0 0 1

0 0 0 1 0 0 0

0 0 0 0 1 0 0

Fonte: Elaborado a partir de Wasserman e Faust, 1994

Os grafos anteriores permitem entender quais são os nodos mais 
importantes do ponto de vista da conectividade. Porém, de novo a 
orientação das relações faz toda diferença. 

6.1 Centralidade de grau (degree) 

	 O indicador mais simples da importância de um nodo consiste 
em contar o número de arcos incidentes nele, ou, em outros termos, o 
número de nodos com os quais possui adjacência.

No caso anterior do grafo (a), em forma de estrela, contamos seis 
relações no total, d(n1) = 6. O d nesse caso significa degree ou grau nodal.

Figura 65 – Centralidade de grau no tipo estrela

Fonte: Elaborado a partir de Wasserman e Faust, 1994
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Se temos o grau nodal de todos os nós, podemos estabelecer a 
média do grau nodal para todo o grafo não orientado. 

No exemplo anterior, temos a seguinte conta:

A medida de centralidade apresenta algumas propriedades básicas, 
segundo a orientação ou não das relações. Se o grafo não for orientado, a 
soma dos arcos de entrada e de saída é igual.

Se o grafo for orientado, o grau nodal pode ter medidas diferentes 
de saída (out degree) e de entrada (in degree). A primeira constitui um 
indicador da iniciativa relacional do agente, e a segunda, de seu prestígio 
ou popularidade.  A notação formal distingue entre arcos de saída (+) e 
arcos de entrada (-), podendo ser normalizada. 

A normalização expressa o grau nodal em termos de uma proporção 
de arcos que cada nodo concentra na rede. Dessa forma, tornam-se 
comparáveis as medidas de centralidade de grau para redes de diferente 
tamanho, na medida em que tomamos um parâmetro relativo ao tamanho 
de cada rede. 

6.2 Centralidade de grau da rede como um todo

Até aqui, temos apresentado a centralidade local, ou focada em cada 
um dos nós. Isso permite construir rankings de status entre os agentes do 
sistema social, determinar quais são mais ativos ou quais possuem mais 
prestígio. Além disso, a condição formal das análises permite construir 
medidas para aferir até onde uma rede gravita em torno de um ou poucos 
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nós. De forma técnica, consiste em construir um índice de dispersão sobre 
a centralidade de grau de todos os nós. Em termos coloquiais, podemos 
perguntar se a rede está sendo puxada por poucos atores com alto grau 
nodal, se a formação das relações depende de poucos atores muito ativos 
ou prestigiosos, ou se, pelo contrário, há uma distribuição balanceada 
do número de relações entre os nós. Para tal propósito, os sociômetras 
construíram um algoritmo que permite aferir a centralidade global de um 
grafo. Vamos ver como opera essa conta para o caso de um grafo não 
orientado. A mesma lógica opera para um grafo orientado. 

Num primeiro momento, o que precisamos entender é o tipo puro 
da pior distribuição de grau. Essa consiste numa rede centralizada ao cem 
por cento, ou em uma rede em estrela, como o caso do grafo que aparece 
na Figura 65. Essa situação é a mais extrema centralização possível. Opera 
como o ponto de referência sobre o qual será aferida a centralização da 
rede observada. Cada grafo de tamanho g terá seu próprio tipo puro de 
extrema centralização. Por exemplo, no caso anterior, temos um grafo de 
tamanho g = 7, onde há um centro e seis alters diferentes. Se fosse uma rede 
de tamanho g=100, então a sua estrela respectiva seria uma rede com um 
centro e noventa e nove alters diferentes. E assim para qualquer tamanho. 

Num segundo momento, são calculadas as diferenças de grau nodal 
entre os nós da rede observada, como também as diferenças na rede de 
maior centralização para tamanho g respectivo. 

Finalmente, é construída uma proporção. No denominador é 
calculado o valor máximo da soma das diferenças no tipo puro, ou 
hipotético, do tamanho g respectivo, e no numerador é calculada a soma 
das diferenças entre o nó com maior centralidade observada e o restante 
dos alters. Wasserman e Faust (1994) introduzem a notação n* para 
designar o nó com maior grau nodal no grafo.
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Para os três tipos puros, podemos calcular a centralidade de 
grau para a rede como um todo. No grafo em estrela temos a situação 
extrapolada da máxima centralização possível de um grafo.

Figura 66 – Comparativo da centralidade de grau para os três tipos puros

Máxima centralização do grupo
Valor 1 (Centro único)

Intermediária centralização do 
grupo

Valor 0,067 (Centralidade 
decrescente em direção dos 

extremos)

Mínima centralização do grupo
Valor 0 (Nós intercambiáveis e 

igualmente centrais)

Fonte: Elaboração a partir de Wasserman e Faust, 1994
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A centralidade de grau global de uma rede orientada segue a lógica 
anterior, com a diferença de que é calculado o total das máximas distâncias, 
do tipo puro, elevando ao quadrado o número de arcos possíveis, o que 
podemos observar no denominador da seguinte fórmula.

7. Intermédio prático

7.1 Software para análise de redes: Pajek e Ucinet

Os analistas de rede já desenvolveram programas ordenadores 
(softwares – logiciels) que permitem processar as informações diádicas 
coletadas. Preparamos dois exercícios com dados fictícios para introduzir os 
softwares Pajek (versão 5.04) e Ucinet (versão 6.461). Os exercícios foram 
pensados para você realizar seu primeiro contato com esses programas 
de análise de redes amplamente utilizados. A maioria das análises podem 
ser feitas nos dois softwares, mas algumas métricas são específicas de 
cada um. Além disso, os programas, em alguns casos, instrumentalizam 
abordagens diferentes para alguns indicadores comuns, embora o 
resultado substancial da análise em cada software seja equivalente. 
Depois de conhecer os dois programas, você poderá optar por aquele que 
mais lhe agradou. Você poderá, também, combinar o uso de ambos, uma 
vez que mostraremos um modo de importação e exportação dos dados de 
um programa a outro. Vamos ao trabalho!

7.1.1 Criando uma rede no Pajek...
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O Pajek é um programa de uso livre desenvolvido pelos 
pesquisadores eslovenos Andrej Mrvar e Vladimir Batagelj. A tradução da 
palavra Pajek do esloveno para o português é aranha, uma referência às 
“teias” de relações que o programa desenha e analisa. O programa está 
disponível no sítio: http://Pajek.imfm.si/

O Pajek distingue três tipos de laços no tratamento dos dados 
relacionais: arcs (laços orientados), edges (laços não orientados) e loops 
(laços autorreferidos). O Quadro 2 ilustra as três possíbilidades.

Quadro 2 – Tipos de Laços no Pajek

Fonte: Elaboração própria.

A distinção dos laços é essencial nos momentos de inserção e 
análise dos dados. Vamos aprender duas formas de alimentarmos o 
programa.  A primeira será o método direto de inserção de dados no Pajek. 
É importante aprender essa forma de entrar com dados no software, pois 
ela lhe permitirá manipular uma rede criada para fazer correções pontuais 
quando erros de entrada de dados forem localizados no momento inicial 
da análise. A segunda maneira de alimentar o programa demanda a 
organização dos dados em um editor de texto. É uma forma simples e ágil 
de construir uma rede no Pajek. 

7.1.2 Inserção direta de dados no Pajek

Instale e abra o Pajek. Para criar uma rede, o primeiro passo será 
definir seu tamanho. Lembre-se que o tamanho da rede corresponde à 
quantidade de vértices que a compõem. Na janela principal do programa, 
execute o caminho: 

Network > Create New Network> Empty Network
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Uma caixa de diálogo será aberta. O Pajek perguntará o número 
de vértices que devem ser inseridos na rede, isto é, o tamanho da rede. 
Se fôssemos criar as subredes dos clubes da 1ª divisão do campeonato 
brasileiro de futebol em 2017, o tamanho da rede seria 20. Todavia, para 
este exercício vamos criar uma rede de tamanho 10. Digite o valor 10 e 
clique em ok.

Você vai perceber que o Pajek abriu uma janela de relatório (Report). 
Essa é a janela que o programa utiliza para apresentar as informações de 
desempenho e alguns resultados dos comandos executados. Toda vez que 
você executar um comando, a janela Report será aberta novamente. Você 
pode fechar, minimizar ou ajustar essa janela na parte inferior da tela de 
seu computador. 

Observe a caixa Networks na tela principal do programa. A rede que 
você criou foi registrada! Para visualizar o resultado, execute o caminho: 

Draw > Network.

O programa abrirá a janela de desenho. Note que os vértices estão 
identificados pelos nomes (labels) v1, v2 ... v10. Podemos renomeá-los 
considerando a lista de nomes dos atores que formam nossa rede. Nesse 
exercício vamos utilizar o seguinte conjunto de atores: 

N = {Natália Leão, Leonardo Silveira, Antonio Ribeiro, Mayra 
Andrade, Silvio Salej, Farney Alcantra, Wanderson Savoi, Vinícius Couto, 
Maurício Botrel, Camila Oliveira}

Pelo método direto de inserção de dados no Pajek, a identificação 
nominal dos vértices será criada através de uma partição. No software as 
partições são um tipo de arquivo que guarda informações sobre atributos 
dos vértices. Na tela principal do Pajek, elas podem ser visualizadas na caixa 
“Partitions”. Em diversos momentos da análise de redes sociais com o Pajek, 
trabalharemos com partições. Para criar uma partição, execute o caminho: 

Partition > Create Constant Partition

Na caixa de diálogo aberta, informe o tamanho da partição. Atenção: 
a partição deve ser do mesmo tamanho da rede criada. Mantenha o valor 
zero em Constant e clique em ok.
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Verifique a caixa Partitions na tela principal do programa. Veja que 
a partição foi registrada. Para inserir o nome dos vértices, basta editá-la. 
Execute o caminho:

File > Partition > View/Edit

A tela de edição será aberta. Substitua as identificações v1, v2, ..., 
v10 pelos nomes informados acima. Depois de digitar feche a tela (não é 
necessário salvar). Visualize a rede novamente e veja o resultado.

Observação: Em alguns casos é necessário manter o anonimato 
dos nodos de nossa rede. Para isso você pode identificá-los através de 
números no lugar dos nomes. O Pajek oferece a opção das duas formas 
de identificação dos nodos. Na janela de desenho, após visualizar a rede, 
utilize os atalhos ctrl+L para identificar os vértices pelos nomes, ctrl+N 
para identificar pelos números dos vértices e ctrl+D para representar 
o sociograma sem identificação. Você obterá o mesmo resultado pelo 
caminho:

Options > Mark Vertices Using > Labels / Numbers / No Labels

7.1.3 Como inserir as relações na rede

Estamos prontos para inserir as relações entre os nodos de 
nosso exemplo. Pelo método direto de inserção de dados, as relações 
são informadas uma a uma. Atenção! É preciso saber se as relações 
são orientadas ou não orientadas (arcs ou edges) e se são binárias ou 
valoradas. Para inserir informações sobre as relações, execute o caminho: 

File > Network > View/Edit

A caixa de diálogo Edit lines incident to vertex será aberta. Indique 
o nodo a que se referem as informações relacionais que serão inseridas. 
Você pode digitar o número ou o nome do nodo. Vamos começar pelo 
primeiro nome da lista “Natália Leão”, número 1. Faça sua opção pelo 
nome ou número, digite na caixa de diálogo e clique em ok. A tela para 
edição dos laços do nodo 1 (vertex 1, no Pajek) será aberta. Note no topo 
dessa janela a identificação do nodo cujas relações estão sendo editadas.
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Para editar as relações efetue um duplo clique sobre a palavra 
Newline. Na caixa de diálogo Add line In/Out of vertex, serão solicitadas a 
informação sobre o tipo de laço e a identificação do alter cuja relação está 
sendo editada. As duas informações serão digitadas simultaneamente. 

Quando os laços são direcionados (arcs), devemos diferenciar entre 
laço de entrada e de saída. Nesse caso, o vertíce selecionado (ego) é a 
referência. No Quadro a seguir, o vértice ego está identificado com v1. Se 
o laço for de entrada, isto é, o ego recebe algo do alter, o valor informado 
na caixa de diálogo Add line In/Out of vertex será identificado com o 
símbolo (+) seguido do número de identificação do alter na rede (ex.: 
para L = <v1,v2>, digite +2). Se você for informar um laço de saída, isto é, 
quando o ego envia um recurso para o alter, digite o simbolo (-) seguido 
do número de identificação do alter na rede (ex.: para L = <v2,v1>, digite 
-2). Para informar laços não direcionados (edges), basta digitar o número 
de identificação do alter na rede. Se o laço corresponde a um loop, então 
basta repetir o número de identificação do ego na rede. 

Veja no Quadro 3 como digitar os valores. 

Quadro 3 – Valores de entrada no Pajek relações de v1

Fonte: Elaboração própria.

Após informar a relação do ego com um alter, repita a operação até 
digitar todos os relacionamentos do ego. Ao final desse trabalho, feche a 
tela de edição e repita a operação para um novo ego. 

Agora estamos prontos para inserir as informações sobre as relações 
no nosso exemplo. O próximo Quadro mostra relações de empréstimo 
de dinheiro entre os nomes listados acima. Esse exemplo é fictício, foi 
pensado apenas para introduzir o software. Antes de iniciar o trabalho, 
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identifique o tipo de laço que compõe a rede: empréstimo de dinheiro são 
laços orientados (arcs) ou não orientados (edges)? 

Quadro 4 – Relações de empréstimo de dinheiro entre 10 amigos

Nº na rede Nome do ator Emprestou a... 
1
2
3
4
5
6
7
8
9

10

Natália Leão
Leonardo Silveira
Antonio Ribeiro
Mayra Andrade
Silvio Salej
Farney Alcantra
Wanderson Savoi
Vinícius Couto
Maurício Botrel
Camila Oliveira

2; 9;10.
1; 5
1; 2; 4; 5; 6; 7; 8; 10.
2.
3.
10; 5; 1.
1.
1; 10.
8.
1;2; 7.

Fonte: Elaboração própria.

Lembre-se que emprestar dinheiro é um laço de saída, portanto 
arc (-). 

Observe que, ao informar um laço de saída, o programa realiza a 
seguinte notação:

“1:	 1.2	 Val=1.0000 / Natália Leão.Leonardo Silveira”. 

Isto é, Natália emprestou dinheiro ao Leonardo. No sociograma, a 
seta sairá de Natália e chegará em Leonardo.

Observe que, ao começar a digitar as informações do segundo nodo 
(Leonardo), haverá um laço de entrada registrado. Veja que a notação 
deste laço é:

“1:	 1.2	 Val=1.0000 / Natália Leão.Leonardo Silveira”. 

Note que se trata do mesmo laço anterior, entretanto, como 
Leonardo passa ser o ego, o laço é considerado um laço de entrada. Isto 
é, Leonardo recebeu recurso de Natália. Observe que será registrado um 
novo laço quando você inserir a informação sobre o empréstimo que 
Leonardo fez à Natália, segundo a notação:

“1:	 2.1	 Val=1.0000 / Leonardo Silveira.Natália Leão”. 
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Observe também que “Val=1.0000” na notação indica que os laços 
foram registrados como binários (houve ou não houve emprestímo). Se 
tivéssemos informações sobre os valores dos empréstimos, bastaria clicar 
com o botão direito em cima desse valor e informar quanto de dinheiro 
um ator emprestou ao outro. Se você digitou errado e desejar excluir uma 
relação, basta um duplo clique sobre a relação que o Pajek lhe dará a 
opção de excluí-la.

Digite todas as informações sobre as relações de empréstimo e 
visualize o resultado. Para otimizar sua visualização, utilize o comando 
Kamada-Kawai executando o seguinte caminho na janela de desenho:

Energy > Kamada-Kawai > Free

A Figura 67 mostra o resultado que você alcançará: 

Figura 67 – Rede de empréstimos de dinheiro

Fonte: Elaboração própria. Software Pajek.

O próximo passo é exportar o dígrafo que você criou. A opção mais 
simples e usual é, a partir da tela de desenho, executar o caminho:

Export > 2D > JPEG > Run

O arquivo será exportado em formato “.jpeg”, então você pode 
utilizá-lo em seus textos e apresentações.



123

Capítulo 5 – Descrição de uma estrutura reticular 

7.1.4 Como guardar a rede criada

Por fim, é o momento de salvar a rede que você criou pelo método 
direto de inserção de dados no Pajek. A partir da tela principal do 
programa, siga o caminho:

File > Network > Save

Escolha um nome para a rede, por exemplo: exercício de introdução 
aos softwares. Escolha a pasta em seu computador onde deseja salvar a 
rede. Clique em Salvar. O Pajek criará um arquivo com extensão “.net”. 
Atenção: Todos os arquivos com a extensão “.net” são aquivos com dados 
estruturais e devem ser abertos na caixa networks da tela principal do 
programa. Esse arquivo pode ser lido por meio do bloco de notas de 
seu computador. Note que será necessário salvar somente a rede, não 
é preciso guardar a partição que usamos para identificar os nodos pelos 
nomes. Depois de salvar sua rede, feche e abra o programa. Então, abra 
novamente a rede que você criou utilizando o caminho:

File > Network > Read

Visualize novamente a rede. Veja que o programa desenha a rede 
com o mesmo posicionamento que você salvou. Isso é uma vantagem 
importante, que poderá lhe poupar bastante tempo.

7.1.5 Criar uma rede com ajuda do bloco de notas

Antes de calcularmos algumas métricas que descrevem a rede que 
criamos, vamos aprender como criar uma rede com a ajuda do bloco de 
notas. Esse método pode ser útil quando trabalhamos com redes muito 
grandes. A seguir, descrevemos algumas regras simples para preparar o 
arquivo “.txt” que será lido pelo Pajek.

Abra o bloco de notas de seu computador. Sempre começaremos 
pelas informações referentes aos nodos das redes, que no Pajek são 
chamados vértices. O símbolo * (asterisco) é usado para indicar ao 
programa que informações sobre um elemento da rede (nodos ou relações) 
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serão inseridas. Assim, logo na primeira linha do bloco de notas digite o 
símbolo * seguido da palavra vertices seguida de espaço (não acentue 
a palavra). Na mesma linha digite o numeral referente à quantidade de 
nodos da rede, isto é, informe o tamanho da rede. Em nosso exemplo 
teremos o seguinte resultado depois desse primeiro passo: 

*vertices 10

Assim, informamos ao programa que as informações a seguir serão 
sobre uma rede de tamanho 10. O próximo passo é identificar os 10 
nodos da rede por números e nomes. Para isso, vamos digitar, a partir da 
segunda linha, os números (espaço) e entre aspas os nomes dos vértices 
correspondentes. A enumeração dos nodos deve começar em 1 e ir até o 
tamanho da rede, no nosso exemplo, 10.  Cada nodo será identificado em 
uma linha diferente do texto. 

Embora o uso de aspas não seja obrigatório, ele é aconselhável 
quando utilizamos nomes compostos. Caso contrário, ao representar 
o sociograma somente será mostrado o primeiro nome do vértice. 
Por exemplo, se o nome do vértice é Fernando Henrique Cardoso será 
mostrado apenas Fernando. Uma solução alternativa é digitar os nomes 
sem separá-los por espaços, assim: FernandoHenriqueCardoso. Concluída 
essa etapa, nosso exemplo assumirá a seguinte digitação:

*vertices 10
1 “Natália Leão”
2 “Leonardo Silveira”
3 “Antônio Ribeiro”
4 “Mayra Andrade”
5 “Silvio Salej”
6 “Farney Alcantra”
7 “Wanderson Savoi”
8 “Vinícius Couto”
9 “Maurício Botrel”
10 “Camila Oliveira”
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O terceiro passo é digitar as informações sobre o segundo elemento 
da rede: as relações. Logo, precisaremos iniciar a próxima linha do texto 
com o simbolo * seguido da identificação do tipo de laços que formam 
a rede (se orientado (arcs) ou não orientados (edges)). Nosso exemplo é 
uma rede orientada, isto é, uma rede formada por arcs. Basta digitar:

*arcs

A partir da linha seguinte, informe as relações entre os vértices 
considerando a enumeração que você elaborou no passo anterior. Utilize 
apenas os números dos vértices. Informe uma relação a cada linha do 
texto. Devemos digitar o número do ego (espaço) e o número do alter 
(enter). Repita a operação até terminar de informar todas as relações. 
Por exemplo: se Natália Leão emprestou dinheiro para Leonardo Silveira, 
Maurício Botrel e Camila Oliveira, então essas relações serão especificadas 
da seguinte forma: 

1 2 
1 9 

1 10

Observação: quando for necessário representar a intensidade das 
relações, pressione a tecla TAB ou espaço do computador e digite o valor 
do laço. Por exemplo, se Natália emprestou 200 reais para Maurício Botrel, 
devemos especificar a relação e sua intensidade digitando:   

1 9     200

Em nosso exemplo, não vamos considerar o quanto de dinheiro 
circulou de ator a ator na rede de empréstimos. Desse modo, ao final do 
processo, teremos o seguinte resultado:

*vertices 10
1 “Natália Leão”
2 “Leonardo Silveira”
3 “Antônio Ribeiro”
4 “Mayra Andrade”
5 “Silvio Salej”
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6 “Farney Alcantra”
7 “Wanderson Savoi”
8 “Vinícius Couto”
9 “Maurício Botrel”
10 “Camila Oliveira”
*arcs
1 2
1 9
1 10
2 1
2 5
3 1
3 2
3 4
3 5
3 6
3 7
3 8
3 10
4 2
5 3
6 1
6 5
6 10
7 1
8 1
8 10
9 8
10 1
10 2
10 7
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Agora basta guardar o arquivo “.txt” com um nome que identifique 
a rede que você criou. Em seguida feche o bloco de notas e abra o Pajek. 
Para visualizar a rede, execute o caminho:

File > Network > Read

Note que é o mesmo comando utilizado para reabrir a rede que 
criamos pelo método direto de inserção de dados. Procure o arquivo 
“.txt”. Atenção! Para que seu arquivo txt apareça entre as opções de 
leitura para o Pajek, você precisará alterar, na caixa de diálogo, a opção 
network (*.net) pela opção all files (*.*). Veja a figura a seguir:

Em seguida, basta escolher o aquivo txt que você guardou e clicar 
em Abrir. Sua rede será ativada na caixa Networks da tela principal do 
Pajek. Visualise a rede, note que o resultado foi o mesmo que você 
alcançou com o procedimento anterior.

Duas observações importantes:
Note que não precisamos digitar os laços de entrada e saída. Foi 

suficiente digitar apenas a relação de saída (emprestou a...). Se nossas 
informações fossem sobre quem pegou dinheiro emprestado, então, ao 
digitar as relações, deveríamos digitar a identificação dos alters (espaço) 
seguida da identificação do ego (enter). Por exemplo: se Leonardo 
Silveira pegou dinheiro emprestado com Natália Leão, a notação da 
relação seria: 2 1

Para montar redes com laços diferentes (arcs, edges e loops), basta 
digitar as especificações que identificam os laços antes de registrar as 
relações. Veja outro exemplo hipotético a seguir:

*vertices 5
1 “Luiza Almeida”
2 “Laura Jardim”



128

Análise de redes em Ciências Sociais

3 “Antônio Silva”
4 “Solange Nunes”
5 “Jéssica Dolores”
*arcs
1 3
2 3
4 3
5 3
*edges
1 2
4 5
*loops
5 5

7.1.6 Inserindo atributos dos atores na análise

Atributos dos atores podem ser categóricos (cor, classe, sexo etc.) 
ou quantitativos (renda, desempenho acadêmico, idade etc.). No Pajek, 
atributos categóricos são alocados na caixa Partições (Partitions), e os 
quantitativos serão alocados na caixa Vetores (Vectors). Neste exemplo, 
vamos traballhar apenas com atributos categóricos, todavia o procedimento 
será semelhante quando for necessário trabalhar com atributos quantitativos.

Para inserir os atributos categóricos dos nodos, devemos criar uma 
partição constante. Execute novamente o caminho:

Partition > Create Constant Partition

Em seguida, vamos editá-la e inserir os códigos dos atributos (“1” 
para feminino e “2” para masculino). Execute novamente o caminho:

File > Partition > View/Edit 

Insira os códigos na primeira coluna considerando o sexo a partir 
dos nomes das pessoas. Feche a partição (não é necessário salvar). Na tela 
principal do programa, visualize a rede executando o caminho:

Draw > Network + First Partition



129

Capítulo 5 – Descrição de uma estrutura reticular 

A Figura 68 mostra o resultado que você alcançará. 

Figura 68 – Rede de empréstimos e sexo

Fonte: Elaboração própria. Software Pajek.

Observação: Para melhorar a visualização do sociograma, você 
pode alterar a cor dos atributos. Na tela de desenho, execute o comando: 
Options > Partition Colors > for Vertices. O Pajek oferece três opções de 
Default, mas você pode distribuir as cores como quiser. Basta clicar em 
cima da cor desejada e digitar o código que identifica o atributo. Por 
exemplo: clique no quadrado cinza claro e na caixa de diálogo aberta digite 
1. Clique em ok. Clique no quadrado cor cinza escuro e na caixa de diálogo 
aberta digite 2. Clique ok. Para as cores aparecerem no sociograma, basta 
clicar no espaço do sociograma ou fechar a tela de desenho e executar 
novamente o comando Draw > Network + First Partition. Note que o sexo 
masculino está representado pelo cinza escuro, e o feminino, pelo cinza 
claro. Utilize o menu Options da tela de desenho para alterar o tamanho 
dos vértices, da fonte e das setas. No primeiro caso, utilize Options > Size 
> of Vertices. No segundo, utilize Options > Size > of Font > Select. No 
terceiro, execute Options > Size > of Arrows.
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7.1.7 Como calcular a centralidade dos atores na rede

Neste exemplo, vamos mostrar como calcular três medidas básicas: 
a centralidade de grau, discutida neste capítulo, e as centralidades de 
proximidade e intermediação que discutiremos no próximo capítulo. As 
medidas de centralidade são atributos quantitativos que os atores possuem 
em função de sua posição na rede. São, portanto, atributos que aferimos a 
partir da rede que estamos analisando. O caminho para calcular tais medidas 
no Pajek é dado a partir do menu network. Para redes orientadas, como em 
nosso exemplo, algumas medidas diferenciam entre input e output. Como 
vimos, nesses casos são consideradas as diferenças entre entrada e saída do 
recurso que circula na rede. Para calcular o grau nodal, execute o caminho:

Network > Centrality > Degree > Input / Output / All

Note que você deverá escolher entre grau de entrada ou saída. A 
opção All desconsidera a orientação dos laços. Você deve ter boas razões 
para escolher essa opção, caso os laços sejam orientados. Para redes não 
orientadas escolha All.

Para calcular o grau de proximidade, execute o caminho:

Network > Centrality > Closeness > Input / Output / All

Para essa métrica, você também deve escolher calcular o grau de 
entrada ou saída. A opção All terá o mesmo significado que o caso anterior.

Para calcular o grau de intermediação, execute o caminho:

Network > Centrality > Betwenness

Nesse caso não é preciso diferenciar o sentido dos laços, já que 
o cálculo considera o número de vezes que um nodo se encontra nas 
geodésicas que ligam as díades dos dígrafos.

Depois de calcular as medidas de centralidade, você pode 
representá-las nos dígrafos, executando o caminho:

Draw > Network + First Vector
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Você pode representar o atributo sexo e uma medida de 
centralidade, pelo caminho:

Draw > Network + First Partition + First Vector

Você ainda pode representar o atributo sexo e duas medidas de 
centralidade, pelo caminho:

Draw > Network + First Partition + First Vector + Second Vector

Nesse caso, lembre-se da visualização da rede de transferências 
de jogadores entre os clubes da 1ª divisão do campeonato brasileiro em 
2017. Considere que sua opção para ordenar os vetores tem impacto na 
forma dos nodos. A medida ativa na primeira opção da caixa Vectors da 
tela principal do programa é considerada o First Vector e sua amplitude 
será representada na horizontal. A medida ativa na segunda opção é o 
Second Vector e sua amplitude será representada na vertical. A seguir 
a ilustração das três formas que a representação simultânea dos graus 
nodais de entrada e saída podem assumir:

•	 Calcule as medidas de centralidade e teste visualizações da 
rede. A seguir apresentamos uma possibilidade referente ao 
grau nodal de entrada (primeiro vetor) e ao grau nodal de saída 
(segundo vetor).
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Figura 69 – Rede de empréstimos, sexo e grau nodal de entrada e saída

Fonte: Elaboração própria. Software Pajek.

Por fim, chegou a hora de guardar o trabalho que você realizou. 
Desta vez, vamos salvar um arquivo de projeto do Pajek. Essa opção 
tem a vantagem de guardar todo o trabalho em um único arquivo. Você 
poderá, por exemplo, compartilhar suas análises com outros colegas. 
Outra vantagem é que a qualquer momento você poderá continuar sua 
análise de onde parou. Ao salvar o projeto, o programa cria um único 
arquivo com extensão “.paj”. Para salvar um projeto, execute o caminho:

File > Pajek Project File > Save

É recomendável que você salve seu trabalho em diferentes 
momentos da análise. À medida que avançar com o trabalho, execute 
novamente o comando salvando a versão atual sobre a versão anterior.

Atenção! Para abrir um projeto novamente lembre-se de executar 
o caminho:

File > Pajek Project File > Read

Não confunda com o comando que utilizamos para abrir informações 
da rede.

Para acessar informações sobre a rede, tais como densidade, 
quantidades de laços, tipos de laços, centralidade média, execute o caminho:

Network > Info > General
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A caixa de diálogo aberta permite que você liste os pares mais 
fortemente ou mais fracamente contectados. Essa função só faz sentido 
para redes valoradas, caso contrário basta clicar em ok.

Antes de inicar a introdução ao Ucinet, convém destacar que as 
partições e os vetores podem ser guardados separadamente, conforme 
fizemos com a rede. Nesses casos, basta seguir os caminhos: 

File > Partition > Save (para guardar partição) 
e 

File > Vector > Save (para guardar vetores)

Arquivos com informações de atributos contínuos, ou seja, partições, 
terão a extensão “.clu”, e arquivos de variáveis quantitativas (vetores) 
terão a extensão “.vec”). É importante se familiarizar com as extensões 
dos arquivos, para saber onde abrir cada conjunto de informações.

7.2 Criando uma rede no Ucinet...	

7.2.1 Sobre o Ucinet

O Ucinet é outro programa de análise de redes amplamente 
utilizado pelos analistas de redes sociais, desenvolvido por Steve Borgatti, 
Martin Everett e Lin Freeman. Os criadores do programa cobram preços 
diferenciados por tipo de licença do programa. Valores menores são 
concedidos para fins acadêmicos. Entretanto, uma versão para testes está 
disponível no sítio: http://www.analytictech.com/Ucinet/ 

Ao instalar o programa, automaticamente o usuário instalará 
o NetDraw, software associado ao Ucinet utilizado para visualizar os 
sociogramas. Como ressaltamos antes, nossa estratégia é introduzir o 
leitor deste manual nos dois softwares. Na seção anterior, aprendemos a 
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inserir dados relacionais, atributos, visualizar sociogramas e calcular três 
medidas de centralidade utilizando o software Pajek. Agora vamos repetir 
esses procedimentos no Ucinet. Lembramos que os dois programas são 
pensados aqui de forma complementar, portanto, vamos apontar como 
chegar a outras medidas de centralidade que não encontramos no Pajek. 
O analista de rede elegerá seu programa favorito e recorrerá ao outro 
software quando necessário. Aos poucos você irá se familarizando com as 
semelhanças e diferenças dos dois programas.

Seguindo o que fizemos com o Pajek, vamos introduzir os dados 
diretamente no Ucinet e também com a ajuda de um editor de texto. Além 
dessas opções, o Ucinet oferece a opção de importar/exportar dados do/
para Pajek. Nesse exercício, importaremos a rede que criamos no Pajek e 
exportaremos a rede que criaremos a seguir no Ucinet. 

Instale a versão de teste do Ucinet em seu computador. Antes de 
iniciar o trabalho no programa, é útil alterarmos o diretório no qual o 
programa salvará seus resultados e buscará os dados que serão analisados. 
Daqui para frente, chamaremos esse diretório de “diretório ativo”. 

Após instalar o programa, abra o software. A tela principal ou 
calculadora do Ucinet mostra informações sobre o programa, sobre a 
licença do programa e sobre o diretório ativo. Observe na parte inferior 
da tela o caminho para o diretório ativo. Para alterá-lo, conforme sua 
necessidade, clique, no canto inferior direito, sobre o ícone amarelo 
chamado set default folder (passe o mouse sobre o ícone para ver o 
nome). Na caixa de diálogo aberta, procure o diretório que você ativará 
para guardar suas análises. Clique em ok. Verifique na tela principal se o 
novo diretório foi registrado. Veja também que o endereço que aparece 
ao lado do ícone também foi alterado.

7.2.2 Método direto de entrada de dados no Ucinet

Agora estamos prontos para criar uma nova rede utilizando o 
Ucinet. Elaboramos outro exemplo, agora sobre troca de conselhos entre 
10 amigos. O Quadro a seguir mostra quem aconselhou quem:
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Quadro 5 – Troca de conselhos entre amigos

Emitiram conselhos Receberam conselhos
Carlos Mayra, Elder, Luiz, Thais, Clara, Leo e Maria
Bob Luiz e Elder
Luiz Carlos, Mayra, Mel e Bob
Maria Carlos, Mayra e Elder
Clara Mel, Mayra e Thais
Mayra Carlos, Elder, Mel, Thais, Maria, Clara e Leo
Elder Carlos, Mel e Bob
Mel Luiz, Mayra, Carlos e Clara
Thais Leo, Carlos, Elder, Luiz e Bob
Leo Mel, Carlos e Clara

Fonte: Elaboração própria.

Para entrada de dados diretamente no Ucinet, precisamos criar a 
matriz de adjacência a partir de nossos dados. Como vimos, operações 
com matrizes são a base matemática da análise de redes sociais. Quando 
trabalhamos com a ferramenta Pajek, não acessamos diretamente a 
matriz de nossa rede de empréstimos, mas o programa a construiu a 
partir dos dados que fornecemos. 	

As matrizes de redes one-mode, como é o caso dos exemplos que 
trabalhamos neste exercício, são sempre matrizes quadradas (o número 
de colunas é igual ao número de linhas). Como nossa abordagem aqui 
considera apenas a presença ou a ausência de laços entre as díades da 
rede, nossas matrizes são binárias, isto é, formadas pelos valores 0 e 1. 
O tamanho da matriz, por sua vez, é igual ao número de nodos da rede. 
No exemplo acima, os conselhos são trocados entre 10 amigos, portanto 
nossa matriz terá o tamanho 10x10. 

O Ucinet oferece a possibilidade de construirmos a matriz a partir 
de um editor de matriz (matrix editor) e de um editor de matriz excel 
(excel matrix editor), que podem ser acessados diretamente do programa. 
Se preferir, você pode construir sua matriz no Excel, copiar e colar em 
algum dos editores de matriz do programa. Neste exemplo, vamos utilizar 
o editor de matriz. Siga o caminho:

Data > Data editors > Matrix editor
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Você deve usar a primeira coluna e a primeira linha para digitar 
a identificação dos nodos. Digite a identificação dos nodos a partir da 
segunda célula da primeira coluna. Nomes compostos não devem ser 
separados por espaço. Exemplo: para Antonio Carlos digite AntonioCarlos. 
Em seguida preencha a etiqueta das colunas; utilize o seguinte caminho:

Labels > Copy rows to columns

O próximo passo é adequar a dimensão da matriz ao tamanho da 
rede. Na caixa de diálogo Dimensions do editor de matriz (segunda caixa 
do canto direito), informe o número de linhas e de colunas da matriz, isto 
é, a quantidade de nodos da rede. Neste exercício trabalhamos com uma 
rede One-Mode de tamanho 10, logo digite 10 em Rows e em Cols. 

Vamos agora informar as relações entre os atores. Comece 
digitando zeros na diagonal da matriz, pois a diagonal representa os loops 
e, neste exemplo, esse tipo de laço não existe. Preencher a diagonal com 
zeros diminui as chances de erros! O passo seguinte será apontar quem 
deu conselho a quem. Tendo o quadro acima como referência, marque 
com valor 1 o vértice entre o conselheiro (ego) e os seus aconselhados 
(alters). Você deve ter em mente, ao digitar os dados, que cada linha 
da matriz mostra a origem da relação (o conselheiro) e as colunas são 
os destinos dos recursos (os aconselhados). Assim, se queremos digitar 
as informações sobre quem Carlos aconselhou, devemos digitar o valor 
um (1) na interseção entre a linha de Carlos e as colunas dos atores que 
receberam os conselhos. Por exemplo, se Carlos aconselhou Luiz e Clara, 
devemos digitar o valor 1 nas células onde a linha de Carlos cruza as 
colunas de Luiz e Clara, conforme o exemplo a seguir:

Carlos Bob Luiz Maria Clara Mayra Elder Mel Thais Leo
Carlos 0 1 1

Depois de informar os laços presentes na matriz, preencha as 
células vazias com o valor 0. Uma vantagem em utilizar o editor de matriz 
do Ucinet é que ele oferece uma opção para preencher as células vazias 
com zero. Execute o caminho:

Fill > Blanks w/0s
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A Figura 70 mostra o resultado final.

Figura 70 – Matriz 10 x 10 troca de conselhos com identificação dos 
atores

  Carlos Bob Luiz Maria Clara Mayra Elder Mel Thais Leo

Carlos 0,000 0,000 1,000 1,000 1,000 1,000 1,000 0,000 1,000 1,000

Bob 0,000 0,000 1,000 0,000 0,000 0,000 0,000 0,000 0,000 1,000

Luiz 1,000 1,000 0,000 0,000 0,000 1,000 0,000 1,000 0,000 0,000

Maria 1,000 0,000 0,000 0,000 0,000 1,000 1,000 0,000 0,000 0,000

Clara 0,000 0,000 0,000 0,000 0,000 1,000 0,000 1,000 1,000 0,000

Mayra 1,000 0,000 0,000 1,000 1,000 0,000 1,000 1,000 1,000 1,000

Elder 1,000 1,000 0,000 0,000 0,000 0,000 0,000 1,000 0,000 0,000

Mel 1,000 0,000 1,000 0,000 1,000 1,000 0,000 0,000 0,000 0,000

Thais 1,000 1,000 0,000 1,000 0,000 0,000 1,000 0,000 0,000 1,000

Leo 1,000 0,000 0,000 0,000 0,000 0,000 0,000 1,000 0,000 0,000

Fonte: Elaboração própria. Software Ucinet.

Salve o arquivo utilizando:

File > Save

Feche a janela. A matriz foi guardada no diretório que você escolheu 
anteriormente. Seus dados estão prontos para serem lidos pelo Ucinet. 
Atenção! É importante saber que os dados produzidos no Ucinet geram 
dois arquivos “gêmeos”. Uma arquivo possui a extensão .##d e o outro a 
extensão .##h. Examine o diretório onde você guardou sua matriz. Veja 
que há dois arquivos com o mesmo nome, mas com extensões diferentes. 
Caso você deseje mover os dados para outro diretório ou enviá-los a um 
amigo, será necessário mover ou enviar os dois arquivos (“.##d” e “.##h”).

7.2.3 Como visualizar redes no Ucinet

O Ucinet utiliza um software auxiliar chamado NetDraw para criar 
representações da rede em sociogramas. Lembre-se que, ao instalar o 
Ucinet em seu computador, o NetDraw foi instalado automaticamente. 
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Você pode abrir esse programa a partir da tela principal do Ucinet, 
executando:

Visualize > NetDraw

Para visualizar o sociograma, execute o caminho: 

File > Open > Ucinet dataset > Network

Na caixa de diálogo aberta, procure o arquivo que deseja 
visualizar. Se você o guardou no diretório ativo será fácil encontrá-lo. 
Selecione o arquivo e clique em ok. Sua rede aparecerá na tela principal 
do programa. 

Se tudo ocorreu bem, o gráfico de sua rede foi criado. Note que 
as etiquetas da matriz nomeiam os nodos da rede. Atente-se também 
que no canto direito da tela existem duas abas: uma com informações 
sobre as relações e outra com informações sobre os nodos. Para mudar 
de uma para outra, basta clicar sobre a palavra Nodes se deseja ver as 
informações sobre os atores ou sobre a palavra Rels se você quer ver as 
informações sobre relações. Veja que você pode marcar ou desmarcar 
atores e relações de acordo com o que você deseja representar no 
gráfico. No caso das relações, essa função será mais útil em redes 
Multiplex.

A primeira representação feita pelo programa nem sempre é a 
melhor. Examine a imagem gerada e procure eliminar sobreposição de 
pontos e linhas. Evite deixar a linha entre dois nodos sobrepor um terceiro 
nodo. Procure posicionar os nodos de forma a evitar linhas cruzadas.  Para 
alterar a imagem elaborada, clique sobre os pontos, segure e arraste, 
posicionando-os no lugar que achar mais adequado.

Você pode mudar o tamanho, a cor e a forma dos nodos, das setas 
e da identificação dos nodos da rede. Na tela principal do NetDraw, você 
poderá trabalhar com o menu Properties para formatar seu sociograma. 
Teste as opções de Nodes e Lines para os nodos e linhas, respectivamente. 
O sociograma da Figura 71 foi criado no NetDraw. Aplique o que você 
aprendeu para elaborar um dígrafo igual. 
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Figura 71 – Rede de aconselhamento

Fonte: Elaboração própria. Software Netdraw.

Após editar o sociograma, guarde sua figura para utilizá-la em seus 
textos e apresentações. O Ucinet permite salvar o desenho definitivo no 
formato “.jpeg”. Execute o caminho:

File > Save Diagram As > Jpeg

Você também pode salvar um trabalho não concluído do sociograma 
para terminá-lo posteriormente. Neste caso, salve o arquivo com a 
extensão “.vna”. Execute o caminho:

File > Save Data As > Vna

Para continuar a edição em outro momento, bastará abrir o 
NetDraw e acessar o arquivo “.vna” seguindo o caminho:

File > Open > Vna text file > Complete

7.2.4 Como criar uma rede no Ucinet com ajuda de um editor de 
texto

Um problema comum que podemos encontrar ao organizarmos 
nossos dados refere-se ao tamanho da rede estudada. Quando analisamos 
redes muito grandes, a construção da matriz de adjacência pode ser muito 
trabalhosa. Nesses casos, temos a opção de utilizar um editor de texto 
para entrar com os dados no Ucinet. Vamos ao trabalho!
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Abra o bloco de notas de seu computador. Na primeira linha do 
arquivo, você deve digitar a seguinte linha de comando: 

dl, n=10, format=nodelist1, labels embedded data:

Observação: n representa o número de atores da rede. No nosso 
exemplo, o tamanho de nossa rede é 10.

A partir da segunda linha, você digitará as informações sobre 
as relações de cada ator. Primeiro você deve digitar o nome do ego (o 
conselheiro); logo em seguida, na mesma linha, digite os nomes dos 
alters (os aconselhados pelo ego). Separe os nomes pressionando uma 
vez a tecla tab ou a barra de espaço. No nosso exemplo, Bob enviou um 
conselho a Luiz e a Leo; logo em frente à identificação de Bob vamos 
digitar Luiz e Leo, conforme a seguir:

Bob    Luiz    Leo

Atenção: a identificação de cada nodo deve ser exatamente igual 
todas as vezes em que for digitada, caso contrário o nodo será considerado 
como um novo ator toda vez que seu nome for digitado errado. Não utilize 
nomes compostos. Você notou que, se você utilizar um nome composto, 
o programa considerá que se trata de dois atores e não apenas um. Se 
necessário, junte os nomes compostos, também evite utilizar acentos. 
Exemplo: para a identificação Carlos Antônio, digite CarlosAntonio. Você 
pode copiar e colar a primeira digitação do nome para evitar erros. O 
resultado final é mostrado na Figura 72. Salve o arquivo e feche o bloco 
de notas.

Figura 72 – Arquivo .txt pronto para ser importado pelo Ucinet
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Caso queira, você pode utilizar um software de apoio para preparar 
os dados, desde que ele lhe permita salvar os dados como aquivo de texto 
(.txt).

Agora basta abrir o Ucinet e executar o caminho:

Data>Import text file> DL…

A caixa de diálogo Import DL Text File será aberta. Clique em “...” e 
abra o arquivo .txt. Clique em ok. Se tudo tiver ocorrido bem, o programa 
mostrará sua matriz em um output no formato .txt e salvará os arquivos 
“gêmeos” com os dados da rede no seu diretório ativo. Caso ocorra algum 
erro, será emitida uma mensagem; nesse caso você deve abrir seu arquivo 
no bloco de notas e procurar o erro. Verifique no arquivo de “.txt” se a linha 
de comando está correta, inclusive a informação sobre o tamanho da rede.

7.2.5 Inserindo atributos dos atores na análise.

Após criar nossa rede no Ucinet, seja diretamente no programa ou 
com o apoio do editor de texto, podemos inserir informações sobre os 
atributos dos atores. Vamos construir um arquivo a partir de nossa matriz de 
adjacência para entrar com os atributos dos atores. Acesse a tela principal 
do Ucinet e abra o editor de matriz seguindo o caminho Data > Data editors 
> Matrix editor. No editor de Matriz, utilize o comando File > Open para 
abrir a matriz de adjacência da rede para a qual criaremos os atributos.

No canto direito, altere a dimensão da matriz (Matrix dimensions), 
reduza o número de colunas para o número de tipos de atributos que 
deseja inserir. Neste exemplo, vamos trabalhar com dois atributos: sexo 
e time de futebol favorito. Logo, precisaremos de uma matriz 10 x 2 (dez 
linhas e duas colunas). Na caixa Dimensions, mude o número de colunas 
(cols) substituindo 10 por 2 e tecle enter. Perceba que sua matriz passou 
a ter apenas duas colunas. Altere o nome das etiquetas das colunas. 
Substitua o nome “Carlos” na etiqueta da primeira coluna por “Sexo” e o 
nome “Bob” na etiqueta da segunda coluna por “Time”. Vamos utilizar 1 
para o sexo feminino e 2 para o sexo masculino. Utilize 1 para torcedores 
do Cruzeiro (Carlos, Bob, Mayra, Elder, Mel e Thais), 2 para torcedores 
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do Atlético-MG (Leo e Clara) e 3 para torcedores do América-MG (Luiz e 
Maria). Ao final do processo, sua tela deverá estar igual à representada 
na Figura73.

Figura 73 – Matriz de atributos da rede de conselho

  Sexo Time

Carlos 2 1

Bob 2 1

Luiz 2 3

Maria 1 3

Clara 1 2

Mayra 1 1

Elder 2 1

Mel 1 1

Thais 1 1

Leo 2 2

Fonte: Elaboração própria no Ucinet. Dados fictícios.

Chegou o momento de salvar seu trabalho, mas atenção! Estamos 
construindo a matriz de atributos a partir da matriz de adjacência da rede 
que contém nossas informações relacionais. Logo, é necessário utilizar 
a opção “salvar como” para não perder a matriz de adjacência. Siga o 
caminho:

File > Save as

Escolha um nome, feche o editor de matriz e abra o NetDraw. Para 
representar os atributos, abra a rede de conselhos que criamos e execute 
o seguinte caminho para abrir as informações sobre os atributos: 

File > Open > Ucinet dataset > Attribute data

Para visualizar os atributos no sociograma, você deve trabalhar com 
as opções do menu Properties. Para mudar as cores, siga o caminho:

Properties > Nodes > Symbols > Color > Attribute based
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Na caixa de diálogo, selecione o atributo time e escolha cores 
diferentes para representar os times de futebol: Cinza = Cruzeiro; Preto = 
Atlético-MG; Branco = América-MG. Confirme as alterações clicando em 
ü  e feche a caixa de diálogo.

Para alterar a forma dos nodos, execute o caminho: 

Properties > Nodes > Symbols >Shape > Attribute based

Escolha formas distintas para representar o sexo: círculo para o 
sexo feminino e quadrado para o sexo masculino. Confirme as alterações 
clicando em ü e feche a caixa de diálogo. A Figura 74 mostra a rede com 
os atributos.

Figura 74  – Rede de conselhos, sexo e time favorito

Fonte: Elaboração própria. Software Netdraw.

7.2.6 Medidas de centralidade no Ucinet

Você pode calcular as medidas de centralidade que já discutimos 
e que ainda discutiremos neste livro utilizando a calculadora do Ucinet. 
Os resultados são emitidos em dois tipos de arquivos: um “.txt”, aberto 
automaticamente, e os arquivos “gêmeos” (“.##d” e “.##h”), que podem 
ser abertos no editor de matrizes. Os primeiros arquivos não são salvos 
no computador, mas os segundos são guardados no diretório ativo. 
Os resultados registrados nos arquivos do Ucinet são úteis para copiar 
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os valores para outros softwares, tais como Excel, spss, Word etc. Para 
calcular as centralidades, execute o caminho a seguir conforme a opção 
que deseja:

Network > Centrality and Power > Degree... / Eigenvector / Closeness /
Freeman Betweenness

As centralidades podem ser calculadas também diretamente 
do NetDraw. Essa opção é util para quando desejamos representar as 
centralidades no sociograma. Para calcular as medidas de centralidade no 
NetDraw, execute:

Analysis > Centrality measures

Na caixa de diálogo, marque as centralidades que deseja calcular, 
escolha a direção dos laços conforme a natureza da rede (se orientada ou 
não orientada) e clique em ok. Para representar as centralidades na rede, 
execute o caminho:

Properties > Nodes > Symbols > Size > Attribute-based

Na caixa de diálogo, escolha a centralidade que deseja representar. 
No sociograma a seguir, representamos a centralidade de intermediação 
na rede de conselhos:

Figura 75 – Rede de conselhos, sexo, time favorito e centralidade de 
intermediação

Fonte: Elaboração própria. Software Netdraw.
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7.2.7 Importar / Exportar redes entre os softwares Pajek e Ucinet

Defendemos neste manual o uso dos programas numa perspectiva 
complementar e não alternativa. Entretanto, vimos que o processo 
de organização e introdução de dados nos dois softwares é bastante 
trabalhoso. Seria desanimador repetir o processo de entrada de dados 
nos dois programas. Para não duplicar nosso trabalho, nós podemos 
utilizar uma função do Ucinet para importar dados organizados no Pajek 
ou exportar para o Pajek dados organizados no Ucinet. Nas duas últimas 
seções deste exercício vamos aprender as duas funções.

7.2.8 Como importar uma rede criada no Pajek para o Ucinet

Para importar os dados de uma rede criada no Pajek através do 
Ucinet, execute o caminho:

Data > Import text file > Pajek

A tela de Import Pajek Net Files será aberta. Na caixa diálogo Input 
Pajek file, clique no botão Browser File ( ) e procure o arquivo com as 
informações da rede que foi criada no Pajek. Clique em ok. 

Os arquivos do Ucinet com informações da rede importada foram 
salvos no diretório ativo. Você pode visualizá-la diretamente na pasta e 
verificar o resultado de seu trabalho visualizando a rede no NetDraw ou 
no editor de matriz, conforme aprendemos acima.

7.2.9 Como exportar uma rede criada no Ucinet para o Pajek

O processo para exportar uma rede criada no Ucinet para o Pajek é 
similar. Execute o caminho: 

Data > Export > Pajek > Network

Note que é possível exportar as informações sobre atributos 
categóricos (o que, no Pajek, corresponde às Partições) escolhendo 
a opção Categorical Attribute. Também é possível exportar atributos 
quantitativos (chamados de vetores no Pajek) clicando em Quantitative 
Attribute. 
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Na caixa de diálogo (Input) – Network dataset, clique no botão 
Browser File ( ) e procure o arquivo com os dados que você quer 
exportar para o Pajek. Clique em ok. A tela Launch Pajek Program será 
aberta. Certifique-se de que a localização do Pajek está correta na caixa de 
diálogo Location of Pajek program e clique em ok. O arquivo com os dados 
preparado para o Pajek será salvo no diretório ativo.
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Capítulo 6 – Nuances do poder: outras 
medidas de centralidade

Este artigo analisa uma resolução histórica desta contradição na 
construção do Estado: a tomada do poder, no começo do século 
XV, por parte de Cosimo de Medici na Florença renascentista. 
Focamos basicamente a análise da estrutura e da emergência 
sequencial das redes de casamento, econômicas e de domínio 
que constituíram o partido dos Medici, usado por Cosimo, em 
1434, para controlar o embrionário Estado Florentino (Padgett; 
Ansell, 1993).

1.Centralidade de proximidade (Closeness)

Analisamos antes a centralidade dos nodos e dos grafos do 
ponto de vista do que poderíamos chamar o “centro gravitacional”. Isto 
é, perguntamos se há um nó, ou vários, com a capacidade de puxar as 
relações ou de ser um centro de influxo para os outros nodos. 

Porém, a centralidade admite uma segunda perspectiva. Pode um 
agente interagir de forma rápida com outros? Está próximo dos outros? 
Em processos de difusão de informação esse fator é importante. 

Hakimi (1965) e Sabidussi (1966), apud Wasserman e Faust (1994), 
definiram que os nós centrais possuem caminhos curtos quando se 
relacionam com seus alters. Assim, a proximidade é outra forma de aferir 
a centralidade, entendida desta vez como capacidade de influência. Para 
tanto, é preciso identificar a distância mínima com a qual um agente 
atinge o maior número de seus pares numa estrutura em rede. 

 Observemos o grafo seguinte e sua respectiva matriz de adjacência 
(Wasserman; Faust, 1994):
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Figura 76 – Centralidade de proximidade (grafo tipo)

Tabela 13 – Matriz de adjacência do grafo que aparece na Figura 76

a b c d e f 
a 0 1 1 1 0 0 
b 1 0 0 1 0 1 
c 1 0 0 1 1 0 
d 1 1 1 0 1 0 
e 0 0 1 1 0 1 
f 0 1 0 0 1 0 

Fonte: Elaboração a patir de Wasserman e Faust, 1994

1.1 Qual é o nodo de maior centralidade?  Por quê? 

Vamos contar as geodésicas de cada nodo (Atenção: não é a matriz 
de distâncias geodésicas!!!). O leitor deve ser consciente de que se trata 
de um caso simplificado para efeitos da demonstração de um conceito, 
em que as geodésicas são de tamanho d=1. 

Tabela  14 – Número de geodésicas no grafo da Figura 76

a 3 

b 3 

c 3 

d 4 

e 3 

f 2 
Fonte: Elaborado a partir de Wasserman e Faust, 1994
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Se aplicarmos o conceito de grau nodal, resulta óbvio que d é o 
ator de maior centralidade. Porém, aqui há algo contraintuitivo, porque 
d, apesar de ter quatro geodésicas, não concentra todas as vantagens na 
estrutura. Por exemplo, o ator f não é atingido diretamente por d, o que, 
do ponto de vista do controle, é uma vantagem frente aos outros nodos. 
Ao mesmo tempo, f possui duas geodésicas para atingir seus colegas, o 
que demonstra seu entrosamento na rede, pois não depende de um único 
nó. Sendo assim, f possui uma dupla vantagem, pode atingir rápido e está 
longe daquele que mais pode atingir. Essa nuance é captada pelo índice 
de centralidade de proximidade ou closeness. A sua fórmula de cálculo é 
a seguinte:

O algoritmo anterior indica o inverso da soma das distâncias 
geodésicas aos outros nodos.

Tabela  15 – Centralidade closeness no grafo da Figura 76

a 3 1/3= 0,33 

b 3 1/3 = 0,33 

c 3 1/3= 0,33 

d 4 1/4=0,25 

e 3 1/3= 0,33 

f 2 1/2 = 0,50 
Fonte: elaborado a partir de Wasserman e Faust, 1994

2. Centralidade de intermediação (Betweenness)

Outra perspectiva da centralidade destaca que as interações 
entre atores não adjacentes podem depender de atores intermediários. 
Intermediar é uma forma de poder dentro de uma rede, pois outorga a 
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capacidade de facilitar ou obstruir, de forma seletiva, fluxos de informação 
ou de recursos que circulam por uma estrutura reticular.  

Observemos o seguinte grafo: 

Figura 77 – Centralidade de intermediação (grafo tipo)

Fonte: Elaboração própria

Qual é o nodo com maior poder de intermediação? À diferença da 
centralidade de grau, esse tipo de propriedade é mais difícil de captar 
por simples inspeção visual. Uma forma técnica para discernir o poder 
de intermediação consiste em identificar quantas geodésicas passam por 
um determinado nó. No grafo anterior, Z é o intermediário que controla o 
maior número de distâncias geodésicas. De fato, intermedia entre d(S,E)= 
2; d(S,T)=2; d(S,P)=2.

Esse tipo de centralidade é aceito pelos sociômetras com algumas 
ressalvas (Wasserman; Faust, 1994). Dado que estamos analisando dados 
interdependentes, não é realista assumir a suposição, bastante discutível, 
de que todas as geodésicas, entre quaisquer nodos k e j, que passam por 
i, são equiprováveis. De fato, o mesmo pode ser questionado de todas as 
medidas de centralidade até agora estudadas. A solução para esse tipo de 
questionamento precisou esperar até meados dos anos oitenta, quando 
os matemáticos e estatísticos desenvolveram modelos probabilísticos 
mais sofisticados com o intuito de estimar a formação de relações num 
processo social que se estrutura como uma rede. Os modelos mais 
avançados são conhecidos hoje como a família de Grafos Exponenciais 
Randômicos (Exponential Random Graphs, ERG). 
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Figura 78 – Z, o nó com maior grau de intermediação (grafo tipo)

Fonte: Elaboração própria

A fórmula de cálculo é:

A conta capta a proporção total de geodésicas entre j e k que 
passam por i.

3. Grau de prestígio

Numa estrutura em rede, uma diferença básica consiste em saber 
se um ator é muito procurado pelos seus pares ou se, pelo contrário, 
possui muita iniciativa na construção de suas relações.

Observemos a diferença entre os nodos 1 e 6: 

Figura 79 – Grau de prestígio

Fonte: Elaboração própria

O indicador de prestígio é o indegree 
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O indegree de um nodo é o número de arcos que terminam em ni.  
A notação é

  O outdegree de um nodo é o número de arcos que se originam 
em ni 

4. Prestígio de proximidade (Reach centrality)

Outra forma de reconhecer o poder de um ator consiste em determinar 
seu raio de influência. Isto é, seu domínio de influência.  Observemos a 
Figura 80; quantos nodos direta e indiretamente 1 e 7 atingem?

4.1 Domínio de influência I i 

Número de atores ligados direta ou indiretamente a i. Âmbito para 
atingir e ser atingido. 

Figura 80 – Prestígio de proximidade

Fonte: Elaboração própria

O seguinte indicador permite calcular a proximidade no domínio de 
influência, consistindo na razão entre:
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Proporção de atores que podem ser atingidos por i dividido pela 
média das distâncias no domínio de influência de i.

Varia de 0, nenhuma proximidade ao conjunto de atores, até 1, 
plena adjacência. O índice de proximidade do nó 1 no grafo anterior é:

Pp  (n1) = 0,51     

5. Status ou ranking de prestígio: o poderoso entre os 
poderosos

Em estrito sentido sociológico, as medidas de centralidade 
anteriores não entregam um comparativo real do poder dentro de uma 
rede social. Isto é, de um ponto de vista relacional, os agentes ganham 
poder na medida em que são reconhecidos ou procurados por outros 
agentes; ter poder é usufruir de uma posição de reconhecimento como 
alguém importante. Nesse fato se sustentam as ideias clássicas de Max 
Weber sobre o poder e o status. Assim, o poder em sentido weberiano 
é a capacidade de influir na vontade alheia, enquanto que o status é o 
reconhecimento recebido em virtude do nível educativo daquele que é 
tido como importante.  

De que forma os analistas de redes conseguiram mensurar o 
status de um agente para logo construir o ranking comparativo de toda 
uma rede?  A resposta envolve a solução de um problema nada trivial. 
Observemos na Figura 81 o grafo das famílias florentinas, correspondente 
à clássica pesquisa de Padgett (1993).

O dígrafo representa, pelo tamanho dos nodos, a centralidade in-
degree das famílias florentinas em suas trocas matrimoniais. Note-se 
que os Médici e os Strozzi aparecem adjacentes a outras famílias que, 
por sua vez, possuem scores importantes de centralidade. Os analistas 
de redes descobriram que um verdadeiro ranking de popularidade devia 
levar em conta se nodos muito populares eram escolhidos por nodos 
também populares. Não é igual receber um elogio de alguém socialmente 
relevante e de alguém considerado como inferior. Agora, a mensuração 
desse fato choca com a natureza interdependente das observações, pois 
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os Médici são importantes porque são escolhidos pelos Ridolfi, também 
importantes, os quais, por sua vez, são escolhidos pelos Strozzi, e estes 
são escolhidos pelos Ridolfi, também escolhidos pelos Médici, o que 
conduz a uma circularidade sem fim. Quem é a fonte de reconhecimento 
para quem?

Figura 81 – Grafo das famílias florentinas

Fonte: Elaboração própria com Ucinet 6 (Borgatti et al. 2002)

Wasserman e Faust (1994) explicam que os matemáticos, para 
solucionar esse problema de regressão infinita, postularam que o ranking 
de um agente qualquer é uma função dos rankings de todos seus alters:

 
Isso significa que todas as colunas de uma matriz, as quais indicam 

as escolhas dos alters para qualquer ego, permitem computar o ranking 
de qualquer agente, ao multiplicar as entradas da iésima coluna pelo 
ranking do ator respectivo da coluna i. 

Se tomarmos uma sociomatriz X e colocarmos o conjunto dos 
índices do ranking num vetor: 

Podemos escrever este sistema de equações como: 
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X’ é uma magnitude conhecida como eigenvalue (valor próprio 
ou idiossincrático), constitui um multiplicador constante da matriz 
original, o qual altera proporcionalmente todos os vértices da matriz. 
Essa magnitude constante, para o caso do ranking de prestígio, permite 
solucionar o problema da circularidade ou regressão infinita, pois, ao 
padronizar todos os valores das colunas, o eigenvalue será igual a 1, o 
que constitui um ponto de referência constante para todos os índices 
de prestígio na matriz (Katz, 1953 apud Wasserman; Faust, 1994). Esse 
vetor resultante, conhecido também como eigenvector, se expressa da 
seguinte forma:

6. Exercícios

A partir deste capítulo vamos trabalhar com a rede dos 20 clubes da 
1ª divisão do campeonato brasileiro em 2017 cujas relações representam as 
transferências de jogadores neste ano. Os dados que utilizamos podem ser 
acessados nos seguintes sites: www.futebol365.pt ou www.giars.ufmg.br.

Elaboramos o dígrafo da rede (Figura 82) utilizando o software Pajek. 
Na figura o tamanho e a forma dos nodos representam a movimentação 
de jogadores entre os clubes, conforme o quadro abaixo:

O inDegree refere-se ao número de clubes que transferiram 
jogadores para o clube ego. Por sua vez, o outDegree mostra para quantos 
clubes o clube ego cedeu jogadores. Para que todos os nodos ficassem 
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visível na figura somamos 1 aos indicadores de grau nodal apenas para 
construir a representação por meio do dígrafo.

Note que o tamanho e o formato dos nodos da rede se referem às 
relações entre os clubes e não à quantidade de jogadores transferidos. 
A quantidade de jogadores que um clube enviou ou recebeu de outro 
clube esta representada pela espessura das linhas. A posição dos nodos 
no dígrafo foi organizada segundo o algoritimo Kamada-Kawai.

Embora a rede seja valorada (o número de jogadores transferidos 
varia entre os pares de clubes), para os exercícios a seguir transformamos 
os dados em uma rede binária, isto é, consideramos apenas se houve ou 
não uma transferência.

Figura 82 – Rede de tranferências de jogadores realizadas em 2017 entre 
os 20 clubes da 1ª divisão do campeonato brasileiro de futebol.

Fonte: Elaboração própria. 

1) Vamos começar observando a rede de transferências de 
jogadores entre os 20 clubes da 1ª divisão (Figura 82). Nesta rede há 4 
path de tamanho 6 que representam o diâmetro da rede, por exemplo:  
d(Flamengo, Chapecoense = 6). Indique abaixo os 5 clubes do path que 
liga o Flamengo à Chapecoense.

Flamengo; __________; ___________; __________; __________; 
___________; Chapecoense
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2) Qual é o tamanho da distância inversa? Isto é: qual é o caminho 
da Chapecoense até o Flamengo?

3) Identifique na rede os 4 clubes que não podem ser alcançados 
por nenhum outro.

1. ___________; 2. ___________; 3. ___________; 4. ___________.

4) Na rede representada acima foram observados 41 laços 
direcionados entre os 20 clubes da 1ª divisão. Com base nesta informação 
pede-se que você:

a. calcule a densidade (Δ) da rede.
b. Interprete o resultado. O que o valor da densidade sugere?
5) A Tabela 16 mostra os graus de centralidades indegree e 

outedegree dos clubes da 1ª divisão do campeonato brasileiro em 2017 
na rede de transferências de jogadores. Analise a tabela e aponte os 
clubes que apresentaram um comportamento ativo no mercado brasileiro 
da 1ª divisão? Isto é, quais times foram os principais compradores e os 
principais fornecedores nas transferências de jogadores entre a elite do 
futebol brasileiro em 2017?

Tabela 16 – Centralidades indegree e outdegree 

Clubes Indegree Outdegree Clubes Indegree Outdegree

Cruzeiro 0,000 31,579 Vitória 36,842 0,000

Flamengo 0,000 15,789 Atlético-GO 10,526 5,263

Vasco 0,000 5,263 Atlético-MG 5,263 10,526

Palmeiras 10,526 31,579 Coritiba 15,789 10,526

São Paulo 15,789 15,789 Botafogo 5,263 5,263

Sport 0,000 5,263 Chapecoense 21,053 0,000

Atlético-PR 15,789 15,789 Ponte Preta 10,526 0,000

Grêmio 15,789 21,053 Santos 5,263 5,263

Fluminense 10,526 10,526 Corinthians 5,263 26,316

Bahia 21,053 0,000 Avaí 10,526 0,000

Fonte: Elaboração própria. Software Ucinet.
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6) Os seguintes graus de centralização da rede foram observados: 
indegree: 28,95% e outedegree: 23,10%. Explique o que estas medidas 
sugerem em relação à estrutura da rede?

7) A Tabela 17 mostra as centralidades de proximidade de entrada 
e de saída dos clubes da 1ª divisão do campeonato brasileiro em 2017 
na rede de transferências de jogadores. Analise a tabela e identifique os 
clubes que são alcançados facilmente e aqueles que alcançam mais rápido 
outros clubes da rede. 

Tabela 17 – Centralidades de proximidade de entrada e de saída

Clubes Proximidade 
input

Proximidade 
output Clubes Proximidade 

input
Proximidade 

output

Cruzeiro 5,000 20,000 Vitória 15,447 5,000

Flamengo 5,000 14,729 Atlético-GO 10,270 6,149

Vasco 5,000 15,447 Atlético-MG 8,796 13,475

Palmeiras 9,135 14,844 Coritiba 9,406 13,571

São Paulo 9,179 14,286 Botafogo 5,263 14,394

Sport 5,000 5,263 Chapecoense 15,574 5,000

Atlético-PR 9,179 13,869 Ponte Preta 10,160 5,000

Grêmio 9,548 14,074 Santos 10,734 5,846

Fluminense 11,950 5,556 Corinthians 9,048 14,729

Bahia 10,615 5,000 Avaí 9,645 5,000

Fonte: Elaboração própria. Software Ucinet.

8) Compare as centralidades de proximidade com os graus nodais 
dos atores na rede. Quais são os cinco clubes mais centrais sob cada 
critério? Há alguma mudança nas cinco primeiras posições quando 
consideramos critérios de centralidade diferentes?

9) A Tabela 18 mostra o grau de intermediação dos clubes da 1ª divisão 
do campeonato brasileiro em 2017 na rede de transferências de jogadores. 
Analise a tabela e identifique os principais intermediadores da rede.
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Tabela 18 – Grau de intermediação 

Clubes Grau de 
intermediação Clubes Grau de 

intermediação
Cruzeiro 0,000 Vitória 0,000

Flamengo 0,000 Atlético-GO 4,532

Vasco 0,000 Atlético-MG 2,315

Palmeiras 0,108 Coritiba 12,865

São Paulo 13,889 Botafogo 0,000

Sport 0,000 Chapecoense 0,000

Atlético-PR 8,090 Ponte Preta 0,000

Grêmio 9,625 Santos 2,193

Fluminense 1,462 Corinthians 13,158

Bahia 0,000 Avaí 0,000
Fonte: Elaboração própria. Software Ucinet.

10) Na rede foi observado um grau de centralização de intermediação 
de 10,46%. O que podemos afirmar com base nessa informação?

11) A Tabela 19 mostra o grau de centralidade eigenvector dos clubes 
da 1ª divisão do campeonato brasileiro em 2017 na rede de transferências 
de jogadores. Analise a tabela e identifique os cinco principais atores sob 
esse critério.

Tabela 19 –  Grau de centralidade eigenvector

Clubes Eigenvector Clubes Eigenvector
Cruzeiro 53,884 Vitória 48,101

Flamengo 19.193 Atlético-GO 18,849

Vasco 10,291 Atlético-MG 25,740

Palmeiras 53,152 Coritiba 37,714

São Paulo 45,987 Botafogo 14,528

Sport 4,471 Chapecoense 23,090

Atlético-PR 39,151 Ponte Preta 13,312

Grêmio 49,561 Santos 8,635

Fluminense 25,748 Corinthians 38,852

Bahia 34,020 Avaí 14,470

Fonte: Elaboração própria. Software Ucinet.



160

Análise de redes em Ciências Sociais

12) Inclua as centralidades de intermediação e de eigenvector na 
comparação realizada anteriormente. O que alterou quando comparamos 
as cinco primeiras posições sob cada critério?

13) A Tabela 20 mostra o tamanho dos domínios de influência 
(input e output) dos nodos de nossa rede. Quais são os clubes com menor 
capacidade de influência? Explique o que essa condição significa.

Tabela 20 – Domínios de influência (input e output)

Clubes Domínio 
input

Domínio 
output

Clubes Domínio 
input

Domínio 
output

Cruzeiro 0 16 Vitória 14 0
Flamengo 0 15 Atlético-GO 11 4
Vasco 0 15 Atlético-MG 10 14
Palmeiras 10 14 Coritiba 10 14
São Paulo 10 14 Botafogo 1 15
Sport 0 1 Chapecoense 15 0
Atlético-PR 10 14 Ponte Preta 11 0
Grêmio 10 14 Santos 12 3
Fluminense 13 2 Corinthians 10 14
Bahia 11 0 Avaí 11 0

Fonte: Elaboração própria. Software Pajek.

14) O dígrafo da rede que estamos analisando foi reorganizado 
para mostrar os domínios de influência outdegree dos clubes mineiros 
Cruzeiro e Atlético no ano de 2017 (Quadro 6). Quais diferenças podemos 
destacar entre os dois clubes ao compararmos seus domínios de influência 
outdegree?
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Quadro 6 – Domínios de influência de Cruzeiro e Atlético-MG

Fonte: Elaboração própria. Software Pajek.
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Capítulo 7 – Análise de subgrupos

Durante os últimos trinta anos, a investigação social empírica 
tem sido dominada pela pesquisa por amostragem tipo survey. 
Mas tal e como é praticado de ordinário, utilizando amostragens 
aleatórias de indivíduos, o survey é uma máquina sociológica de 
amassar carne, tirando os indivíduos de seu contexto social e 
garantindo que ninguém no fenômeno estudado interaja com os 
demais (Allen Barton, 1968 apud  Freeman, 2004).

1. Identificação de subgrupos ou cliques

Se a densidade fala da coesão num sentido global, outro aspecto 
importante, ao analisar uma rede social, consiste na identificação de 
setores de uma rede com maior entrosamento relacional. Nessas áreas 
diferenciadas, a dinâmica do processo social conduz à formação de 
subgrupos.

Porém, devemos tomar cuidado com as palavras, pois, nesse caso, 
um grupo não é uma associação de pessoas que se identificam entre si por 
algum critério explícito de pertencimento ou que seja reconhecida como 
tal por observadores externos. Não estamos falando, por exemplo, de 
uma gangue ou de clube de aficionados por xadrez. Quando identificamos 
subgrupos, dentro de uma rede social, talvez os próprios membros não 
sejam conscientes dessa condição. Isto é, um subgrupo, entendido como 
um setor denso dentro de uma rede, pode ou não coincidir com um grupo 
primário em sentido sociológico. 

Wassermann e Faust (1994) resumem quatro propriedades básicas 
de um subgrupo dentro de um domínio em rede:

(1)  mutualidade dos laços;
(2) proximidade ou atingibilidade dos membros do subgrupo;
(3) frequência dos laços entre os membros;
(4) frequência relativa de laços entre membros e não membros. 
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A propriedade básica da coesão de um subgrupo é chamada pelos 
sociômetras norteamericanos de “cliquish soubgroup”. Isto é, um conjunto 
de agentes com relações de mutualidade que demonstram um padrão 
de preferências relacionais ao interior do subgrupo em detrimento das 
relações com agentes externos. Neste trabalho adotamos o anglicismo 
clique, traduzível como panelinha, para expor os critérios técnicos de 
análise.

Um clique se define como um subgrupo de três ou mais nodos, no 
qual todos são adjacentes entre si, sem que exista outro nodo que seja 
adjacente a todos os membros do subgrupo. É importante destacar que o 
caráter restritivo do conceito de clique torna homogêneos seus membros 
em termos de suas propriedades de centralidade. 

Observemos o grafo seguinte:

Figura 83 – Vários tipos de cliques

Fonte: Elaborado a partir de Wasserman e Faust, 1994

Ao levarmos em conta o critério anterior, plena mutualidade das 
relações ou adjacência com todos os membros, encontramos que há três 
subgrupos ou cliques:

{1,2,3}, {1,3,5} e {3,4,5,6}

2. Coesão: baseada em atingibilidade de diâmetro ou n-clique

Podemos encontrar subgrupos que não se identificam a partir 
da adjacência total, mas sim pelo fato de que suas distâncias são 
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relativamente curtas. Dessa forma, é possível definir parâmetros de corte 
para identificar cliques com geodésicas de n tamanho.

Figura  84 – n-clique 

Fonte: Elaborado a partir de Wasserman e Faust, 1994

Um n-clique é um subgrupo no qual a mais longa geodésica entre 
dois nodos não é maior que n. Formalmente, um n-clique é um subgrafo 
com um conjunto de nós Ns. A sua notação é a seguinte:

d (i,j) ≤ n para todo ni , nj  Є Ns 
Conforme a Figura 84, temos um clique cuja distância máxima entre 

os membros é de tamanho n=1 e dois cliques cuja distância máxima é de 
tamanho n=2.

1- clique: {1,2,3}
2- clique: {1,2,3,4,5} e {2,3,4,5,6}

3.  n- Clã

O critério do diâmetro pode colocar problemas na identificação dos 
cliques. Observemos novamente o grafo que foi utilizado anteriormente 
para demonstrar o conceito de n-clique: 
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Figura 85 – n-Clã 

Fonte: Elaborado a partir de Wasserman e Faust, 1994

Desta vez destacamos, em elipses pontilhadas e no círculo cinza, o 
fato de que, no clique de tamanho 2, conformado pelos nós {2,3,4,5,}, há 
uma situação anômala: a distância de tamanho d= 3 entre os nós 4 e 5, 
pois para estes cumprirem com a condição de sua máxima distância n=2, 
devem conectar-se através do nó 6, sendo que este não faz parte, em 
estrito sentido, do clique identificado.  

Para superar esse problema, cria-se uma restrição mais severa 
chamada de n-clã. Este se define como um clique em que as geodésicas 
entre os nós não ultrapassam a distância n definida pelo observador. 

A sua notação é a seguinte:
d (i,j) ≤ n para todo ni, nj  Є NS 

Como podemos ver, o n-clã torna restritiva a máxima distância ao 
definir que essa condição vale para todos e cada um dos membros do 
subgrupo. 

4. Coesão baseada no grau nodal

Outra perspectiva, para enxergar um subgrupo numa rede, consiste 
em perguntar pela sua robusteza como subgrupo. Nem sempre a fortaleza 
de um grupo reside em que todos os atores estejam conectados entre si. 
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Uma forma negativa de definir a fortaleza de um subgrupo consiste em 
afirmar que não seja vulnerável. 

Observemos a Figura 86; qual é a debilidade deste subgrupo?

Figura 86 – k-plexo

Há duas formas de identificar a robusteza de um subgrupo:
(1) Determinando quantos laços adjacentes, dos possíveis, podem 

faltar para cada nó. Nesse caso, fala-se de um k-plexo.  
(2) Determinando quantos laços adjacentes deve ter um nodo. 

Nesse caso, fala-se de um k-nodo. 
No grafo anterior, para cada nó faltam três arcos, isto é, está 

presente o número de arcos mínimos para a existência do subgrupo.
•	 Faltam os arcos reflexivos de cada nó (nesse caso, os manuais 

de sociometria incluem o loop ou autorrelação).
•	 Para cada nó, faltam dois arcos de adjacência com cada um de 

seus alters.

•	 Neste caso, fala-se de um k-plexo de grau k=3; este coincide 
com o número total de arcos possíveis por nó (g – 1). Isto é, 
num nível a mais k=4, o grafo ficaria desconexo, todos os nós 
estariam isolados.  

5. Exercícios

1) Examine as Figuras 87 e 88  e circule subgrupos com base nos 
setores densos das redes.
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Figura 87 – Rede 1

Fonte: Elaboração Própria

Figura 88 – Rede 2

Fonte: Elaboração Própria

2) Examine a Figura 89 e identifique dois cliques de tamanho 4.
Clique 1 = {___, ___, ___, ___}; Clique 2 = {___, ___, ___, ___}

Figura 89 – Rede 3
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Capítulo 8 – Papéis e posições: 
equivalência estrutural – primeira parte 

1. Pressupostos teóricos

Talvez não exista outro conceito sociológico que tenha conquistado 
tanto o senso comum como o do papel social ou rôle, pela sua denominação 
original em língua francesa. Duas grandes vertentes da Sociologia 
contemporânea focaram no entendimento dos papéis sociais dos agentes 
como assunto crucial na explicação da vida coletiva. Por um lado, fica claro 
que devemos ao interacionismo simbólico a interpretação da ação social 
como um cenário onde cada um dos participantes assume parte de um 
roteiro que não está totalmente escrito de antemão. Foi Ervin Goffmann 
(1956) quem especificamente inspirou-se na crítica literária para analisar 
o agente social nos termos de um ator, como alguém que encarna uma 
personagem com obrigações e expectativas mútuas frente aos outros que 
tomam parte na cena. Esta é a abordagem do papel social do ponto de 
vista do agente ou a partir de seu horizonte interno. 

Por outro lado, devemos a Talcott Parsons a identificação do 
papel social com a função social. Porém, devemos salientar que, nesta 
perspectiva holística, a função não é um assunto do indivíduo, e sim do 
sistema como um todo. Segundo os pressupostos biológicos da teoria 
do sistema social, o papel social de pai, por exemplo, desempenhado 
pelo agente dentro do subsistema do parentesco, é a sua contribuição 
para o vigor e a reprodução da totalidade do organismo social. Nesse 
sentido, o agente executa uma pauta que ele não cria e da qual não é 
necessariamente consciente. Se, por exemplo, um médico – lembremos 
que Parsons começou a sua carreira como sociólogo pesquisando a vida 
profissional nas sociedades modernas – está obrigado a uma pauta de 
neutralidade afetiva com seus pacientes, isso é consequência de um novo 
arranjo na atividade curativa por oposição à medicina tradicional. Parsons 
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entendia que era consequência da aplicação racional do conhecimento 
científico caracterizado pela abstração e pelo universalismo de seus 
métodos e resultados.

No estrutural-funcionalismo, no qual também devemos destacar 
as contribuições de Robert K. Merton em sua análise sobre a anomia e 
as consequências não antecipadas da ação humana, o conceito de papel 
social é uma ferramenta-chave para analisar sistemas organizados. No 
papel social ou função encontram-se a estrutura e a ação. Em termos 
do velho problema sobre o que significa agir socialmente, se somos 
compelidos pela coletividade ou se temos margem de inovação ou 
manobra conforme nossas aspirações e desejos, o papel social seria a 
síntese entre o todo e a parte.

Figura 90 – Perspectiva funcionalista sobre o papel social

Fonte: Elaboração própria

O papel seria o lado visível de uma estrutura que põe em movimento 
agentes sociais. Por exemplo, numa organização militar, há uma estrutura 
hierárquica – cadeia de mando – que impõe papéis aos agentes 
individuais. Num sistema de parentesco, há atribuições diferenciadas. Em 
alguns sistemas matrilineares, o tio materno assume a tarefa de sustentar 
e educar os filhos do casamento. De forma análoga, e sob o risco da 
simplificação, podemos afirmar que o jogo de xadrez atribui papéis, ou 
funções, às peças dentro de sua estrutura. 
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Figura 91 – O xadrez atribui funções a cada uma das peças do tabuleiro
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Fonte: Digital commons.

Porém, devemos ser mais cautos e afirmar que, em sociologia, 
funcional é tudo aquilo que contribui à estabilidade e reprodução de um 
sistema social. A função é a pauta específica que comanda um elemento 
dentro de um sistema. Eis, em continuação, a famosa tabela de Parsons 
(1977) sobre as quatro funções básicas do sistema social. Conservamos 
as letras maiúsculas da nemotecnia original com que foi concebida em 
inglês: Adaptation, Goal Attainment, Lattent Pattern, Integration. 

Tabela 21 – Funções básicas do sistema social segundo Talcott Parsons 

A 
Adaptação
(Troca com o meio) 

G 
Realização de fins 
(Troca com o meio) 

L 
Identidade
Consistência com os valores 
(Atividade Interna)

I
Integração
Conformidade com as normas
(Atividade interna)

Fonte: Elaboração propria a partir de Parsons (1977)
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Para encerrar este curto prelúdio teórico, lembremos como Merton 
(1968) torna mais complexo o conceito de função social ao distinguir entre 
função manifesta e latente. Seu exemplo proverbial, a dança da chuva do 
povo aborígene Hopi, permite entender com clareza que um ritual gera 
efeitos não antevistos pelos próprios envolvidos. Para além de visar à 
queda da chuva, função manifesta, a comunidade participante sai mais 
coesa da prática ritual, função latente.   

2. Papel e posição na análise de redes

Cada uma das perspectivas acima expostas possui fortalezas e 
debilidades. No caso do interacionismo simbólico, é importante destacar 
que o estudo da ordem social sem levar em conta como os próprios 
agentes explicam e dão sentido ao que fazem em seus encontros sociais 
criaria uma Sociologia aleijada, sem discurso e significados. Essa senda da 
explicação endógena da estruturação social foi aprofundada por Harold 
Garfinkel (1984) no que hoje é conhecido como etnometodologia. No 
caso do estrutural-funcionalismo, é louvável a interpretação sistêmica de 
como podem ser consistentes as ações das pessoas num determinado 
contexto. Porém, há algo que não conseguem explicar tanto as sociologias 
do sentido quanto as sociologias do sistema, os mecanismos específicos 
que dão origem aos papéis sociais. A primeira abordagem peca por um 
excessivo casuísmo contextual, e a segunda, por um forte apriorismo 
sobre o que são os papéis executados pelos agentes. Lembremos que 
Parsons (1977) definia nove pautas funcionais do papel social. Mas por 
que são essas e não outras? Não sabemos. 

Por fortuna, novos avanços foram feitos na Sociologia neoestrutural. 
White, Boorman e Breiger (1976) contribuíram ao entendimento da 
formação endógena de papéis sociais dentro de uma estrutura em rede. 
Usando um símil, podemos afirmar que criaram um telescópio Hubble 
para observar a consolidação de papéis dentro de um sistema social.  

Em termos de análise de redes sociais, distingue-se entre papéis 
e posições. A posição está referida ao conjunto de indivíduos que estão 
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imbricados de forma similar em redes de relações. Já o papel ou rol está 
referido a padrões de relações entre atores ou entre posições.

A análise de papéis e posições em estruturas em rede está 
sustentada na ideia de que ambas as propriedades, das quais participam 
os agentes do sistema, podem ser identificadas a partir da mensuração 
das relações.

Figura 92 – Dupla tarefa da análise de redes

Fonte: Elaboração própria 

3. Análise de posições

Tudo o que foi analisado até aqui, em termos da descrição de 
um grafo ou de uma estrutura reticular, pode ser chamado de estudo 
de superfície. Partimos agora para uma análise de estruturas de maior 
complexidade, mas que estão subjacentes nos dados. Isso significa que 
não podem ser reconhecidas a olho nu. 

Há consenso entre os pesquisadores de redes sociais no sentido 
de que a similaridade estrutural dos atores é uma das mais importantes 
propriedades da análise de redes sociais. Observemos o seguinte dígrafo 
explicativo proposto por Wasserman e Faust (1994):
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Figura 93 – Equivalência estrutural

1 2 3 4 5

1 - 0 1 1 0

2 0 - 1 1 0

3 0 0 - 0 1

4 0 0 0 - 1

5 0 0 0 0 -

Fonte: Elaboração a partir de Wasserman e Faust (1994)	

O que há de comum entre os nós que aparecem identificados pelas 
elipses e o círculo? 

Neste exemplo, há B= 3 subconjuntos de posições:
B1 = {1,2} , B2 = {3,4}, e B3 = {5}.  Por que o nodo 5 é considerado uma 

posição estrutural?
O leitor deverá estar atento para o fato de que os nós identificados 

na mesma posição, apesar de não estarem em contato entre si, possuem 
semelhanças em suas relações com os nós de outras posições. Observe 
novamente e leia a definição intuitiva. 

Figura 94 – Equivalência estrutural – definição intuitiva

Definição intuitiva
Atores estruturalmente 

equivalentes possuem relações 
idênticas em direção a e 

procedentes de idênticos atores.

Fonte: Elaboração própria a partir de Wasserman e Faust, (1994)
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Os nós 1 e 2, por exemplo, possuem em comum o fato de ter como 
alters exatamente os mesmos nós, 3 e 4. Por sua vez, 3 e 4 recebem 
relações dos mesmos alters, 1 e 2. O nó 5 é único no grafo, pois recebe 
relações simultaneamente de 3 e 4. Agora já estamos em condições de 
apresentar a definição formal.

3.1 Definição formal

Os atores i e j são estruturalmente equivalentes se Xikr = Xjkr e Xikr = 
Xjkr para k= 1,2...,g, e r=1,2...,R. Emprega-se a notação para indicar a 
equivalência estrutural dos atores i e j.

Esta definição é uma situação pura ou tipo, dificilmente na realidade 
há atores dentro de redes com um perfil relacional exatamente igual. 
Emprega-se o termo "classe equivalente" ou "posição" para referir-se a 
um conjunto de atores equivalentes ou aproximadamente equivalentes.

Figura 95 – Equivalência estrutural  – Correspondência entre o grafo e a 
matriz de adjacência

1 2 3 4 5

1 - 0 1 1 0

2 0 - 1 1 0

3 0 0 - 0 1

4 0 0 0 - 1

5 0 0 0 0 -

Note-se que para os 
atores 1 e 2, 3 e 4 , as 
linhas e colunas são 
iguais.

3.2 Notação da posição

A posição se expressa como Bk e se expressa como B o número de 
posições dentro da rede. Emprega-se f(i) = Bk para expressar a colocação 
do autor i na posição Bk. Se os atores são estruturalmete equivalentes 
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, então estão colocados na mesma posição. Se , então f (i) = f 
(j) = Bk.

Em síntese, se dois nós são estruturalmente equivalentes, então se 
consideram substituíveis. Não há perda de informação ao combinar dois 
ou mais atores estruturalmente equivalentes dentro de um subconjunto. 
Podemos representá-los como uma entidade simples chamada de posição 
ou classe equivalente. Em continuação, explicaremos essa vantagem. 

3.3 Vantagens da análise posicional

Um dos principais objetivos da análise posicional consiste em 
simplificar a informação de um conjunto de dados em rede. Essa 
simplificação procede a partir da representação da rede em termos de 
posições identificadas com base numa definição de equivalência. Após 
identificar as posições estruturalmente equivalentes, podemos apreciar 
melhor o padrão de relações entre as posições, isto é, as suas funções 
dentro do sistema. 

Observando a matriz de adjacência seguinte e seu dígrafo respectivo, 
é possível identificar regularidades?

Figura 96 – Análise posicional

1 2 3 4 5 6 7 8 9

1 - 0 0 1 0 0 0 0 1

2 0 - 0 0 1 0 1 0 0

3 0 1 - 0 1 1 1 1 0

4 1 0 0 - 0 0 0 0 1

5 0 1 0 0 - 0 1 0 0

6 0 1 1 0 1 - 1 1 0

7 0 1 0 0 1 0 - 0 0

8 0 1 1 0 1 1 1 - 0

9 1 0 0 1 0 0 0 0 -

Fonte: Elaborado a partir de Wasserman e Faust (1994)
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À primeira vista, fica difícil visualizar se na matriz de adjacência há 
algum tipo de regularidade. Pelo procedimento de permuta, podemos 
entender melhor a correspondência entre a matriz e o grafo. 

Tabela 22 – Matriz permutada para análise posicional

6 3 8 1 4 9 2 5 7 

6 - 1 1 0 0 0 1 1 1 

3 1 - 1 0 0 0 1 1 1 

8 1 1 - 0 0 0 1 1 1 

1 0 0 0 - 1 1 0 0 0 

4 0 0 0 1 - 1 0 0 0 

9 0 0 0 1 1 - 0 0 0 

2 0 0 0 0 0 0 - 1 1 

5 0 0 0 0 0 0 1 - 1 

7 0 0 0 0 0 0 1 1 - 
Fonte: Elaboração a partir de Wasserman e Faust (1994)

Após o procedimento de permutação, podemos ver com clareza 
que há três subconjuntos de linhas e colunas:

B1 = {6,3,8} ,  B2 = {1,4,9},  B3 = {2,5,7}
Cada subconjunto é chamado de posição ou classe. Cada nó dentro 

da posição é estruturalmente equivalente. Possui o mesmo perfil relacional, 
as mesmas relações procedentes de e em direção a. Cada subgrupo é 
denominado uma classe de equivalência ou uma posição na rede.

O leitor deve perceber que a permutação anterior implica que os 
nós estruturalmente equivalentes são adjacentes entre si. Porém, como 
vimos no tipo puro da definição de equivalência estrutural, isso não é 
estritamente necessário, pois dois agentes posicionalmente equivalente 
podem não ser adjacentes entre si. 

Ao ter posições equivalentes, podemos simplificar ainda mais a 
matriz inicial, mediante uma matriz chamada de imagem.
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Tabela 23 – Matriz imagem e dígrafo respectivo

B1 B2 B3

B1 1 0 1

B2 0 1 0

B3 0 0 1

Fonte: Elaboração a partir de Wasserman e Faust (1994)

Na matriz anterior, os grupos de posições foram tratados como um 
único nó, isto é, foram reduzidos ou colapsados. Dado que B é o número 
de posições, então temos uma matriz 3x3. Mediante a matriz imagem, 
podemos observar se uma posição é adjacente de outra. Neste caso, 
observamos que há uma relação entre as posições B1 e B3.  Observe-se 
que estão representadas as autorrelações ou loops. Isso significa que 
ao interior de cada posição há um nutrido número de interações, nesse 
caso completo. 

Um conceito importante na análise de posições é chamado 
homomorfismo de grafo.  Se dois nodos i e j estão unidos por um arco no 
grafo original, também haverá um arco entre suas respectivas posições no 
grafo reduzido. 

Formalmente o homomorfirsmo se expressa de seguinte forma:
se i está na posição Bk e j na posição Bl , então i à j implica Bk à Bl 

No grafo reduzido estão presentes as seguintes relações entre 
posições: 

B1↔ B1, B2 ↔  B2 , B3 ↔ B3 , que correspondem aos loops e B1 

àB3, esta última relação implica que todos os nós da posição 1 estão em 
relação com seus pares da posição 3. 

Essa representação simplificada de uma rede social também 
é conhecida como blockmodeling. Pode ser estendida para um 
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conjunto de matrizes-imagem, uma para cada relação de um conjunto 
multiplexo ou multirrelacional. No capítulo seguinte, apresentaremos 
um exemplo.  

3.4 Quatro passos para uma análise completa de posições

Até aqui, foi feita a apresentação geral do conceito de equivalência 
estrutural destacando a vantagem que supõe identificar posições onde 
os nós compartilham o mesmo perfil relacional. A matriz imagem é uma 
versão da estrutura subjacente do grafo com a qual podemos identificar 
simultaneamente as posições e as relações entre as mesmas. Esse 
segundo elemento constitui a análise de papéis propriamente dita. Saber 
o que funcionalmente faz um ator numa rede supõe identificar qual é a 
sua posição estrutural e o tipo de relação que mantém com os membros 
de outras posições. 

O roteiro geral de uma boa análise de papéis e posições deve conter 
os seguintes passos: 

1. Ter uma definição de equivalência
Precisamos especificar as condições matemático-formais sob as 

quais vamos considerar como equivalentes os nodos de uma rede. A 
definição de equivalência é colocada em termos das propriedades das 
relações entre os atores em rede. 

2. Mensurar a equivalência
Ao coletar dados em rede, dificilmente encontraremos um grupo de 

atores exatamente equivalentes. A mensuração da equivalência permitirá 
decidir o grau de proximidade dos perfis relacionais dos atores.

3. Representar a equivalência
A forma mais comum de representação é o modelo discreto que 

oferece uma partição dos atores em rede numa coleção de classes 
equivalentes. Também é importante representar as relações entre 
posições; para essa finalidade servem a matriz de imagem e o grafo 
reduzido, isto é, o blockmodeling. 

4. Julgar a adequação do modelo



180

Análise de redes em Ciências Sociais

Determinar a adequação de um modelo e sua representação 
implica o uso de modelos probabilísticos e/ou determinísticos ou o que é 
conhecido na literatura técnica como goodness-of-fit. 

4. Exercícios

1) Analise a figura a seguir e marque a opção que identifica as 
classes de atores equivalentes:

a. (   ) {2,4}; {7}; {1}; {5}; {3,6}.
	
b. (   ) {2,4,7}; {1}; {3,5,6}.

c. (   ) {2,4}; {7}; {1}; {3,5,6}.

d. (   ) {2,4,7}; {1}; {5}; {3,6}.

e. (   ) {3,4}; {1,5,7}; {2,6}.

2) Permute a matriz do dígrafo anterior para representar as classes 
de atores equivalentes.

1 2 3 4 5 6 7

1 0 1 1 1 1 1 1

2 0 0 0 0 0 0 1

3 0 0 0 0 1 1 0

4 0 0 0 0 0 0 1

5 0 0 1 0 0 1 0

6 0 0 1 0 1 0 0

7 0 0 0 0 0 0 0

3) Elabore a matriz e o sociograma imagem com base nas posições 
identificadas na questão anterior.



181

Capítulo 9 – Papéis e posições: equivalência estrutural – segunda parte

Capítulo 9 – Papéis e posições: 
equivalência estrutural – segunda parte

1. A distância euclidiana como medida de equivalência 
estrutural

Antes tínhamos anotado que é improvável que dois atores sejam 
estruturalmente equivalentes com plena exatidão. Por quê? Um conjunto 
de fatores entram em jogo, o erro de mensuração, a variabilidade das 
respostas dos atores, dificuldades nas respostas, mudança dos critérios 
de seleção social quando um ator muda de sistema relacional etc. 

De ordinário, trabalha-se com relações dicotômicas, mas também 
pode ser feita uma análise para relações ponderadas, quando variam em 
frequência e intensidade, o que comumente é conhecido como a força dos 
laços. Deverão ser avaliados os loops, se faz sentido incluir as diagonais da 
matriz numa avaliação de equivalência estrutural.

A equivalência estrutural define um tipo-ideal. De fato, podemos 
encontrar dois nodos i e j que possuem grande quantidade de laços idênticos 
e poucos laços diferentes. Mas também dois nodos k e m que possuem 
poucos laços idênticos e muitos laços específicos que não compartilham. 

Lorraine e White (1971) introduziram a distância euclidiana como 
um critério de mensuração da equivalência estrutural. Observemos a 
seguinte figura:

Figura 97 – Distância euclidiana

Fonte: Digital commons
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O leitor deve lembrar o axioma elementar da geometria clássica. 
Sendo a linha reta a distância mais curta entre dois pontos, então 
a hipotenusa, ou diagonal, será a distância menor entre os pontos 
marcados na Figura 97. Dessa forma, o teorema de Pitágoras se aplica 
para determinar a distância entre dois pontos quaisquer num espaço 
dimensional, basta saber os valores na abcissa e na ordenada. A distância 
será a raiz quadrada da soma das diferenças nos valores da abcissa e da 
ordenada. Como estamos trabalhando com matrizes de adjacência, o que 
se inclui são as diferenças entre os valores das linhas e das colunas para 
todos os nós do sistema social.    

Dado xik como valor do laço entre i e k numa relação. Para dois 
atores i e j, procura-se a distância entre as linhas i e j e as colunas i e j na 
matriz de adjacência. A notação formal é a seguinte: 

Para i ≠ k, j ≠ k 
Se os atores i e j são estruturalmente equivalentes, então as 

entradas em suas linhas e colunas serão idênticas, e nesse caso a distância 
euclidiana será igual a 0. Eis algumas propriedades: 

A distância euclidiana de um nó a si próprio é igual a 0, (dii = 0).
A distância é simétrica nas relações de ida e volta, (dij = dji). 
Todas as distâncias serão maiores ou iguais a 0 (dij ≥ 0). 
Para uma relação direcionada e dicotômica simples, em que os 

valores da diagonal são indefinidos, o valor máximo possível da distância 
dij é 

Todas as distâncias euclidianas de uma rede são computadas. As 
distâncias pareadas constituem as entradas de uma matriz g x g a qual 
se denota como D = {dij}, cada entrada em D mensura a equivalência 
estrutural entre as linhas do ator e as colunas do ator.

Para um conjunto de R relações, ou relações multiplexo, onde xikr é 
o valor do laço do ator i ao ator k na relação Xr, a equivalência estrutural 
entre i e j será a distância euclidiana entre relações e atores i e j ao longo 
da coleção de relações: 
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Na seguinte Tabela, podemos observar o cálculo das distâncias 
euclidianas entre atores que constituem o sistema social das trocas de 
casamento das famílias de Florência na Renascença Italiana (Padgett, 1991). 
Observe-se que o valor zero nas diagonais corresponde à identidade do nó 
consigo mesmo. Para o restante dos valores, quanto mais próximos de zero, 
indicam maior semelhança no perfil relacional dos nós, portanto, maior 
proximidade com o tipo puro da equivalência estrutural. Por exemplo, as 
famílias Acciaiuoli e Pucci apresentam a maior semelhança quanto às suas 
escolhas de casamentos arranjados. A Figura 98 apresenta o dendrograma 
que agrupa os nós em clusters segundo a sua proximidade.

Tabela 24 – Matriz de distância euclidiana calculada com dados de 
Padgett (1991)
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Acciaiuoli 0 2 3.16 3.47 3.74 2.83 3.74 3.46 4.47 2.45 4 1.41 2 2 3.16 2.45

Albizzi 2 0 3.74 3.74 4.24 2.83 3.74 3.46 4.9 3.16 4.47 2.45 2.83 2.83 3.74 2.45
Barbadori 3.16 3.47 0 4.47 3.46. 3.16 4.9 3.74 4.69 3.46 3.74 3.46 374 3.16 4. 3.46

Bischeri 3.74 3.74 4.47 0 2.83 4.24 3.46 2.45 5.83 4 3.16 3.46 3.74 4.24 3.46 4
Castellani 3.74 4.24 3.46 2.83 0 3.74 4.47 3.74 5.1 4 2.45 3.46 3.74 4.24 3.46 4.47

Ginori 2.83 2.83 3.16 4.24 3.74 0 3.74 4 4 2.45 4 2.45 3.46 2.83 3.74 3.16
Guadagni 3.74 3.74 4.9 3.46 4.47 3.74 0 3.16 5.1 4 3.74 3.46 3.74 4.24 4 4

Lamberteschi 3.46 3.46 3.74 2.45 3.74 4 3.16 0 5.66 3.74 3.46 3.16 4 4 4.24 3.74
Medici 4.47 4.9 4.69 5.83 5.1 4 5.1 5.66 0 4.24 5.66 4.69 4.47 4.47 5.1 4.24

Pazzi 2.45 3.16 3.46 4 4 2.45 4 3.74 4.24 0 4.24 2 3.16 1.41 3.46 2.83
Peruzzi 4 4.47 3.74 3.16 2.45 4 3.74 3.46 5.66 4.24 0 3.74 4 4.47 3.16 4.69

Pucci 1.41 2.45 3.46 3.46 3.46 2.45 3.46 3.16 4.69 2 3.74 0 2.45 2.45 2.83 2.83
Ridolfi 2 2.83 3.74 3.74 3.74 3.46 3.74 4 4.47 3.16 4 2.45 0 2.83 3.16 2.45

Salviati 2 2.83 3.16 4.24 4.24 2.83 4.24 4 4.47 1.41 4.47 2.45 2.83 0 3.74 2.45
Strozzi 3.16 3.74 4 3.46 3.46 3.74 4 4.24 5.1 3.46 3.16 2.83 3.16 3.74 0 3.46

Tornabuoni 2.45 2.45 3.46 4 4.47 3.16 4 3.74 4.24 2.83 4.69 2.83 2.45 2.45 3.46 0
Fonte: Elaboração própria com Ucinet 6, Borgatti et al. (2002)
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Figura 98 – Distâncias euclidianas calculada com dados de Padgett (1991)
Dendrograma

Fonte: Elaboração própria com Ucinet 6 (Borgatti et al. 2002)

2. A correlação como medida de equivalência estrutural. O 
método CONCOR

Para entendermos a segunda opção de mensuração da equivalência 
estrutural, resulta pertinente lembrar o conceito básico da correlação 
linear entre duas variáveis. Correlacionar, em termos probabilísticos, 
significa determinar se duas variáveis, neste caso, contínuas, caminham 
no mesmo sentido ou não. Isto é, se a variabilidade de uma vai no sentido 
da outra. A correlação oscila entre valores extremos, um positivo, se as 
duas variáveis vão no mesmo sentido, e um negativo, se as duas variáveis 
vão em sentido contrário. Por exemplo, os anos de escolaridade estão 
correlacionados de forma positiva com os ganhos salariais das pessoas. 
Isto é, quanto mais ciclos formativos tiver concluído uma pessoa (ensino 
fundamental, médio e superior), maior será seu salário. Nesse caso, há 
uma correlação positiva. Agora, se correlacionamos a escolaridade e o 
número de filhos por mulher em idade fértil, encontraremos que vão em 
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sentido inverso. Quanto mais escolarizada uma mulher, terá menos filhos 
em seu ciclo de fertilidade. Esse é um fato das sociedades que passaram 
pelo processo de industrialização e massificação do sistema de ensino. 
A nova realidade do mercado de trabalho faz com que as mulheres 
profissionais posterguem a decisão de ter filhos. Nesse caso, escolaridade 
e número de filhos em idade fértil estão correlacionadas negativamente.  

Em continuação, apresentamos um gráfico de dispersão que 
correlaciona duas variáveis utilizadas num estudo de redes de produção 
acadêmica. Com dados de coautoria, e visando testar a hipótese do 
buraco estrutural (Burt, 2005), foi correlacionada autonomia estrutural 
dos autores com seu score de produção qualitativa segundo o estrato das 
revistas no índice Qualis da Coordenação de Aperfeiçoamento de Pessoal 
de Nível Superior (Capes). 

Tabela 25 – Correlação de Pearson

Fonte: Elaboração própria

A relação inversa entre as duas variáveis admite duas soluções: a 
correlação estritamente linear, da linha cinza, com um valor moderado 
r= 0.530; e a curva levemente exponencial e invertida, da linha tracejada, 
que melhora levemente o ajuste, pois seu coeficiente de determinação, o 
quadrado do r, é levemente maior. Em termos substantivos, o gráfico de 
dispersão está indicando que os autores com um capital relacional mais 
diversificado, o que se define pela sua autonomia estrutural, conseguem 
publicar mais e melhor. 
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A fórmula de cálculo da correlação linear, ou de Pearson, permite 
entender que no numerador é calculada a covariância dos dados, e 
no denominador, o desvio tipo da covariação. Sendo assim, o valor do 
coeficiente é uma proporção de quanto a covariação é semelhante ao 
desvio tipo. Dito de outra forma, em que medida a dispersão dos dados 
se parece à perfeita covariação positiva ou negativa. 

A correlação foi desenvolvida como método de identificação de 
posições e relações estruturalmente equivalentes. Harrison White e 
seus discípulos Boorman e Breiger (1976) desenvolveram o algoritmo 
denominado Convergence of Iterated Correlations (CONCOR), cuja 
tradução seria Convergência de Correlações Repetidas. 

O procedimento parte do fato de que o cálculo repetido de 
correlações de Pearson – conhecido como produto momento de Pearson 
– entre o ator i e o ator j, computado tanto em linhas como em colunas 
da matriz de adjacência, conduz a uma matriz imagem composta de 
correlações perfeitas positivas, +1, e negativas, -1.

Para efeito do entendimento da notação formal do algoritmo, 
deve se levar em conta que a média dos valores na linha i da matriz de 
adjacência é   e, de modo semelhante, a média dos valores na coluna 
i é 

Define-se a correlação como medida de equivalência estrutural 
para uma relação simples, mediante a seguinte fórmula (Wasserman; 
Faust, 1994):

na qual todas as somas estão feitas sobre k, sendo i ≠ k e j ≠ k.
O leitor deve levar em conta que essa fórmula inclui os mesmos 

fatores da correlação linear vista antes, com a covariação dos valores das 
linhas e colunas no numerador e o desvio tipo no denominador.  
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As correlações são organizadas numa matriz de correlação g x 
g denotada como C1. O (i, j) iésimo elemento em C1 é o coeficiente de 
correlação de Pearson, rij , entre a i iésima linha e coluna e a j iésima linha 
e coluna da matriz de adjacência. Os elementos da diagonal são excluídos.  

Se dois atores são estruturalmente equivalentes, então a 
correlação entre suas respectivas linhas e colunas da matriz de 
adjacência será igual a +1.

Em continuação, temos um exemplo do resultado inicial da matriz 
de correlação no sistema de trocas matrimoniais estudado por Padgett 
(1993). A correlação positiva com valor 1 nas diagonais expressa a 
identidade do nó consigo mesmo, mas nos vértices há valores positivos 
e negativos. Os primeiros insinuam semelhança no perfil relacional, e os 
segundos, dessemelhança.  

Tabela 26 – Matriz C, inicial de correlação, calculada com dados de 
Padgett (1993)
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Acciaiuoli 1 0.56 0.37 -0.1 -0.1 -0.07 -0.1 -0.09 0 -0.05 -0.11 0 0.56 0.56 -0.08 0.47

Albizzi 0.56 1 0.1 0.1 -0.18 -0.08 -0.13 0.14 -0.21 -0.1 -0.2 0 0.25 0.25 -0.14 0.52

Barbadori 0.37 0.1 1 -0.06 0.13 0.23 -0.27 0.21 -0.06 0.19 0.21 0 0.1 0.38 0.04 0.28

Bischeri -0.1 0.1 -0.06 1 0.58 -0.18 0.13 0.61 -0.42 -0.14 0.34 0 0.1 -0.18 0.14 0.04

Castellani -0.1 -0.18 0.13 0.58 1 0.1 -0.06 0.08 -0.06 -0.14 0.61 0 0.1 -0.18 0.14 -0.21

Ginori -0.07 -0.08 0.23 -0.18 0.1 1 0.1 -0.16 0.37 0.35 0.07 0 -0.12 0.25 -0.14 0.19

Guadagni -0.1 -0.13 -0.27 0.13 -0.06 0.1 1 0.19 -0.06 -014 0.3 0 0.1 -018 0.04 -0.16

Lamberteschi -0.09 0.14 0.21 0.61 0.08 -0.16 0.19 1 -0.38 -0.13 0.28 0 -0.16 -0.16 -0.19 0.08

Medici 0 -0.21 -0.06 -0.42 -0.06 03.7 -0.06 -0.38 1 0.26 -0.3 0 0.08 -0.13 -0.12 0.11

Pazzi -0.05 -0.1 0.19 -0.14 -0.14 0.35 -0.14 -0.13 0.26 1 -0.16 0 -0.1 0.69 -0.11 0.28

Peruzzi -0.11 -0.2 0.21 0.34 0.61 0.07 0.3 0.28 -0.3 -0.16 1 0 0.07 -0.2 0.38 -0.24

Pucci 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0

Ridolfi 0.56 0.25 0.1 0.1 0.1 -0.12 0.1 -0.16 0.08 -0.1 0.07 0 1 0.25 -0.1 0.35

Salviati 0.56 025 0.38 -0.18 -0.18 0.25 -0.18 -0.16 -0.13 0.69 -0.2 0 0.25 1 -0.14 0.52

Strozzi -0.08 -0.14 0.04 0.14 0.14 -0.14 0.04 -0.19 -0.12 -0.11 0.38 0 -0.1 -0.14 1 0.13

Tornabuoni 0.47 0.52 0.28 0.04 -0.21 0.19 -0.16 0.08 0.11 0.28 -0.24 0 0.35 0.52 0.13 1

Fonte: Elaboração própria com Ucinet 6 (Borgatti, 2002)
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O procedimento continua em rodadas sucessivas até encontrar 
valores de perfeita correlação positiva ou negativa. 

Tabela 27 – Perfeita correlação intrablocos e interblocos

+1 -1

-1 +1

Fonte: Elaborado a partir de Wasserman e Faust (1994)

Os atores correlacionados de forma positiva possuem perfis 
relacionais semelhantes. Dessa forma, os dados dos blocos permitem 
subdividir as posições dentro da rede.

A partição inicial, ou Split, pode ser refinada com ulteriores 
cálculos de correlação. Desse ponto de vista, CONCOR é um método de 
clusterização hierárquica por divisão. Mas uma decisão se impõe: quando 
parar com as divisões? A teoria e a interpretabilidade da solução serão os 
primeiros critérios para definir quantas posições gerar.

Vejamos a Tabela seguinte:

Tabela 28 – Partições CONCOR

1 2 13 16 3 14 9 6 10 4 8 15 11 5 7 12
N3
N2
N1

Fonte: Elaborado a partir de Padgett (1993) com Ucinet 6 (Borgatti et al. 2002)

Na Tabela 28, o nível 1 significa a primeira partição, e nesta foram 
separados dois grupos ou clusters, onde os nós que pertencem ao cluster 
estão correlacionados de forma perfeita e positiva, +1, ao tempo que 
estão correlacionados de forma perfeita e negativa com os membros 
do outro cluster, -1. Os nós ficaram agrupados em B1 = {1, 2, 13, 16, 3, 
14, 9, 6, 10} e no B2 = {4, 8, 15, 11, 5, 7, 12}. Como vimos antes, cada 
agrupamento constitui uma posição comum, em que há semelhança no 
perfil relacional. O procedimento continua com uma segunda partição, 
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ou nível 2, onde foram encontrados quatros blocos de semelhança. O 
leitor pode identificar cada bloco pelo alinhamento da coluna do nível 
respectivo. No nível 3, a partição encontrou sete blocos de semelhança. 
O procedimento termina porque em alguns casos ficaram blocos ou 
posições de um ator único. No critério de Wasserman e Faust (1994), 
partições subtriádicas, isto é, com menos de três nós, não são de fácil 
interpretação sociométrica. Lembremos também o axioma de Simmel: “a 
sociedade começa na tríada”. 

O método CONCOR exige alguns cuidados na hora da interpretação 
final dos resultados (Wasserman; Faust, 1994):

O procedimento de bi-partição, ou 2 splits, em cada iteração, impõe 
uma árvore binária que é inerente ao procedimento e não à estrutura dos 
dados.

Alguns pesquisadores têm demonstrado que a partição CONCOR não 
encontra necessariamente posições que correspondem a subconjuntos 
de atores que ocupam intuitivamente posições sociais.

As propriedades formais do procedimento não são bem 
conhecidas. Schawartz (1977), apud Wasserman e Faust (1994), discute 
as propriedades matemáticas de covariâncias iteradas e de correlações 
iteradas, relacionando-as com a análise multivariada de componentes 
principais. Demonstra que a primeira partição de CONCOR é virtualmente 
idêntica ao padrão de signos (+ e -) do primeiro componente principal 
da análise de componentes feita a partir de uma matriz de correlação. 
Dada essa semelhança, constata-se que a análise de componentes 
principais outorga uma informação mais rica, pois entrega um número de 
componentes que explica variância e não uma simples partição dos atores. 
Além disso, há todo um leque de discussões sobre o critério de otimização 
do resultado, algo sobre o que nos debruçaremos posteriormente.

3. Comparação entre medidas de equivalência estrutural

Encontrar atores, dentro de um espaço em rede, que sejam 
perfeita e estruturalmente equivalentes, é algo muito raro. Há 
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divergências entre a distância euclidiana e o método CONCOR como 
detectores de equivalência estrutural. Por um lado, podemos encontrar 
uma correlação +1 entre dois nodos, mas, por outro, podemos obter 
uma distância euclidiana que não seja 0. 

Mensurar equivalência estrutural consiste em mesurar a 
similaridade dos laços que saem e chegam entre pares de atores dentro de 
um conjunto de dados em rede. Diversos matemáticos têm-se debruçado 
sobre esse problema (apud Wasserman; Faust, 1994): Cronbach e Gleser 
(1953),  Fox (1982), Sokal e Sneath (1963).

Somente destacamos alguns dos trabalhos referenciados. Podemos 
ver que há um domínio da matemática que se denomina “taxonomia 
numérica”. Isto é, como classificar por semelhança e diferença dados 
apresentados numericamente.

Como vimos antes, Wasserman e Faust (1994) trabalham a relação 
entre distância euclidiana e CONCOR a partir da relação entre duas linhas 
e colunas de uma matriz de adjacência.  

Esses autores propõem uma análise comparativa que parte da média 
dos valores na linha i e na linha j, denotados ,  respectivamente. 
As variâncias denotam-se como  , e  , respectivamente. 

Os cálculos excluem os elementos da diagonal (loops) e os elemen
tos , , dado que inicialmente foram excluídos dos cálculos da 
distância euclidiana e da correlação entre i e j. Por que isto último? 
Lembremos que interessa o perfil relacional de i e j em relação a todos os 
outros nodos k. Por isso, tanto a fórmula da distância euclidiana como da 
correlação excluem as relações mútuas entre os nodos cujo perfil estamos 
comparando. Lembremos:
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A relação entre a distância euclidiana  e a correlação  entre 
as linhas i e j se expressa formalmente como:

Em circulos temos destacado o que significam os termos principais 
da equação anterior. Observa-se que, para uma correlação dada :  

 a distância euclidiana entre duas linhas incrementa;
 a diferença entre as médias das duas linhas incrementa;
 a soma entre as variâncias das duas linhas incrementa.

Assim, em termos substantivos, o anterior significa que a distância 
euclidiana capta uma menor quantidade de equivalência estrutural que o 
coeficiente de correlação se os atores diferem na média e na variância de seus 
laços, assumindo que todo o restante permanece igual ou ceteris paribus.

Wasserman e Faust (1994) ilustram a diferença a partir do seguinte 
exemplo:

Freeman et al. (1979) estudou o impacto de um sistema de trocas 
de informação eletrônicas (Electronic Information Exchange System, EIES) 
na produtividade dos pesquisadores envolvidos. Quando a internet ainda 
não era um dispositivo popular, um grupo de cientistas foi conectado, via 
computadores. No questionário sociométrico, aplicado no começo e no 
final da pesquisa, foi perguntado a cada um se:

(1) Não conhecia o outro(a).
(2) Se havia ouvido falar, mas ainda não o/a conhecia.
(3) Se o/a conhecia.
(4) Se era amigo do outro(a).
(5) Se era amigo íntimo do outro(a).
O assunto relevante consiste em saber se dois respondentes 

podem diferir só no uso da escala de resposta, um deles outorgando de 
forma consistente valores baixos e os outros valores altos, mas possuem 
exatamente os mesmos conhecidos e amigos. Assim, dado que as médias 
dos atores são diferentes, estes serão considerados estruturalmente 
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menos equivalentes se aplicarmos a distância euclidiana, e com maior 
equivalência se aplicamos coeficiente de correlação.

Em síntese, se o pesquisador visa mensurar a identidade na 
valoração dos laços entre dois atores, a distância euclidiana é preferível; 
se visa mensurar a similaridade no padrão relacional, a correlação é mais 
adequada.

A diferença anterior faz sentido e é acentuada quando os laços são 
valorados e quando há grandes diferenças na média da força geral dos 
laços entre os atores. 

Uma forma de evitar os resultados divergentes entre a distância 
euclidiana e a correlação consiste em padronizar os dados relacionais para 
apagar as diferenças de médias e variâncias entre atores. Se isso é feito, 
todas as linhas e colunas dos atores terão igual média e variância, média 
zero e desvio tipo um. Dessa forma, a distância euclidiana e a correlação 
dão resultados idênticos. 

Finalmente, devemos lembrar que a distância euclidiana e a 
correlação aplicam-se a todos os tipos de relações: simples ou múltiplas, 
dicotômicas ou valoradas, direcionadas ou não direcionadas. 

4. Exercícios

1) Calcule o valor máximo possível da distância euclidiana entre 
i e j na rede de transferência de jogadores dos clubes da 1ª divisão do 
campeonato brasileiro em 2017.

2) Utilize o Ucinet para calcular a matriz de distâncias euclidianas 
entre os clubes da 1ª divisão do campeonato brasileiro em 2017 na rede 
de transferências de jogadores. Execute o caminho:

Network > Roles & Positions > Structural > Profile...
3) A Tabela 29 a seguir apresenta os resultados que você alcançou 

na questão anterior. Analise as informações e aponte os dois pares de 
clubes mais próximos da condição de equivalência estrutural.
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Tabela 29 – Matriz de distâncias euclidianas
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45

Flamengo
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2,
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24
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83
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2,
00
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2,
65

2,
00
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0,
00

2,
83

2,
65

3,
46

2,
65

2,
45
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3,
16
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65

2,
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45
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83
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83
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2,
45
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24
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65

2,
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00
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83
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73
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24
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45
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1,
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1,
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45
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83
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32
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83

2,
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2,
83

3,
16
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00
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3,
32
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2,
83

2,
65

3,
32

2,
83

2,
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0,
00

2,
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2,
24

3,
16

2,
83

2,
45

2,
83

3,
00

3,
00

2,
65

3,
00

3,
32

2,
65

Fluminense

2,
45

2,
24

2,
24

2,
45

3,
16

1,
73

2,
83

2,
65

0,
00

2,
45

2,
65

2,
65

2,
24

2,
65

2,
45

2,
00

2,
45

2,
00

3,
16

2,
45

Bahia

3,
16

2,
65

2,
24

2,
83

2,
83

2,
24

2,
83

2,
24

2,
45

0,
00

3,
00

2,
65

2,
24

2,
24

2,
45

2,
45

2,
45

2,
45

2,
45

2,
00

Vitória

3,
32

2,
83

2,
83

3,
61

2,
65

2,
83

3,
00

3,
16

2,
65

3,
00

0,
00

2,
45

2,
83

2,
45

2,
65

2,
24

2,
24

3,
00

3,
61

2,
65

Atlético-GO

3,
00

2,
45

2,
00

3,
32

2,
65

2,
00

2,
65

2,
83

2,
65

2,
65

2,
45

0,
00

2,
45

2,
45

2,
24

2,
65

1,
73

1,
73

3,
00

2,
24

Atlético-MG

2,
24

2,
00

2,
00

3,
00

2,
65

2,
00

1,
73

2,
45

2,
24

2,
24

2,
83

2,
45

0,
00

2,
83

2,
24

2,
65

2,
24

2,
24

2,
65

1,
73

Coritiba

3,
32

2,
45

2,
45

3,
00

3,
00

2,
45

3,
32

2,
83

2,
65

2,
24

2,
45

2,
45

2,
83

0,
00

2,
65

2,
65

1,
73

2,
65

2,
65

2,
65

Botafogo

2,
00

2,
24

1,
73

3,
16

2,
45

1,
73

2,
00

3,
00

2,
45

2,
45

2,
65

2,
24

2,
24

2,
65

0,
00

2,
00

2,
00

2,
00

2,
45

1,
41

Chapecoense

2,
83

2,
65

2,
24

3,
16

2,
83

1,
73

2,
83

3,
00

2,
00

2,
45

2,
24

2,
65

2,
65

2,
65

2,
00

0,
00

2,
45

2,
45

3,
16

2,
00

Ponte Preta

2,
83

1,
73

1,
73

3,
16

2,
83

1,
73

2,
83

2,
65

2,
45

2,
45

2,
24

1,
73

2,
24

1,
73

2,
00

2,
45

0,
00

2,
00

2,
83

2,
00

Santos

2,
83

2,
24

1,
73

2,
83

2,
83

1,
73

2,
83

3,
00

2,
00

2,
45

3,
00

1,
73

2,
24

2,
65

2,
00

2,
45

2,
00

0,
00

2,
83

2,
00

Corinthians

2,
83

3,
00

2,
65

3,
16

2,
83

2,
65

3,
16

3,
32

3,
16

2,
45

3,
61

3,
00

2,
65

2,
65

2,
45

3,
16

2,
83

2,
83

0,
00

2,
45

Avaí

2,
45

2,
24

1,
73

3,
16

2,
45

1,
73

2,
00

2,
65

2,
45

2,
00

2,
65

2,
24

1,
73

2,
65

1,
41

2,
00

2,
00

2,
00

2,
45

0,
00

Fonte: Elaboração própria. Software Ucinet. 

A Tabela 30  mostra o Clustering hierárquico da matriz de 
equivalência calculado pelo método da distância euclidiana. Analise a 
tabela e aponte a composição dos quatro grupos mais similares entre si.
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Tabela 30 – Clustering hierárquico da matriz de equivalência 
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1,414 . . . . . . . . . . . . . X X . . . X X

1,732 . . . . . . . . . . X X . X X X X X X X

1,839 . . . . . . . . . . X X X X X X X X X X

1,933 . . . . . . . . . . X X X X X X X X X X

1,971 . . . . . . . . . X X X X X X X X X X X

2,000 . . . . . . . X X X X X X X X X X X X X

2,101 . . . . . . . X X X X X X X X X X X X X

2,236 . . . . . X X X X X X X X X X X X X X X

2,252 . . . . . X X X X X X X X X X X X X X X

2,333 . . . . . X X X X X X X X X X X X X X X

2,477 . . . . . X X X X X X X X X X X X X X X

2,638 . . . . X X X X X X X X X X X X X X X X

2,646 . . X X X X X X X X X X X X X X X X X X

2,741 . . X X X X X X X X X X X X X X X X X X

2,813 . X X X X X X X X X X X X X X X X X X X

3,049 X X X X X X X X X X X X X X X X X X X X

Fonte: Elaboração própria. Software Ucinet.

Utilize o método CONCOR padrão, no Ucinet, para calcular a matriz 
de correlação da rede de transferências de jogadores entre os clubes da 
1ª divisão do campeonato brasileiro em 2017. Execute o caminho:

Network > Roles & Positions > Structural > Concor > Standart
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A Tabela 31  a seguir apresenta os resultados que você alcançou na 
questão anterior. Analise as informações e aponte os pares de clubes mais 
próximos da condição de equivalência estrutural.

Tabela 31 – Matriz de correlação inicial – CONCOR padrão
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Cruzeiro 1,
00

0,
13

-0
,0

8

0,
12

-0
,1

6

0,
38

0,
30

-0
,0

3

0,
32

-0
,1

6

-0
,1

8

-0
,1

3

0,
40

-0
,1

8

0,
42

-0
,1

2

-0
,1

1

-0
,1

1

0,
20

-0
,0

7

Flamengo 0,
13

1,
00

-0
,0

5

0,
32

-0
,1

3

-0
,0

5

0,
13

0,
61

0,
21

-0
,1

1

-0
,1

1

-0
,0

9

0,
27

-0
,0

9

-0
,0

7

-0
,1

1
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4
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Vasco
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,0

3

-0
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,1
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,1

3
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0,
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3
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,1
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3

0,
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0
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0

0,
67

-0
,1

8

0,
42

0,
08

-0
,1

1

-0
,1

1

-0
,1

6

0,
54
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-0
,0

3
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Fonte: Elaboração própria. Software Ucinet.
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A Tabela 32  é outro resultado da análise de similaridade de 
equivalência estrutural baseada no método CONCOR padrão. Analise e 
interprete as informações da tabela. Quantos blocos de atores o método 
CONCOR padrão encontrou?

Tabela 32 – Diagrama de partições
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Nível 3 X X X X X X X X . X X X X X X X X X X X

Nível 2 X X X X X X X X X X X X X X X X X X X X

Nível 1 X X X X X X X X X X X X X X X X X X X X

Fonte: Elaboração própria. Software Ucinet.

Compare os resultados encontrados pelos métodos distância 
euclidiana e CONCOR padrão. Aponte as diferenças e semelhanças. 
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Capítulo 10 – Papéis e posições: a 
passagem do micro ao macro

1. Construção da matriz imagem: o método da densidade

Agora vamos explicar a lógica e o procedimento para a construção 
da matriz de adjacência. Lembremos que o trabalho de representar 
posições estruturalmente equivalentes numa rede procede em dois 
momentos: primeiro, alocar atores a posições; e, segundo, descrever 
como as posições se relacionam umas com outras. 

Para descrever relações intra e interposições, há três representações 
diferentes:

•	 Tabela de densidades
•	 Matriz imagem 
•	 Grafo reduzido 

Já vimos que o ponto de partida consiste em definir uma medida 
de semelhança estrutural, seja a distância euclidiana ou a correlação 
linear. Num primeiro momento, é gerada uma matriz de adjacência com 
as medidas de semelhança entre os nós. O leitor pode voltar às seções 1 
e 2 do capítulo 9 e constatar a dificuldade de discernir dentro do conjunto 
quais são os clusters de nós com semelhança relacional. Aqui vemos a 
importância da permutação como uma operação básica com matrizes. 
Na Tabela seguinte, apresentamos o output, gerado pelo software 
Ucinet 6.624, da matriz de adjacência entre as sete posições ou blocos 
estruturalmente equivalentes na rede de casamentos de Padgett (1993). 
Nessa apresentação, temos a versão permutada da matriz original com 
diversos blocos, mas ao mesmo tempo mantendo as relações originais da 
matriz de adjacência.
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Tabela 33 – Matriz de posições 

1
A

2
A

1
3
R

1
6
T

3
B

1
4
S

9
M

6
G

1
0
P

7
G

1
2
P

4
B

8
L

1
1
P

5
C

1
5
S

--------------------------------------------------------------------------------
1 Acciaiuoli 1

2 Albizzi 1 1 1

13 Ridolfi 1 1 1

16 Tornabuoni 1 1 1
--------------------------------------------------------------------------------

3 Barbadori 1

14 Salviati 1
--------------------------------------------------------------------------------

9 Medici 1 1 1 1 1 1

6 Ginort 1
--------------------------------------------------------------------------------

10 Pazzi 1
--------------------------------------------------------------------------------

7 Guadagni 1 1 1 1

12 Pucci
--------------------------------------------------------------------------------

4 Bischeri 1 1 1

8 Lamberteschi 1
--------------------------------------------------------------------------------

11 Peruzzi 1 1 1

5 Castellani 1 1 1

15 Strozzi 1 1 1 1
--------------------------------------------------------------------------------

Fonte: Elaborado a partir de Padgett (1993) com Ucinet 6 (Borgatti, 2002)

O objetivo agora é construir uma matriz imagem com os blocos de 
posições estruturais. Observemos que no exemplo há sete blocos:

B1 = {1, 2, 13, 16}
B2 = {3, 14}
B3 = {9, 6}
B4 = {10}
B5 = {7, 12}
B6 = {4, 8}
B7 = {11, 5, 15}
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Note-se que também há variabilidade na densidade das relações 
ao interior dos clusters e entre clusters. Por exemplo, entre B1 e B3 temos 
um número expressivo de relações, enquanto que entre B1 e B6 não há 
relações. Outra forma de resumir as relações entre posições consiste na 
tabela de densidades ou matriz de densidades. Lembremos nossa medida 
de coesão global ou densidade.

 Assim, entre B1 e B3 temos 4*2 laços possíveis, e só foram observados 
5. Portanto,  ∆’s = 0,625. 

Tabela 34 – Matriz de densidades intra e inter blocos

1 2 3 4 5 6 7
1 0.167 0 0.625 0 0.25 0 0.083
2 0 0 0.5 0.5 0 0 0.167
3 0.625 0.5 0 0 0 0 0
4 0 0.5 0 0 0 0 0
5 0.25 0 0 0 0 0.5 0
6 0 0 0 0 0.5 0 0.333
7 0.083 0.167 0 0 0 0.333 1.000

Fonte: Elaborado a partir de Padgett (1993) com Ucinet 6 (Borgatti, 2002)

Qual é o critério para construir uma matriz imagem que resuma 
as relações entre blocos ou posições? Lembremos que a matriz imagem 
expressa em termos de 0 e 1 as relações entre blocos. Porém, só algumas 
relações entre posições aparecem em termos de 0 ou 1. Por exemplo, 
entre o B1 e o B6 não há relações. Mas, ao mesmo tempo, em vários 
vértices as densidades estão entre 0 e 1. Como colocar a matriz em preto 
e branco, isto é, em termos de relações binárias 1 e 0?

A partir da tabela de densidades, podem se invocar vários critérios 
para construir uma matriz imagem. Uma opção é a regra α de densidade. 

Leva-se em conta a densidade de toda a matriz. No caso da matriz 
de trocas matrimoniais, temos que: 

∆ α = 0,16
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Assim, só as densidades entre posições maiores ou iguais à 
densidade de toda a rede se consideram válidas para entrar na matriz 
imagem com valor 1.

Atribuímos valor 0 se ∆klr < α
Atribuímos valor 1 se ∆klr ≥ α  

Aplicando os critérios de corte anteriores, temos que a matriz de 
densidades se transforma numa matriz binária.

Tabela 35 – Matriz imagem intra e inter blocos 

1 2 3 4 5 6 7
1 1 0 1 0 1 0 0
2 0 0 1 1 0 0 1
3 1 1 0 0 0 0 0
4 0 1 0 0 0 0 0
5 1 0 0 0 0 0 0
6 0 0 0 0 0 0 1
7 0 1 0 0 0 1 1

Fonte: elaborado a partir de Padgett (1991) com Ucinet 6 (Borgatti et al. 2002)

2. Blockmodeling: critérios de interpretação e ajuste

Como seu nome indica, um blockmodeling é uma representação 
formal e simplificada de um estado de coisas no mundo social, 
especificamente de uma estrutura dentro de um sistema social. Nesse 
sentido, o leitor deve lembrar ideias básicas da Filosofia da Ciência e 
da Epistemologia. Um modelo teórico não é a reprodução duplicada da 
realidade, somente aspira a lançar uma conjetura de como é o mundo sob 
algumas pressuposições. Por esse motivo, toda teorização é passível de ser 
aperfeiçoada ou refutada mediante os resultados de novas pesquisas. No 
caso específico dos blockmodelings, estes são úteis por diversos motivos:

(i) 	 Permitem simplificar sistemas posicionais em rede.
(ii) 	 Permitem interpretações teóricas.
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(iii) 	Permitem validar teorias estruturais.
(iv) 	Permitem comparar padrões relacionais entre populações.

Sintetizando, um blockmodeling consiste em:

(i) 	 Uma partição de atores em rede dentro de subconjuntos 
chamados de posições.

(ii) 	 Para cada par de posições é determinada a presença ou 
ausência de um laço dentro ou entre posições para cada uma 
das relações que estejam sendo analisadas.

Até aqui vimos o critério da densidade para identificar clusters 
ou subgrupos em que os nós possuem um perfil relacional semelhante 
segundo o conceito de equivalência estrutural. Agora se coloca o problema 
de como interpretar os resultados de uma análise posicional quando os 
resultados são apresentados como um blockmodeling.

Para avançarmos na interpretação dos resultados de um 
blockmodeling, precisamos de uma definição formal: 

Um blockmodeling é uma partição de atores em N dentro de B 
posições, B1, B2,..., BB , constituindo uma coleção de posições φ(i) = Bk se o 
ator i está na posição Bk. 

Também especifica os laços ao interior e entre as B posições. Com a 
expressão bklr se indica a presença ou ausência de um laço de uma posição 
Bk até uma posição Bl na relação Xr, onde bklr = 1, se há um laço; e bklr = 0, 
se não há laço. 

Um blockmodeling se representa por uma matriz imagem B= {bklr}. 
Essa matriz é um arranjo B x B x R que expressa relações intra e entre 
posições. Cada entrada na matriz é chamada de block. Um block que inclui 
um 1, indicando uma relação com outro block, é chamado de oneblock, e 
se não há relação – incluindo um 0 – é chamado de zeroblock. 

Como vimos antes, é pouco provável encontrar redes sociais que 
possam ser modelizadas em forma pura como oneblock ou zeroblock. As 
relações intra e interposições sempre incluem 1 e 0. 

Portanto, é preciso uma regra que permita atribuir 1 ou 0 aos laços 
entre posições. 
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Vimos antes que o critério geral para definir oneblocks ou 
zeroblocks é densidade de laços interblocos e dentro de um bloco. Porém, 
há critérios alternativos para definir como marcar ou não uma relação. 
De forma resumida, podemos afirmar que há quatro critérios para definir 
oneblocks e zeroblocks. 

2.1 Ajuste perfeito (Fat fit)

Tabela 36 – Ajuste Fat fit

B1 B2 B3
1 2 3 4 5

B1
1 - 0 1 1 0
2 0 - 1 1 0

B2
3 0 0 - 0 1
4 0 0 0 - 0

B3 5 0 0 0 0 -
Fonte: Elaborado a partir de Wasserman e Faust (1994) 

Figura 99 – Grafo e matriz de adjacência após ajuste Fat fit

0 1 0

0 0 1

0 0 0

Fonte: Elaboração a partir de Wasserman e Faust (1994)

O ajuste perfeito requer que o valor dos laços entre duas posições 
seja igual a 1, dado que todos os atores na posição linha possuem relações 
com todos os atores na posição coluna. E 0 quando não há relações. 

As condições se expressam formalmente como:
bklr = 0 se o valor no vértice é zero para todas as relações entre o 

bloco linha e coluna, ou no intrabloco.
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bklr = 1 se o valor no vértice é um para todas as relações entre o 
bloco linha e coluna, ou no intrabloco.

O leitor pode observar as áreas coloridas na Tabela 36. Entre as 
posições B1 e B2, todos os valores correspondem a 1. Já entre as posições 
B1 e B3, todos os valores correspondem a 0. Isto é, estão dadas a condições 
para se proceder pelo critério do ajuste perfeito.

2.2 Ajuste zeroblock (Lean fit)

Tabela  37 – Ajuste zeroblock 

B1 B2 B3
1 2 3 4 5

B1
1 - 0 1 1 0
2 0 - 1 1 0

B2
3 0 0 - 0 1
4 0 0 0 - 0

B3 5 0 0 0 0 -
Fonte: Elaboração a partir de Wassreman e Faust (1994)

Figura 100 – Grafo e matriz de adjacência após ajuste zeroblock

0 1 0

0 0 1

0 0 0

Fonte: Elaboração a partir de Wassreman e Faust (1994)

O critério zeroblock determina que o laço entre duas posições 
numa relação dada é 0 só e só se não há nenhum laço entre os atores na 
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posição linha e os atores da posição coluna. Já a segunda condição para o 
valor 1 não é rígida.

bklr = 0 se o valor no vértice é zero para todas as relações entre o 
bloco linha e coluna, ou no intrabloco.

bklr = 1 para qualquer outra combinação de valores.
O leitor pode observar na Tabela 37 que, no vértice de interseção 

dos Blocos B2 e B1, cumpre-se a condição de todos os valores serem zero, 
já no vértice de interseção dos Blocos B2 e B3, basta que exista um único 
valor em 1. 

2.3 Ajuste oneblock

Tabela 38 – Ajuste oneblock 

B1 B2 B3
1 2 3 4 5

B1
1 - 0 1 1 0
2 0 - 1 1 0

B2
3 0 0 - 0 1
4 0 0 0 - 0

B3 5 0 0 0 0 -
Fonte: Elaboração a partir de Wassreman e Faust (1994)

Figura 101 – Grafo e matriz de adjacência após ajuste oneblock

0 1 0

0 0 0

0 0 0

Fonte: Elaboração a partir de Wassreman e Faust (1994)
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O critério oneblock determina que os vértices que correspondem 
aos laços intra e interposições possuam valores 1, caso todos os laços 
entre os atores da posição linha com os atores da posição coluna estejam 
presentes. Já a segunda condição para o valor 0 não é rígida.

bklr = 0 para qualquer outra combinação de valores.
bklr = 1 se o valor no vértice é um para todas as relações entre o 

bloco linha e coluna, ou no intrabloco. 
Observemos o seguinte exemplo das relações comerciais de bens 

manufaturados entre diversos países, tomado do banco de dados do Ucinet 

Tabela 39 – Blocos das relações comerciais de bens manufaturados

1
A

2
0
S

7
E

2
1
T

5
C

4
C

1
1
1

1
7
P

6
E

2
4
Y

1
4
L

3
B

2
A

2
2
U

1
3
J

9
F

1
6
N

1
8
S

1
9
S

8
E

1
5
M

1
0
H

2
3
U

1
2
I

------------------------------------------------------------------------------------------
1 Algeria | | | 1 1 | 1 | | 1 | | |

------------------------------------------------------------------------------------------
20 Syria | | | | | | | | |
7 Egypt | | | 1 | 1 | | 1 1 1 1 1 | 1 | 1 |

------------------------------------------------------------------------------------------
21 Thailand | | 1 | 1 1 1 | 1 | 1 | 1 1 1 1 1 1 | | 1 1 |
5 Czechoslovakia | 1 | 1 1 | 1 1 1 1 | 1 1 1 | 1 1 | 1 1 1 1 1 1 | 1 1 | |
4 China | 1 | 1 1 | 1 1 1 1 | 1 1 | 1 1 | 1 1 1 1 1 1 | 1 1 1 | |

11 Indonesia | 1 | 1 | 1 1 1 1 | 1 | | 1 1 1 1 1 1 | | |
17 Pakistan | | 1 | 1 1 1 1 | 1 | | 1 1 1 1 1 1 | | |

------------------------------------------------------------------------------------------
6 Ecuador | | | | | 1 | | | 1 |

24 Yugoslavia | 1 | 1 1 | 1 1 1 1 1 | | 1 | 1 1 1 1 1 1 | 1 | 1 1 |
14 Liberia | | | | | | | | |

------------------------------------------------------------------------------------------
3 Brazil | 1 | 1 1 | 1 1 1 1 1 | 1 1 1 | 1 | 1 1 1 1 1 1 | 1 | 1 1 |
2 Argentina | 1 | | 1 1 1 1 | 1 | 1 | 1 1 1 1 | | 1 1 |

------------------------------------------------------------------------------------------
22 United Kingdom | 1 | 1 1 | 1 1 1 1 1 | 1 1 1 | 1 | 1 1 1 1 1 | 1 1 1 | 1 1 |
13 Japan | 1 | 1 1 | 1 1 1 1 1 | 1 1 1 | 1 1 | 1 1 1 1 1 | 1 1 1 | 1 1 |
9 Finland | 1 | 1 1 | 1 1 1 1 1 | 1 1 | 1 1 | 1 1 1 1 1 | 1 1 | 1 1 |

16 New Zeland | 1 | 1 | 1 1 1 1 | 1 | | 1 1 1 | | 1 |
18 Spain | 1 | 1 1 | 1 1 1 1 1 | 1 1 1 | 1 1 | 1 1 1 1 1 | 1 1 | 1 1 |
19 Switzerland | 1 | 1 1 | 1 1 1 1 1 | 1 1 1 | 1 1 | 1 1 1 1 1 | 1 1 1 | 1 1 |

------------------------------------------------------------------------------------------
8 Ethiopia | | | | | | 1 1 | | |

15 Madagascar | | | | | | 1 | | |
10 Honduras | | | | | | | | 1 |

------------------------------------------------------------------------------------------
23 United States | 1 | 1 1 | 1 1 1 1 1 | 1 1 1 | 1 1 | 1 1 1 1 1 1 | 1 1 1 | 1 |
12 Israel | | | 1 | 1 | 1 | 1 1 1 1 1 1 | 1 | 1 |

------------------------------------------------------------------------------------------
Fonte: Elaboração propria com Ucinet 6 (Borgatti, 2002)
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Para uma melhor compreensão, apresentamos em continuação a 
tabela de densidades que corresponde aos blocos vistos anteriormente. 

Tabela 40 – Matriz de densidades – trocas de bens manufaturados

1 2 3 4 5 6 7 8
---------- ---------- ---------- ---------- ---------- ---------- ---------- ----------

1 0.000 0.000 0.400 0.333 0.000 0.167 0.000 0.000

2 0.000 0.000 0.100 0.167 0.000 0.417 0.167 0.250

3 0.600 0.700 0.950 0.533 0.500 1.000 0.333 0.600

4 0.333 0.333 0.333 0.000 0.333 0.333 0.111 0.500

5 1.000 0.900 0.500 0.667 1.000 0.833 0.167 1.000

6 1.000 0.967 0.917 0.833 0.750 0.933 0.722 0.917

7 0.000 0.000 0.000 0.500 0.000 0.167 0.000 0.167

8 0.500 0.500 0.500 0.667 0.750 1.000 0.667 1.000
Fonte: Elaboração própria com Ucinet 6 (Borgatti et al. 2000)

A presença de 1 e 0, na matriz, indica que alguns dos vértices estão 
preenchidos completamente com esses valores. Isso sugere a possibilidade 
de aplicar os critérios zeroblock ou oneblock para construir a matriz 
imagem. Porém, cada opção deturparia a informação original. No caso da 
opção zeroblock, temos treze vértices, dos sessenta e quatro em total, que 
seriam preenchidos com zeros e o restante com um, gerando um modelo 
muito denso, onde ∆ = 0,79. Já na opção oneblock, temos somente sete 
vértices, dos sessenta e quatro em total, que seriam preenchidos com um 
e o restante com zeros, gerando um modelo pouco denso, onde ∆ = 0,11.

Tabela 41  – Matriz imagem – trocas de bens manufaturados

0 0 0 0 0 0 0 0
0 0 0 1 0 0 0 0
1 1 1 0 0 1 0 1
0 0 0 0 0 0 0 0
1 0 1 1 1 1 0 1
1 1 1 1 1 1 1 1
0 0 1 0 0 0 0 0
0 0 0 1 1 1 1 1

Fonte: Elaboração própria
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De fato, a densidade da matriz imagem corresponde a um ∆ = 
0,39, um pouco abaixo do que seria a média entre os valores extremos 
acima citados. Isso indica que a melhor opção corresponde ao critério 
da densidade como ponto de corte para binarizar a matriz de blocos e 
construir, assim, a matriz imagem. 

Até aqui, podemos tirar a limpo a principal vantagem da análise 
de blocos. No começo do presente trabalho, explicamos que a teoria 
sociológica tem oscilado entre extremos onde, por um lado, damos como 
sabido que há indivíduos, e, por outro, que há estruturas que governam os 
indivíduos. Na medida em que o blockmodeling apresenta uma estrutura 
latente que não pode ser vista a olho nu num grafo qualquer, estamos 
fazendo uma abstração válida que decola do nível superficial das relações 
entre agentes e atinge o nível profundo de semelhanças não percebidas e 
de pautas de relações que estruturam as trocas de um sistema social. Em 
poucas palavras, conseguimos uma passagem válida do nível micro para o 
nível macro na análise sociológica. 

3. Aferimento do ajuste (Goodness of fit – GOF)

Pelo visto até aqui, ainda resta encarar um desafio que é próprio 
de qualquer modelo que aspire a explicar a realidade: como saber se está 
bem ajustado aos dados, isto é, como discernir se não está deturpando 
a estrutura relacional observada. Em termos gerais, há duas abordagens 
básicas para testar o ajuste de um blockmodeling (Wasserman; Faust, 
1994):

	 1. Perspectiva comparativa simples: procede pela comparação 
dos dados observados, isto é, as sociomatrizes R, com os dados preditos 
da matriz imagem. 

	 2. Perspectiva estatística: trabalha com testes de probabilidade 
que pressupõem uma distribuição estatística específica e uma estimação 
estocástica para o bom ajuste de um blockmodeling. 

Dado o escopo introdutório deste trabalho, não avançamos com a 
discussão dos testes estocásticos na análise dos blockmodeling. Somente 
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indicamos que a diferença básica, com o que aqui é explicado, reside no 
fato de que a análise posicional, do ponto de vista estocástico, é estudada 
como o resultado de uma distribuição de probabilidade. Portanto, o 
analista pressupõe um modelo que estime desde um começo tanto a 
probabilidade das relações como a alocação dos nós a um determinado 
grupo posicional. 

3.1 Perspectiva comparativa simples ou índice bruto 

A notação formal do índice é a seguinte:

O índice varia de 0 até BxB = B2, quantidade que é igual ao número 
de vértices na matriz de blocos. Atinge o valor máximo se o blockmodeling 
final da matriz imagem estiver completamente invertido, isto é, todos os 
valores em 0 em lugar de 1, ou todos os valores em 1 em lugar de 0, 
tomando como ponto de referência as densidades observadas. Quanto 
menor o valor bruto do índice, melhor o ajuste. 

Observemos qual seria o pior ajuste possível:

Tabela 42 – Matriz de densidades

B1 B2 B3 B4 B5 B6 B7

B1 0 0 0 0 0 0 0

B2 0 0 0 0 0 0 0

B3 0 0 0 0 0 0 0

B4 0 0 0 0 0 0 0

B5 0 0 0 0 0 0 0

B6 0 0 0 0 0 0 0

B7 0 0 0 0 0 0 0
Fonte: Elaboração própria
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Tabela 43 – Matriz imagem

B1 B2 B3 B4 B5 B6 B7

B1 1 1 1 1 1 1 1

B2 1 1 1 1 1 1 1

B3 1 1 1 1 1 1 1

B4 1 1 1 1 1 1 1

B5 1 1 1 1 1 1 1

B6 1 1 1 1 1 1 1

B7 1 1 1 1 1 1 1
Fonte: Elaboração própria

O seguinte exemplo ajuda a esclarecer o procedimento. Foi feito 
a partir da matriz de Krackhardt (1987), incorporada no banco de dados 
de Ucinet, que registra as trocas de conselho técnico entre gerentes de 
organizações num setor de alta tecnologia.

Tabela 44 – Matriz de densidades Δ, intra e inter blocos – Krackhardt (1987)

1 2 3 4 5 6 7
1 0.667 0.500 0.400 0.750 0.125 0.050 0.000
2 0.750 1.000 0.500 1.000 0.250 0.400 0.500
3 0.350 0.100 0.300 0.200 0.500 0.080 0.000
4 1.000 1.000 0.400 0.000 1.000 1.000 1.000
5 0.250 0.000 0.600 1.000 1.000 0.000 0.000
6 0.800 0.900 0.960 1.000 0.900 0.400 0.400
7 0.500 0.250 0.100 1.000 0.750 0.600 0.000

Fonte: Elaborado com Ucinet 6 (Borgatti et al. 2000)
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Tabela 45 – Matriz imagem B, binarizada pela densidade da rede 

B1 B2 B3 B4 B5 B6 B7

B1 1 1 0 1 0 0 0

B2 1 1 1 1 0 0 1

B3 0 0 0 0 1 0 0

B4 1 1 0 0 1 1 1

B5 0 0 1 1 1 0 0

B6 1 1 1 1 1 0 0

B7 1 0 0 1 1 1 0

Tabela 46 – 

B1 B2 B3 B4 B5 B6 B7

B1 0.333 0.5 -0.4 0.25 -0.125 -0.05 0

B2 0.25 0 0.5 0 -0.25 -0.4 0.5

B3 -0.35 -0.1 -0.3 -0.2 0.5 -0.08 0
B4 0 0 -0.4 0 0 0 0
B5 -0.25 0 0.4 0 0 0 0
B6 0.2 0.1 0.04 0 0.1 -0.4 -0.4
B7 0.5 -0.25 -0.1 0 0.25 0 0

O total das diferenças é 

Como não se trata de um teste probabilístico, o único ponto de 
referência que temos é o valor extremo 49, sendo este último o total 
dos vértices da matriz imagem que corresponde ao B2. Como vimos, 
o resultado de 0,768 está longe do valor que representaria a máxima 
diferença.

Para sermos exatos, o valor anterior corresponde a uma fração do 
valor máximo, isto é,
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3.2 Perspectiva comparativa das relações observadas com a matriz 
imagem 

Uma primeira variante do índice cru consiste em calcular as 
diferenças entre as relações observadas e a matriz imagem, focando nas 
relações específicas entre os nós que ocupam uma posição. Em lugar de 
comparar uma medida geral, como é a densidade, o que se compara é o 
número de relações. A sua notação formal é a seguinte:

Para a matriz de Krackhardt, a diferença que se calcula é a que 
resulta das relações na matriz imagem menos as relações observadas, tais 
e como aparecem na matriz de blocos.

Tabela 47 – Matriz de Blocos – Krackhardt (1987)

B1 B2 B3 B4 B5 B6 B7

1 2 4
1 
6 8

1 
0

1 
7

1 
2

1 
1 6

2 
1

1 
8

1 
4 7 5 9 3

2 
0

1 
5

1 
3

1 
9

----------------------------------------------------------------------------------------

B1
1 | 1 1 1 | 1 | 1 | 1 | | | |
2 | | | 1 1 | | 1 | | |
4 | 1 1 1 | 1 1 | 1 1 1 1 1 | 1 | | 1 | |

16 | 1 1 | 1 | | 1 | | | |
----------------------------------------------------------------------------------------

B2 8 | 1 1 | 1 | 1 1 1 | 1 | 1 | | |
10 | 1 1 1 1 | 1 | 1 1 | 1 | | 1 1 1 1 | 1 1 |

----------------------------------------------------------------------------------------

B3
17 | 1 1 1 | | 1 | | 1 | | |
12 | | | 1 | | 1 | | |
11 | 1 1 | | | | 1 | | |
6 | | | 1 | | | | |

21 | 1 1 | 1 | 1 1 1 | 1 | 1 1 | 1 1 | |
----------------------------------------------------------------------------------------

B4 18 | 1 1 1 1 | 1 1 | 1 1 | | 1 1 | 1 1 1 1 1 | 1 1 |

----------------------------------------------------------------------------------------
B5 14 | 1 | | 1 | 1 | 1 | | |

7 | 1 | | 1 1 1 1 1 | 1 | 1 | | |
----------------------------------------------------------------------------------------

B6

5 | 1 1 1 | 1 1 | 1 1 1 1 | 1 | 1 1 | 1 | 1 1 |
9 | 1 1 1 | 1 1 | 1 1 1 1 1 | 1 | 1 1 | | |
3 | 1 1 1 | 1 1 | 1 1 1 1 1 | 1 | 1 1 | 1 1 | |

20 | 1 1 1 | 1 | 1 1 1 1 1 | 1 | 1 | 1 | |
15 | 1 1 1 1 | 1 1 | 1 1 1 1 1 | 1 | 1 1 | 1 1 1 1 | 1 1 |

----------------------------------------------------------------------------------------
B7 13 | 1 1 | | | 1 | 1 | 1 1 | |

19 | 1 1 | 1 | 1 | 1 | 1 1 | 1 1 1 1 | |
----------------------------------------------------------------------------------------

Fonte: Elaborado com UCINTE 6 (Borgatti et al. 2000)
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Tabela 48 – Matriz de imagem com entradas cheias

B1 B2 B3 B4 B5 B6 B7

B1

1 1 1 1

1 0 1 0 0 0
1 1 1 1

1 1 1 1

1 1 1 1

B2 1 1 1 1 0 0 1

B3 0 0 0 0 1 0 0

B4 1 1 0 0 1 1 1

B5 0 0 1 1 1 0 0

B6 1 1 1 1 0 0 0

B7 1 0 0 1 1 1 0
Fonte: Krackhardt (1987)

O leitor deve observar que ampliamos o vértice das relações internas 
ao Bloco 1, incluindo todas as relações entre os nós. Isso significa que onde 
há valores 1, na matriz imagem, estão sendo computadas a totalidade das 
relações. Se compararmos o mesmo vértice na matriz observada, Tabela 
47, vemos que há somente 8 relações, enquanto que na matriz imagem 
há o dobro. Dessa forma, podemos entender a discrepância que pode 
haver entre a matriz predita e a matriz observada. A mesma análise deve 
ser feita para todos e cada um dos vértices com valor 1 na matriz imagem. 

O cálculo da diferença é o seguinte:

O que se mensura é o número de vértices na matriz de adjacência 
observada x, que não são idênticos aos valores preditos da matriz imagem 
x(t) ou alvo (target). Trata-se de uma medida de dissimilaridade. Dado que 
a lógica é a mesma, sabendo o índice bruto, podemos obter o índice da 
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diferença nas relações. Isto é, se o primeiro é uma medida de proporções, 
obtida a partir da diferença das densidades, basta multiplicá-lo pelo total 
das relações possíveis. Então, podemos afirmar que o índice das diferenças 
nas relações é uma função do índice bruto. A sua notação é a seguinte:

Aplicando a fórmula ao exemplo anterior, em que tomamos os 
dados da rede de Krackhardt (1987), temos o seguinte:

Este valor é próximo de 7, a diferença encontrada ao fazermos a 
conta com os valores binários em cada uma das matrizes.

Uma segunda variante consiste em calcular o coeficiente de 
coincidência ou match coefficient. Consiste na proporção de laços 
observados que são idênticos aos laços preditos da matriz imagem. Nesse 
caso, temos uma medida de similaridade, portanto, quanto maior o valor, 
maior a proximidade entre o valor observado e o valor predito. A sua 
notação formal é a seguinte:

Se incluímos na fórmula os valores do exemplo com que viemos 
trabalhando, temos a seguinte conta:
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4. Exercícios

1) Com base nos resultados da análise de equivalência estrutural 
pelo método CONCOR padrão, elabore a matriz e o sociograma imagem 
para a rede de transferências de jogadores dos clubes da 1ª divisão do 
campeonato brasileiro em 2017. Utilize o critério da densidade para 
ajustar seu modelo de blocos. Lembre-se de calcular a densidade geral da 
rede. No Ucinet basta seguir o caminho:

Network > Density > Density Overall

A matriz de densidade dos blocos foi emitida entre os resultados da 
análise de equivalência via CONCOR padrão. Recupere essa informação 
para resolver este exercício.

2) Elabore também as matrizes e os sociogramas imagem utilizando 
os critérios: oneblocks e zeroblocks. 
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Epílogo para praticantes

1. Analisando seus contatos pessoais nos últimos 30 dias.

Este exercício foi pensado para você reforçar sua apropriação dos 
conceitos e medidas que discutimos no livro. A seguir, descrevemos um 
conjunto de passos para que você reconstrua a rede de contatos com 
quem você interagiu nos últimos 30 dias. Ao final, você terá uma proxy de 
sua rede pessoal, então poderá realizar a análise desse domínio relacional 
e, quem sabe, descobrir algumas características ocultas de sua vida.

O exercício foi pensado para ser iniciado no software Pajek. 
Entretanto, para explorar ao máximo a rede, você precisará exportá-la 
para o software Ucinet. Bastará aplicar os ensinamentos anteriores.

1.1 Exercício

Levando em consideração que nossas relações pessoais não são 
aleatórias, conclui-se que podemos reconstruir e analisar esse universo 
relacional por meio das técnicas de análise de redes sociais. Você já 
pensou sobre o lugar que as pessoas com quem você se relaciona ocupa 
em sua vida? Este exercício busca motivá-lo (a) a estudar suas relações 
pessoais. Aplicaremos alguns critérios para identificar as pessoas com 
quem você interagiu nos últimos 30 dias. Você deverá realizar os passos 
descritos a seguir e, ao final, chegará à representação das suas relações 
pessoais mais recentes. 

1) Identificação dos nós da rede.
Para identificar os pontos de sua rede de contatos pessoais 

recentes, vamos adotar como critério os meios de comunicação mais 
comuns à nossa disposição: (1) ligações telefônicas; (2) interações 
presenciais; (3) relações virtuais por meio de e-mail, whatsApp, 
facebook, Hangouts, Skype, Instagram etc. No caso de interações 
virtuais, considere apenas os casos em que houve comunicação direta 
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e pessoal (conversa) com seu alter. Não considere, por exemplo, 
curtidas, compartilhamento de fotos ou mensagens coletivas (enviadas 
ou recebidas de grupos). Para limitar nossa análise, focaremos apenas 
nos contatos que realizamos nos últimos 30 dias. Construa uma lista 
de nomes a partir dos seguintes passos:

a)	 Pegue seu telefone e liste os seus últimos contatos registrados. 
Para quem você ligou ou de quem recebeu ligações? Para quem 
você enviou ou de quem recebeu mensagens?

b)	 Liste em seguida as pessoas com quem você lembra ter 
conversado pessoalmente nos últimos 30 dias sobre algum 
tema relevante para você (trabalho, estudos, religião, conversou 
sobre seus problemas, situação financeira etc.). NÃO inclua as 
pessoas que você apenas cumprimentou.

c)	 Em seguida, acesse as ferramentas que lhe permitem interargir 
por meio da internet. Abra sua caixa de e-mail e complete 
a lista com nomes de pessoas para quem você enviou ou 
de quem você recebeu um e-mail (não considere spam, 
empresas ou grupos, estamos interessados em pessoas que 
você conhece e com quem interage individualmente). Se você 
utiliza mais de um e-mail, verifique suas interações naquele 
que você utiliza com frequência. Acesse suas mídias sociais 
(instagram, facebook, tinder, twitter etc.) e liste pessoas 
para quem você enviou ou de quem recebeu mensagens 
nos últimos 30 dias (exclua os contatos esporádicos, aqueles 
feitos com pessoas que você não conhece ou devido a alguma 
obrigação profissional. Ex.: realizar uma compra, enviar um 
relatório para alguém desconhecido etc.).

Ao final, você deverá ter uma lista semelhante a que mostramos na 
coluna A a seguir. Guarde esse arquivo. Em seguida, crie uma nova lista 
com os nomes identificados, mas, desta vez, elimine os nomes repetidos 
e exclua a origem das relações. Você então chegará a uma lista final, tal 
como na coluna B a seguir. 
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Quadro 7 – Exemplo de mapeamento das interações realizadas nos 
últimos 30 dias:

Coluna A – Indivíduos com quem interagiu por 
diferentes meios

Coluna B – Nós da 
rede pessoal

Relações originadas em interações telefônicas
Maurício Botrel
César Luís
Mariana Almeida
Ana Augusta
...
Relações originadas em interação pessoal
César Luís
Ana Augusta
Paula Pereira
...
Relações originadas em interação virtual Off-Line  
e On-Line
Mariana Almeida
Ana Augusta
Joana da Silva
Ana Augusta
Luís Antônio
Anayra Ribeiro
...

Maurício Botrel
César Luís
Mariana Almeida
Ana Augusta
Paula Pereira
Joana da Silva
Luís Antônio
Anayra Ribeiro
...

Observação: Note que a coluna B lista os indivíduos da sua rede 
pessoal com quem você interagiu nos últimos 30 dias. Se o número de 
indivíduos identificados for inferior a 45, complete a lista com pessoas 
que você conhece e com quem teve contato nos últimos 3 meses até 
alcançar o número mínimo de 45 atores. Guarde a lista final.

2) Representando as relações
Uma vez que identificamos os atores da rede, vamos indicar as 

relações entre os atores. No caso de redes pessoais, as relações entre 
os alters (seus familiares, amigos e conhecidos) são apontadas pelo ego 
(você). Isso significa que as relações representadas são registradas a 
partir da percepção do ego. Esse é um dos limites dessa técnica. Outro 
ponto importante a notar é que o ego (o dono da rede pessoal) não será 
inserido na rede.
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Para representar as relações, vamos seguir os seguintes passos:

a) 	 Criar uma sintaxe da rede no bloco de notas a partir da lista 
de pessoas que você identificou. Lembre-se que o tamanho 
mínimo da rede deve ser de 45 atores. A sintaxe será criada 
para o Pajek, 
Passo 1: Abra o blocos de notas, na primeira linha digite: 
*vertices X 
	(X refere-se ao número de atores que você levantou na etapa 
anterior. Ex.: se você identificou 58 pessoas, substitua X por 58.)
Passo 2: em seguida, a partir da segunda linha, numere e digite 
(entre aspas) o “nome de cada pessoa identificada”. Veja o 
exemplo para uma rede com cinco atores:
*vertices 5
1  “Alessandro 2º grau”
2  “Ana Carolina”
3  “Ana Paula JK”
4  “Anderson Xavier”
5  “Andrea Matriz”

b) 	 Agora estamos prontos para registrar as relações entre os 
atores.  Neste exercício, representaremos também a intensidade 
dessas relações. Indique as pessoas que se conhecem (que 
conversam ou já conversaram e, portanto, podem interagir 
sem a necessidade de sua intermediação). Vamos considerar 
a seguinte escala de intensidade: a) o número “2” indicará um 
laço forte, isto é, pessoas que se conhece bem (conversam 
com frequência, encontram-se frequentemente); b) o número 
“1” indicará um laço fraco, ou seja, pessoas que apenas se 
conhecem (conversam pouco, encontram-se eventualmente). 
Lembre-se que se duas pessoas não se conhecem, não háverá 
relação para registrar na sintaxe. Para registrar as relações, siga 
os seguintes passos:

Passo 3: Logo abaixo da identificação dos nomes (passo 2), 
digite:
*edges
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(esse comando indicará o natureza da relação entre os atores)
Passo 4: Na linha seguinte, comece a informar as relações 
existentes. Cada linha representará uma relação e sua 
intensidade através da combinação de 3 números. Assim, se o 
ator 1 de sua rede conhece muito bem o ator 10 (uma relação de 
intensidade 2), você deverá informar essa relação digitando-a 
da seguinte forma: 
1 10 2
Se o ator 1 apenas conhece o ator 26 (intensidade 1), você 
deverá digitar: 
1 26 1
Utilize espaço para separar os 3 números, note que os dois 
primeiros números representam atores (identificados nos 
passos 1 e 2 acima) e o terceiro número revela a intensidade 
da relação entre estes. Seu resultado final será semelhante ao 
exemplo a seguir, lembrando que sua rede deve ter um tamanho 
mínimo de 45 atores.
Exemplo com uma rede de tamanho 5. Note no seguinte 
exemplo que o ator 1 (Alessandro) tem um laço fraco com o 
ator 2 (Ana Carolina), um laço forte com o ator 3 (Ana Paula) e 
não conhece os atores 4 e 5:

*vertices 5
1  “Alessandro 2º grau”
2  “Ana Carolina”
3  “Ana Paula JK”
4  “Anderson Xavier”
5  “Andrea Matriz”
*edges
1 2	  1
1 3	  2
2 3	  1
3 5	  2
4 5	  2
Salve o arquivo com as informações da rede. 
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3) Identificando atributos
O último passo para organizar os dados de sua rede de contatos 

pessoais recentes será o levantamento de alguns atributos úteis para 
analisar a rede. Vamos sugerir alguns atributos interessantes para 
serem inseridos na análise, mas você pode identificar outros atributos 
relevantes além dos dois sugeridos.

a) 	 O primeiro atributo refere-se às esferas de sua vida as quais 
seus contatos estão ligados. Volte à lista de identificação dos 
atores e classifique-os em relação ao pertencimento às esferas 
da sua vida: trabalho, religião, estudos, família, lazer. Cada 
ator deve ser associado apenas em uma esfera. Se um ator atua 
em mais de uma esfera, considere aquela na qual você julge 
que a atuação desse ator é mais relevante para você.

b) 	 Um segundo atributo é o sexo dos atores. Classifique-os em 
masculino e feminino.

Salve o arquivo com as informações dos atributos.
Pronto! Você agora pode analisar as relações entre seus contatos 

pessoais mais recentes.

1.2 Orientações para análise descritiva.

Antes de visualizar a rede, reflita sobre a natureza das relações que 
você levantou. As questões a seguir lhe ajudarão nessa tarefa:

I.	 A rede construída é formada por laços orientados ou não-
orientados?

II.	 Trata-se de uma rede binária ou valorada? 
III.	 Essa rede é One-Mode ou Two-Mode?
IV.	 Sua rede de contatos pessoais é uma rede Multiplex?
Esperamos que, após pensar um pouco sobre o tipo de rede 

construída neste exercício, você já tenha uma noção sobre os tipos de 
análises que poderão ser feitas. Por exemplo, você já deve ter claro se será 
ou não possível classificar os atores da rede considerando os graus nodais 
e a centralidade de proximidade diferenciando entre laços de entrada e de 
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saída. A seguir, preparamos algumas questões para lhe auxiliar a construir 
uma análise descritiva da rede.

1)	 Visualize a rede e os atributos no Pajek.
2)	 Importe e visualize sua rede no Ucinet.
3)	 Qual é o tamanho de sua rede?
4)	 Quantos laços existem na rede?
5)	 Quantos laços são fortes e quantos são fracos?
6)	 Qual é a densidade da rede?
7)	 Os atores de sua rede estão todos conectados em um único 

componente ou há subgrupos desconectados?
8)	 Como as pessoas de cada esfera de sua vida se relacionam? Há 

mais relações internas ou externas nas diferentes esferas?
9)	 Compare a densidade dos laços dentre e entre as esferas de sua 

vida.
10)	Quais esferas da sua vida se conectam internamente por laços 

fortes e quais se conectam por laços fracos?
11)	Como seus contatos pessoais se relacionam com base no sexo? 

Como essa relação acontece em cada esfera da sua vida?
12)	Quais são os 5 atores mais centrais sob as diferentes perspectivas 

de centralidade que estudamos (grau nodal, proximidade, 
intermediação, prestígio de proximidade (Reach Centrality), 
Eigenvector)?

13)	Quais são os top 5 de seus contados pessoais recentes? Isto 
é, quais são os 5 atores que se destacaram mais vezes como 
centrais, considerando as diferentes medidas de centralidade 
que você analisou? Eles pertencem a quais esferas de sua vida?

14)	Compare os domínios de influência de um parente 
(preferencialmente de sua família primária), de seu(sua) melhor 
amigo(a) e de um(a) colega que você conheceu recentemente.

15)	Calcule o número de panelinhas na sua rede (cliques)? Se você 
encontrou mais de uma, compare os tamanhos e a composição 
desses subgrupos. Os cliques misturam as esferas da vida? Há 
cliques seguimentados por sexo? A composição dos cliques 
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maiores é diferente da composição dos cliques menores? Quais 
são os atores que mais participaram das panelinhas entre seus 
contatos pessoais recentes?

16)	Adote outros critérios para identificar subgrupos na sua 
rede (N-clique, N-clã, K-plex etc.). Analise os tamanhos e a 
composição dos subgrupos encontrados.

17) Qual das análises realizadas nos exercícios 15 e 16 revelou algo 
novo ou interessante sobre suas interações recentes?

18)	Por fim, vamos partir para uma análise de blockmodeling. 
Elabore um modelo utilizando o critério de equivalência 
estrutural, ajuste o modelo e responda:
a.	 Algum ator da sua rede de contatos pessoais recentes ocupa 

uma posição exclusiva? Isto é, há alguém na sua vida para 
quem não há outra pessoa estruturalmente equivalente?

b.	 O que os resultados da análise de blocos mostraram em 
relação à forma como você classificou seus contatos 
pessoais nas esferas de sua vida? Os subgrupos 
encontrados correspondem à sua classificação inicial ou 
houve subdivisão das esferas de sua vida? Quais?

c.	 Construa a matriz e o grafo imagem utilizando o critério da 
densidade para ajustar o modelo. Qual posição na rede tem 
a função de conectar blocos de atores entre seus contatos? 
Quem são os atores que assumem essa posição na rede? 
Quais blocos de atores são conectados mais fortemente?

d.	 Qual foi o achado novo ou interessante que você encontrou 
a partir da análise de blocos de sua rede de contatos 
pessoais recentes?

19)	Descreva sua rede de contatos pessoais recentes destacando os 
principais achados. O que você tem a dizer sobre a importância 
das pessoas e dos grupos que elas formam em sua vida?  Quais 
pessoas desempenham a função mais importante em sua vida?
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